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is Release

What’'s New in Siebel Email Response Administration Guide, Version

7.7

Table 1 lists changes described in this version of the documentation to support release 7.7 of the

software.

Table 1. New Product Features in Siebel Email Response Administration Guide, Version 7.7

Topic

“Understanding the
Communications Inbound Receiver
(CIR) and Communications Inbound
Processor (CIP) Server
Components” on page 11.

Description

As part of the new Siebel Email Response server architecture,
these two new server components replace the
Communications Inbound Manager component. You can use
the CIR and CIP to create a higher-performing, more scalable
architecture that meets your business requirements.

“Using Siebel Email Response
Analytics” on page 11

This new feature allows you to record a timestamp at
different stages of email processing.

“Using the Siebel Email Response
Smart Character Set” on page 111.

This new feature allows Web-based email to be read,
processed, and responded to in the language of the person
sending the email.

“Creating Secure Sockets Layer
(SSL) Connections for SMTP and
POP3 Drivers” on page 12.

This new feature allows you to establish secure connections
between your Siebel Server and email server.

Chapter 8, “Troubleshooting Siebel
Email Response.”

New troubleshooting techniques and improved diagnostics for
resolving Siebel Email Response issues are described in this
chapter.
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Siebel Email

This chapter provides an Overview description of Siebel Email Response. It includes the following
topics:

B “Fundamentals of Using Siebel Email Response”

m “Siebel Email Response Features” on page 10

®  "Deploying Siebel Email Response” on page 17

m  “Determining How Agents Use Siebel Email Response” on page 19
®  “Working with Siebel Applications” on page 20

® “Understanding the Siebel Email Response Architecture” on page 21

Fundamentals of Using Siebel Email
Response

Siebel Email Response allows organizations to manage and respond to a high volume of incoming
email. It has a browser-based user interface, accesses a single company-wide customer information
database, and can be used with other Siebel eBusiness applications.

Siebel Email Response and Siebel Communications Server are installed with the Siebel Server and
work together to receive email and send responses. Siebel Communications Server supports and
integrates communications channels used to communicate with customers. The following
Communications Server components handle email traffic to and from Siebel Email Response.

®m  Communications Inbound Receiver (CIR) pulls email from the email server, converts the email
into event data, and creates an SRM request for Communications Inbound Processor.

®m  Communications Inbound Processor (CIP) receives the events from Communications Inbound
Receiver and processes them using workflows.

®  Communications Outbound Manager manages outbound communications with customers. Siebel
Email Response uses the Communications Outbound Manager server component to send
responses.

In addition to handling email traffic, the Communications Server can support a multichannel toolbar
when you install Siebel Universal Queuing. This toolbar includes buttons used by agents to access
different communications channels, such as voice and email. Many Siebel products, such as Siebel
Email Response and Siebel Call Center, use the communications toolbar to allow agents to initiate
outgoing communications and accept incoming communications using any supported
communications channel. For details about Communications Server components and the
communications toolbar, see Siebel Communications Server Administration Guide.

Siebel Email Response performs the following tasks:

B Monitors one or more mailboxes on your email system.

Siebel Email Response Administration Guide Version 7.7 =9
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Parse an inbound email message for various fields, such as Sender, Message Body, and Message
attributes for further processing.

Creates an activity record in the Siebel database for each inbound email and stores the content
of the email in fields within the new record.

Sends an acknowledgment message to let the sender know that the sender’s email has been
received.

Routes an inbound email message to an agent, based on parameters such as agent skills, when
integrated with Siebel Business Process Designer and Siebel Assignment Manager or Siebel
Universal Queuing.

Automatically routes an email message to an agent.

NOTE: You can use Siebel Smart Answer (optional module) with Siebel Email Response to also
receive a suggested response to an email.

Allows an agent to compose and send a response message using templates configured for your
company’s needs. Templates save agents’ time and give them preapproved responses to send to
customers.

Includes a spell-checking feature to improve the accuracy of messages.
Accesses customer data and history in one customer information database.

Provides international support for companies that receive email messages from customers
around the world in the following ways:

= Many different international languages. For information on supported languages, see Siebel
System Requirements and Supported Platforms on Siebel SupportWeb.

= Unicode support. Organizations can deploy Siebel Email Response around the globe, without
requiring separate Siebel environments.

Siebel Email Response Features

This section presents an overview of the following Siebel Email Response features:

Understanding the Communications Inbound Receiver (CIR) and Communications Inbound Processor
(CIP) Server Components

Using Siebel Email Response Analytics

Creating Secure Sockets Layer (SSL) Connections for SMTP and POP3 Drivers
Processing Structured and Unstructured Messages

Processing Responses Based on Service-Level Agreements (SLAs)

Using Siebel Business Process Designer and Routing and Queuing Methods
Analyzing Email Content With Siebel Smart Answer (Optional Module)
Associating Multiple Organizations With Siebel Email Response

Identifying Contacts By Email Addresses
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B Receiving Email With the Smart Character Set

Understanding the Communications Inbound Receiver
(CIR) and Communications Inbound Processor (CIP)
Server Components

In the Siebel 7.7 release, the Communications Inbound Receiver (CIR) and Communications Inbound
Processor (CIP) server components replace the Communications Inbound Manager component. You
use Communications Inbound Receiver (CIR) for receiving inbound email messages and
Communications Inbound Processor (CIP) for processing (using business logic) email message. You
can use Communications Inbound Receiver (CIR) and Communications Inbound Processor (CIP) to
process all inbound emails, whether they are Web-structured or unstructured messages.

This new architecture allows for better performance and greater scalability. Your system can now run
continuously (24 hours/day, 7 days/week) with no manual restart required when making changes to
profiles and response groups. Depending on your business needs, you can also run Siebel Email
Response in real-time mode, with only the Communications Inbound Receiver (CIR) component
processing email, or nonreal-time mode, with both Communications Inbound Receiver (CIR) and
Communications Inbound Processor (CIP) processing email with multiple instances of
Communications Inbound Receiver (CIR) and Communications Inbound Processor (CIP) on different
Siebel Servers. For more information on the Siebel Email Response architecture, see “Understanding
the Siebel Email Response Architecture” on page 21.

Using Siebel Email Response Analytics

Siebel Email Response Analytics allows you to create a timestamp for an email as it moves through
the different stages of email processing. The timestamp fields are initially recorded at various points
in the workflow and then written to the S_EM_RESP_TM table using the Update Analytics Record
method in the Inbound Email Database Operation business service.

You can capture the time an email is received, processed, created, sent by the server, assigned to,
replied to or sent by an agent. Table 2 provides a list of the timestamp fields.

Table 2. Siebel Email Response Timestamp fields

Field Description

Received The time Siebel Email Response receives an email.

Processing The time Siebel Email Response begins processing an email.

Created The time Siebel Email Response creates an activity for an email.

Server Send The time Siebel Email Response sends either an auto acknowledgement or
an auto response for an email.

Reply The time an agent responds to an email.
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Table 2. Siebel Email Response Timestamp fields

Field Description

Agent Send The time an agent sends out a responding email.

Assigned The time an event is assigned to an owner either through Universal Queuing
(UQ) or Assignment Manager.

Creating Secure Sockets Layer (SSL) Connections for
SMTP and POP3 Drivers

Siebel Email Response allows the SMTP and POP3 drivers to work with email servers that are enabled
for SSL. This provides secure transmission of data between the Siebel Server and the email servers.
For information on how to enable an SSL connection for SMTP and POP3 drivers, see “Enabling a
Secure Sockets Layer (SSL) Connection for SMTP and POP3 Drivers” on page 68.

Processing Structured and Unstructured Messages

Siebel Email Response can process two types of the most common messages sent to many
organizations, structured and unstructured. The following sections describe the way Siebel Email
Response handles each type of message and the advantages and disadvantages of each type of
message:

Processing Structured Email Messages

Siebel Email Response uses the eMail Response - Process Service Request workflow to process
structured (keyword-based or Web-form) messages. You can use a number of keywords (such as
help, query, status, submit, and update) when processing and creating service requests for keyword-
based emails.

To use structured email processing, you should provide your customers with email templates or with
Web forms (Web-based forms on your Web sites).

NOTE: You can create Web forms with the Web development product used to maintain your current
Web site. Siebel Systems does not make a Web-form product. However, organizations using Siebel
eService can configure Web pages, views, and applets to meet many of their business needs. For
more details, see Siebel eService Administration Guide.

Examples of incoming structured (keyword-based or Web-form) messages are:
®m  New service requests

m Status requests for pending service requests

m Updates for existing service requests

B Searches for specific service requests
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Structured email messages should be processed using the eMail Response - Process Service Request
workflow process. This workflow process creates service request records in the Siebel database that
can be viewed on the Communications screen.

Processing Keyword-Based Email

For keyword-based email, specific keywords are required in the subject headers of incoming email
messages to indicate different actions. For example, Help, Status, Query, Submit, and Update are

keywords that can be required in the subject to initiate an action. The keyword allows Siebel Business
Process Designer to determine the appropriate process for a given email. In keyword-based email

messages, customers must understand and use the required format or the data will not be parsed

correctly.

Processing Web Forms

Web forms allow the customer to communicate the severity of a problem, allow Siebel Email
Response to categorize the problem, and provide information that Siebel Assignment Manager can
use to notify the appropriate service representatives in your organization. If you use Web forms, you
will need administrators to build and maintain them.

Processing Unstructured Email
Unstructured email (free-form) messages require no special subject or structure in the incoming
email. They allow a broad range of communications, such as:

m Requests for general information
m Requests for information about a product or event
®  Order requests

Unstructured email messages should be processed using the eMail Response - Process Message
workflow process. This workflow process creates activity records in the Siebel database that can be
viewed on the Communications screen.

This method is useful when Web forms are not available or when your customers must receive
personalized service. However, free-form messages make it more difficult to automate the response
process because customer emails frequently do not include all the information necessary to process
a message.

Processing Responses Based on Service-Level
Agreements (SLAs)

Siebel Email Response can use information from your customers’ service-level agreements when
processing incoming emails. For example, if your organization has two levels of support, standard
and premier, your Siebel Email Response administrator can implement Siebel Email Response in the
following ways:

m Customers with standard agreements can have access to full online support but do not receive
any premier services.
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m Customers with premier agreements can send an email message and receive an immediate auto-
acknowledgment giving the latest date and time that they will receive a response.

Using Siebel Business Process Designher and Routing
and Queuing Methods

You use Siebel Business Process Designer with routing and queuing products or methods to further
automate your email interactions. Routing and queuing applications and methods assign incoming
records to employees, positions, and organizations.

Your company can manage your email processes by using Siebel Business Process Designer with one
of the following routing and queuing methods or by integrating Siebel Email Response with a third-
party routing and queuing application:

®  Manual routing. A person must manually assign every work item as it comes in. This is the most
labor-intensive method.

m Siebel Assignment Manager (optional). Assigns inbound work items such as opportunities,
email, or service requests to agents based on your business rules and the agents’ skills, product
expertise, language skills, availability, workload, and other criteria. You can change the rules as
your business requirements change.

m Siebel Universal Queuing (optional). Can assign, route, and queue work items from multiple
channels. Siebel Universal Queuing tracks customer interactions (email, telephone calls, Web
collaboration, and so on), agent states, and channel states, and determines the way to route and
assign work items using a combination of channel type, skill type, and agent availability. Agents
can access communications channels by using the communications toolbar.

Using the communications toolbar, Siebel Universal Queuing allows agents to work on a
combination of call center channels such as inbound and outbound calls, faxes, pages, and email,
prioritizing each communication by volume and service level.

® Custom routing and queuing. You can design and program your own routing and queuing
using Siebel Business Process Designer.

See “Tables and Reference” for a comparison chart that describes various routing and queuing
methods and their advantages and disadvantages. For additional information about Siebel Email
Response routing and queuing requirements, see “Revising, Testing, and Activating Workflow
Processes” and “Implementing Routing and Queuing Processes”.

Using the Spell Check Feature

Siebel Email Response uses a spell-checking feature that is available with Siebel eBusiness
applications. It can identify many spelling errors in text communications (including email, service
requests, and solutions) before they are sent to customers. The spell check feature is automatically
installed and enabled as part of the Siebel Server and Mobile Web Client installation processes.
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By default, the spell check feature ignores HTML in outbound email messages. You can change this
and other spell check options (for example, the option to automatically check spelling when an email
is sent) in the Spelling view of the User Preferences screen. For more information about setting user
preferences, see Applications Administration Guide.

Setting Up a Default Dictionary

The spell check feature uses the dictionary for the default language specified during installation.
During installation, dictionary files (lexicons) for the most common international languages are
installed. Common dictionary files (two files for each language, with the TLX and CLX extensions)
are stored in the [ROOT]\lex directory during installation. All included language dictionaries are
installed regardless of the default language your systems administrator selects during installation.
For a list of supported languages, see Siebel System Requirements and Supported Platforms on
Siebel SupportWeb.

NOTE: Medical and legal dictionaries are available only in U.S. English.

In the User Preferences screen, agents can change the default language used for the spell check
feature. If you assign a default language in user preferences, the spell check feature uses that
default language to check the spelling in replies to inbound emails. For more information about user
preferences, see Applications Administration Guide.

Creating a Personal Dictionary

An agent can add frequently used words to a personal dictionary (custom user dictionary) that is
saved on the server so that it is accessible from any workstation the agent uses. These dictionaries
are stored in the following locations:
[FILESERVERROOT]\userpref\[USERNAME&]J\[USERNAME_LANGID].tIx and
[FILESERVERROOT]\crm\[USERNAME_LANGID].tIx.

Analyzing Email Content With Siebel Smart Answer
(Optional Module)

Siebel Smart Answer analyzes email content and sends an automatic response to the customer or
suggests a response for the agent. For more information and setup instructions, see Siebel Smart
Answer Administration Guide.

Automatic response. Answers customer inquiries and Web requests without agent intervention by
automatically interpreting the customer’s request and locating an appropriate response.

Automatic suggestion. This feature analyzes an email’s content and recommends a response for
agents to review before sending the response to the customer. You use automatic suggestion for
complex situations in which the auto-response feature is not appropriate. Using a solution or
template associated with the response category, Smart Answer creates a suggested response.

Siebel Email Response Administration Guide Version 7.7 m 15
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In many situations, you can use both the automatic suggestion and automatic response features of
Siebel Smart Answer, depending on the confidence of the Smart Answer engine. For example, the
administrator can establish a rule whereby Smart Answer automatically responds if the confidence
parameter is greater than 90 percent, and if the confidence parameter is less than 90 percent, Smart
Answer suggests a response for an agent to evaluate.

Self-learning technology. The automatic response and automatic suggestion features are based
on a technology that determines the way to respond to email messages by learning from the behavior
of the agents. When an agent chooses a category and clicks send, the feedback is sent to the
knowledge base. Over time, this feedback trains the knowledge base using the categories that agents
choose.

Language support. For a list of languages supported by Smart Answer, see Siebel System
Requirements and Supported Platforms on Siebel SupportWeb.

Associating Multiple Organizations With Siebel Email
Response

In Siebel Email Response, you can associate business entities with a specific organization. This gives
you a way to filter and access records. If your company consists of multiple organizations, you can
look up contacts by organization.

Identifying Contacts By Email Addresses

Siebel Email Response allows you to identify one contact that has multiple email addresses or
multiple contacts that share one email address. The eMail Response - Process Message and eMail
Response - Process Service Request workflows support contact verification.

Identifying One Contact With Multiple Email Addresses

Many customers have multiple email addresses. For example, they might work from multiple
locations (office, home, other remote locations, and so on). Therefore, when your customers contact
you, you need to be able to identify them no matter what email address they use. Siebel software is
preconfigured to allow you to add a contact’s alternate email addresses in the Contacts screen, More
Info view.

NOTE: In the Contacts screen, the Do Not Email check box applies to all email addresses in this
contact record.

Identifying Multiple Contacts That Share One Email Address
When Siebel Email Response receives an email, it searches all contact records for the sender’s email
address.

m  First, Siebel Email Response compares the sender’s email address to the email address in the
Email field.
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When Siebel Email Response finds a match, it creates an activity record and associates it with
that contact record. If multiple contact records contain the sender’s email address, Siebel Email
Response associates the email with the first contact record found and creates an activity record
for that contact.

After Siebel Email Response creates an activity record, the following events occur:

One inbound email is routed, if routing is enabled.

In a preconfigured Siebel Email Response application, an auto acknowledge response is sent to
the email sender. However, you will have to add the response group parameter for no response
to be sent.

The eMail Response - Update Activity Status workflow process updates the activity status for the
contact.

The eMail Response - Client Send Email workflow process updates the response activity status
and inbound activity status for the contact.

Receiving Email With the Smart Character Set

The Smart Character Set feature allows you to receive, process, and reply to an email in the same
character set as the inbound email. For more information on this feature, see “"Using the Siebel Email
Response Smart Character Set” on page 111.

Deploying Siebel Email Response

You can implement Siebel Email Response in the following ways:

To use only the Siebel Email Response features, a base application such as Siebel Sales, Siebel
Marketing, Siebel Service, or Siebel Call Center is required. Instead of configuring both Siebel
Email Response and the base application, only Siebel Email Response needs to be configured.

Using a Siebel base application as a foundation for your deployment of Siebel Email Response

can solve the immediate challenge of routing and processing a high volume of incoming email

and can be an interim step before you implement a larger, more integrated solution.

The Siebel Email Response add-on module (integrated solution) includes Siebel Email Response
features (without Siebel Service functionality) and can be added to many other Siebel
applications, including Siebel Sales, Siebel Marketing, Siebel Service, and Siebel Call Center. For
example, if you wanted only Siebel Marketing and Siebel Email Response, you would purchase
the Siebel Marketing base application and the Siebel Email Response add-on module.

Siebel Email Response is installed during the installation of your purchased Siebel base application
package and does not require separate installation.

The following topics provide additional information about Siebel Email Response deployment:

“Designating an Implementation Team”

“Implementing Siebel Email Response in an International Environment”
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Designating an Implementation Team

You should designate several people to serve as the Siebel Email Response deployment team. They
will coordinate the setup and maintenance of its new email system by using Chapter 3, “Planning a
Siebel Email Response Deployment,” as a guide. After the planning process is complete, the email
response administrator uses the instructions in Chapter 4, "Completing Basic Setup Tasks,” to set up
the Siebel Email Response components. Employees who perform the following roles should be on
your Siebel Email Response implementation team:

m System administrator. Responsible for installing, configuring, and maintaining the network,
including the email server, the Smart Answer server component, and the Siebel environment.

m Siebel Email Response administrator. Responsible for setting up and maintaining Siebel
Email Response, including profiles, drivers, response groups, catalogs, response categories, and
templates.

m Developer. Responsible for configuring and customizing the Siebel application to meet the
customer’s business requirements, including view modifications and process automation.

® Business analyst. Responsible for:
= Mapping and developing customer business processes in Siebel Business Process Designer.
= Developing response categories, solutions, and templates for use by agents.

m  Creating and maintaining the knowledge base for Smart Answer. For additional information,
see Siebel Smart Answer Administration Guide.

m Agent. Responsible for providing feedback to the system administrator and business analyst
during the development process.

NOTE: The same employee may perform more than one role.

Implementing Siebel Email Response in an
International Environment

Siebel Email Response supports Unicode and the ability to filter templates based on language and
locale settings in a single Siebel Systems environment. No matter whether the database is unicode
or not, incoming email content will be converted to Unicode. If the database is Unicode, then all
characters after the conversion will be saved in the database. However, non-ASCII characters will not
be able to be saved after the conversion. For global deployment resources, see the following list:

Configuring Siebel software to use Global Deployment Guide.
multiple languages. For general Unicode

information, see the sections about global

deployment scenarios.

Siebel Email Response global deployment Chapter 7, “"Global Deployment Setup and
setup, including the Smart Character Set Configuration” in this guide.
feature.
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Supported database code pages. The server installation guide for your operating
system.
Supported languages. Siebel System Requirements and Supported Platforms

on Siebel SupportWeb.

Determining How Agents Use Siebel
Email Response

Agents receive incoming email messages in the Communications screen in the Inbound Item List
view or when a work item is routed to the communications toolbar by Siebel Universal Queuing.

Agents select incoming email messages from their Communications list or accept messages using
the communications toolbar. The way they reply to email depends on the way your organization
chooses to implement Siebel Email Response.

m Siebel Email Response. Agents select appropriate templates or solutions, or compose free-
form content.

m Siebel Email Response with Siebel Smart Answer. Smart Answer reviews the intent of
incoming messages and assigns a category and score that indicates how closely the incoming
email matches the category. The agent reviews the incoming email’s content and the suggested
category. The agent might need only to verify the suggested category, select a solution or
template that is associated with that category, and make additional comments before sending
the reply to the customer.

If an agent is not satisfied with a category provided by Smart Answer, that agent can change the
category for the message and use a different solution or template. Smart Answer records this
change as feedback so that it can improve categorization accuracy.

With both implementations, an agent can attach useful literature or files to a reply, use the spell
check feature to find spelling errors, and look for errors not found by the spell check feature. When
the reply is finished, the agent sends it.

NOTE: No matter whether the database is Unicode or not, incoming email content will be converted
to Unicode. If the database is Unicode, then all characters after conversion will be saved into the
database. Otherwise, non-ASCII characters will not be saved after the conversion. When agents reply
to incoming email, the character set of the reply is determined by the Smart Character Set feature.
For more information on this feature, see “Using the Siebel Email Response Smart Character Set” on
page 111.

For more information about how agents use Siebel Email Response, see Applications Administration
Guide. For more information about Siebel Smart Answer, see Siebel Smart Answer Administration
Guide.
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Working with Siebel Applications

Siebel Email Response can be used with any Siebel application, such as Siebel Sales, Siebel
Marketing, Siebel Service, and Siebel Call Center.

m Sijebel Sales

Agents can generate opportunities from Siebel Email Response that are accessed by sales
representatives.

m  Siebel Marketing

Companies need to be prepared to handle the large quantities of inbound messages generated
as a result of large outbound email campaigns. Siebel Email Response processes customer
responses to the campaign and outgoing messages that are returned to your company because
of incorrect email addresses or overloaded email servers, using the same routing rules defined
for the rest of your company.

m Siebel Service

Siebel Service schedules service requests, installations, projects, and preventive maintenance
activities and dispatches them to the right person. When customers send email requesting a
service call status or a change request, Siebel Email Response routes email to the correct field
agents, allowing them to respond and adjust their schedules immediately.

m Siebel Call Center

A unified, multichannel desktop application with voice, email, and fax channels. The Siebel Call
Center base application includes Siebel Service, Siebel Sales, and the Siebel Email Response
optional module. When logged on to Call Center, an agent can use any available channel to
communicate with customers. If the customer sends email, the agent replies using Siebel Email
Response. If the customer makes a phone call, the agent can switch to the voice channel and
handle the phone call.
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Understanding the Siebel Email
Response Architecture

The Siebel Server and the Siebel Email Response application process incoming emails and handle the
replies. Figure 1 provides a high-level overview of a typical email process, which starts when a
customer sends an email and ends when Siebel Server components (either Communications Inbound
Receiver or Communications Inbound Receiver and Communications Inbound Processor) process the
incoming email and send a reply back to the customer.
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Figure 1. Siebel Email Response Architecture Overview

Understanding Siebel Email Response Workflows

The Siebel Email Response workflow begins when a customer sends an email to your company over
the Internet using that customer’s email software. In example described in Figure 1, the email passes
through the customer’s email server and communicates with your email server using SMTP/POP3
(Simple Mail Transport Protocol and Post Office Protocol 3) communication protocols. The
Communications Inbound Receiver (CIR) uses POP3 to retrieve the inbound message.

Determining Supported Email Sender Software and Email Server
The following guidelines describe the types of email software a sender can use and the types of email
servers that should be used by your company.

® Sender’s email system. The sender can use any email software product currently used on the
Internet.

®  Your email server. The Siebel-provided Internet SMTP/POP3 Server driver has been tested and
certified with a number of email servers. Although many email servers support the SMTP and
POP3 email protocols, it is recommended that you use a supported email server for the following
reasons:

m  These servers have been certified and tested by Siebel Engineering.
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= Siebel Technical Support has access to these servers in supporting customer issues.

See Siebel System Requirements and Supported Platforms on Siebel SupportWeb for support
information about your email system.

Managing Siebel Server Components to Process
Incoming Email

Once a customer sends an email to your company, your email server that is connected to the Siebel
Server receives the email and passes it to the Communications Inbound Receiver (CIR). The
Communications Inbound Receiver (CIR) resides on the Siebel Server and has a primary role in the
Siebel Email Response processes. Three Communications Server components manage inbound and
outbound email messages: Communications Inbound Receiver (receives email), Communications
Inbound Processor (processes and routes email), and Communications Outbound Manager (sends
responses to the email). Workflow Manager invokes other Siebel Server components, such as
Assignment Manager, Universal Queuing, and Smart Answer Manager. Communications Inbound
Receiver uses the Internet SMTP/POP3 Server driver to periodically connect to your email server and
check for new email messages. When Communications Inbound Receiver detects a new message, it
does the following:

®m  Downloads the message and attachments from the email server.

m Parses elements of the email message (To:, CC:, Subject:, and body content) and places them
in memory.

m  Converts this email data into event data which will be saved in the database (if less than 15K)
or the Siebel File System (if greater than 15K).

m If you are using nonreal-time email processing, the Communications Inbound Receiver creates a
SRM request to inform the Communications Inbound Processor that a new event has been
created.

m If you are using nonreal-time email processing, the Communications Inbound Receiver passes
event data from memory to the Communications Inbound Processor.

NOTE: Communications Inbound Processor can start multiple subprocesses so that multiple
instances of a workflow can operate in parallel.

Processing Email in Real-Time and Nonreal-Time
Depending on your business requirements, you can process email in one of the following ways:

B Processing Email in Real-Time

®  Processing Email in Nonreal-Time
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Figure 2 provides examples of different Communications Inbound Receiver and Communications
Inbound Processor configurations for your Siebel Enterprise.

Real Time CIR

Figure 2. Communications Inbound Receiver and Communications Inbound Processor Configuration
Examples.
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Processing Email in Real-Time

Real-Time email processing only uses one server component, Communications Inbound Receiver.
This type of processing is best for businesses with a low volume of email customers or businesses
who primarily use phone events, as these types of events always use real-time mode. Figure 3
describes the architecture for real-time email processing. For information on how to enable real-time
email processing, see “Enabling Real-Time Email Processing” on page 63.

Email
Ernail Client
ShTP
POP3
ShTP
Email Semer Ermail Sermer

Third Party Software
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Lacal Disk Diriwer
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Changes

Figure 3. Real-Time Email Processing.
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Processing Email in Nonreal-Time

Nonreal-Time email processing has both server components, Communications Inbound Receiver
(CIR) and Communications Inbound Processor (CIP) running as separate server components. This
type of processing allows you to have multiple instances of Communications Inbound Receiver (CIR)
and Communications Inbound Processor (CIP) on different Siebel Servers, providing a distributed
architecture which is more scalable and reliable than real-time email processing. Figure 4 describes
the architecture for Nonreal-Time email processing. For information on how to enable nonreal-time
email processing, see “Enabling Nonreal-Time Email Processing” on page 63.

Em ail

Ermail Client

SMTP
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CIR
Local Disk SRE Listener
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Changes

Figure 4. Nonreal-Time Email Processing.

Processing Incoming Email with Siebel Business Process Designer
Communications Inbound Processor uses the Workflow Process Manager in the Siebel Business
Process Designer to process an email message in a number of ways, depending on the workflow
process you select to handle that type of message. Siebel Systems ships several preconfigured
workflow processes that provide email processing features. For more information, see Chapter 5,
“Setting Up Siebel Email Response Workflows.” The Workflow Process Manager in Siebel Business
Process Designer can be set up to perform the following tasks:
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m  Determine the commit time (the time by which you should reply to the message) based on the
customer’s service-level agreement.

® Send the message to Smart Answer Manager for language detection and categorization.
® Send the message to Assignment Manager or Universal Queuing for routing.
®  Write a record to your database if the message is routed to an agent for response.

®  When integrated with routing and queuing software, route incoming email to an agent based on
defined parameters such as agent skills. The selected routing and queuing processes route and
queue messages to the agent with the skills that are necessary to respond to the message.

Determining How an Agent Replies to Email

The agent reviews the message using the Siebel client and composes and sends a reply using
templates configured for your company’s needs. See Figure 1 on page 21 for an illustration of this
process.

Understanding How the Communications Server Returns a Reply to a
Customer

When the agent sends the message, Communications Outbound Manager, a Communications Server
component, sends the replies through your email server using SMTP/POP3 communication protocols.
Your email server then sends the email over the Internet to the customer’s email server and the
customer’s email server sends it to the customer’s mailbox. See Figure 1 on page 21 for an illustration
of this process.
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This chapter covers planning a Siebel Email Response Deployment. It includes the following topics:
B "Using the Siebel Email Response Tools and Resources”
B "“Performing a Business Analysis for Your Siebel Email Response Deployment” on page 27

B “Gathering System Setup Information For Siebel Email Response” on page 30

Using the Siebel Email Response Tools
and Resources

This chapter provides tools and resources to help you implement Siebel Email Response. Setting up
Siebel Email Response for your business will be easier if you:

m Use the planning tools provided.
m  Follow recommendations, unless your business needs dictate otherwise.

This section provides instructions for business analysis and setup planning. Use information gathered
during the business analysis and setup planning processes to set up Siebel Email Response after
installation.

Instructions in each section tell you what needs to be done and why it needs to be done, and provide
suggestions for obtaining answers and more information. Your answers will consist of data you will
use to set up Siebel Email Response.

® Business Analysis Planning. This section helps you analyze your business needs by gathering
business information before you set up Siebel Email Response.

m  Setup Planning. This section helps you gather additional system information you need to set
up Siebel Email Response.

Performing a Business Analysis for Your
Siebel Email Response Deployment

Before you set up Siebel Email Response, analyze your company’s email business needs. Often Siebel
Email Response products are deployed to meet the needs of one group within an organization. After
additional research, other groups that may benefit from the capabilities of a Siebel Email Response
product may be included.
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1 Which groups in your organization have the largest email volume?

Groups with the largest email volume benefit most from using Siebel Email Response. Analyze
all groups in your organization to determine which can benefit from using a Siebel Email
Response product. Mail server administrators in your organization can help you identify the email
addresses that are the most heavily used.

2 What email addresses will you use for Siebel Email Response?

Develop a list of current and/or new email addresses that you want to use for all groups that will
use Siebel Email Response. Specify the email addresses you need to create to receive incoming
email. Your mail server administrator can tell you what email addresses your company currently
uses.

Each email address must be designated as receiving unstructured (free-form) or structured
(keyword-based or Web-form) email.

3 Does your organization use structured (web-form) or unstructured (free-form) email messages?

If your company uses many structured email messages, you might want to use Siebel eService.
This product can automate many of the processes solved with Web forms. For example, service
request submissions or status updates can be automated with Siebel eService.

= Web forms. An example of a Web form is an order status form. Make a list of Web forms
that you may use. If you currently use Web forms, gather examples with your standard
responses.

A Web form saves time because no human interaction is necessary to respond to the initial
email. However, it takes special skills and time to set up and maintain Web forms with their
associated responses. You cannot use them in every situation, but they are useful to handle
high-volume communications that require standard responses.

= Free-form messages. Examples of free-form messages are a free-form email request for a
customer’s order status and a free-form request for help with a product purchased from your
company.

Agents have to respond to each free-form email individually.

When you set up your workflow processes, you will decide which workflow you want to use to
process incoming messages, eMail Response - Process Message or eMail Response - Process
Service Request.

4 What are the most frequently asked questions that you currently receive at each corporate email
address?

Gather examples of the most common questions (with their responses) and estimate how many
you receive of each. Templates can be modified, so you should concentrate on determining the
most frequently asked questions you receive at present.

One of the most valuable features of any email response product is the ability to store templates
that can be used by agents to respond to common questions.

You can identify questions that can be answered with templates by asking customer service
agents for a list of the most commonly asked questions, including the appropriate response for
each. Other sources of template candidates are FAQs (Frequently Asked Questions documents)
that have been developed for your customers.
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What solution documents do you currently use?

A solution document can be any document prepared for customers that provides a fix or a
recommended approach to a problem.

See “Solutions and Templates Decision Table” to find out when to use solution documents (called
FAQs in Siebel eService), when to use reply templates, and how each compares to a free-form

reply.

Gather copies or make a list of these electronic documents and their network locations. Specify
new documents that are needed and existing documents that can be converted to electronic
documents.

What categories do you want to associate with templates and solutions?

Sort the templates and solutions from Step 4 and Step 5 into types of email questions
(categories) and assign a category to each solution and template. During Siebel Email Response
setup, you will associate solutions and templates with categories so that solutions and templates
can be inserted into the body of Siebel Email Response replies.

NOTE: Only templates intended to be used as body templates should be associated to a
category.

Who will be responsible for template maintenance and developing maintenance procedures?

Develop a process and specify a person to be responsible. Develop procedures for maintaining
templates and notifying agents that new or changed templates are available and how templates
are to be used.

You must review templates for changes if your business changes in some way. For example, when
you launch a new product or discontinue a product, you may want to review the templates to
determine whether they need updating. Another example would be adding the URL of a new Web
site to the signature line of an email template.

Do you want to automatically acknowledge receipt of incoming mail?

An auto-acknowledge message sets reasonable customer expectations for a response and
reduces the chance that customers will send follow-up emails or communicate through other
channels.

If there is an existing auto-acknowledge message, obtain a copy. An auto-acknowledge message
should thank the customer for the inquiry and tell the customer how long it will take to respond.

How are groups currently routing email messages? Why do you use the current routing approach?

Determine how each of your target email response deployments (such as, Sales or Call Center)
currently routes an incoming email message to an agent best suited to handle the message. Most
organizations simply have agents select email messages from a list of messages sent to a
particular address. How are incoming email queues managed and why? Why do you use your
current approach to email queues?
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10 Which routing and queuing method meets your needs for email response?

11

When using Siebel Email Response, you can choose from several methods to route email
messages to the correct agent. To review a comparison of different routing and queuing methods,
see “Routing and Queuing Methods Comparison Table.”

The method you use should be based on the way your business needs to route incoming mail.
For example, if you need to notify agents immediately after routing a message, you need Siebel
Universal Queuing or another universal queuing engine. For more information, see Siebel
Universal Queuing Administration Guide.

If your contact center already has CTI software set up, you can use universal queuing
technologies to make multiple media channels available to your agents. For example, customer
service representatives may be dedicated to handling telephone calls, but when they are not busy
with telephone calls, they can be assighed email messages.

Language Support.
a In what languages do your customers send email? In what languages do you reply using email?
b Do you have templates in multiple languages?

For additional information about supported languages, see Siebel System Requirements and
Supported Platforms on Siebel SupportWeb.

12 Do you need to set up multiple organizations for your company?

Gathering System Setup Information For
Siebel Email Response

In this section, you gather system setup information for Siebel Email Response by answering the
following questions:

1

Do you have a working Siebel Systems environment installed and configured by the system
administrator? (Prerequisite.)

For more information, see the Siebel Server Installation Guide for your operating system.
Has your email server been installed and configured? (Prerequisite.)

The email server should have been set up by the Communications Server administrator.
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3 What communications drivers and profiles will you use for Siebel Email Response?

NOTE: You should use the Internet SMTP/POP3 Server driver for connecting to all supported
email servers.

Create communications profile names that correspond to all the mailboxes that you will monitor.
For example, support@siebel.com and sales@siebel.com.

To obtain communications driver parameters (settings), see Siebel Communications Server
Administration Guide. Values assigned to driver parameters apply to every profile that uses that
driver unless you add a profile parameter override value to a profile. Profile parameter overrides
allow you to make each profile unique. These will be explained later in this checklist.

See Siebel Communications Server Administration Guide for more information about
communications drivers, communications driver parameters, and communications driver
profiles.

4 What profile parameter overrides and values need to be established for each profile (email
address) assigned to the communications driver?

A profile parameter override is a setting that overrides the values on the driver used by the
profile.

= If you do not supply a profile parameter override, the default parameter value is taken from
the driver. Some required parameters do not have a default value, such as POP3 Account
Name. You must provide values for all required parameters.

= If you supply a profile parameter override, the override value will be used instead of the
parameter value on the driver.

Each profile has its own parameter overrides that are necessary to connect to the email server
account. For example, a common parameter override is From Address. The From Address
parameter is passed to the SMTP server as the address that will show in the From field in an email
reply. Values you assign make each profile unique. You add profile parameter overrides during
Siebel Email Response setup procedures. For more information about driver profiles and
parameter overrides, see Siebel Communications Server Administration Guide.

5 Which email profiles (mailboxes) will receive Web-form messages and which will receive free-
form messages?

Separate your email profiles into two groups, one to receive Web-form messages (such as,
service requests) and one to receive free-form messages.

Take each of these two groups of email profiles and separate the profiles into groups that have
the same types of email behaviors (input arguments). Each of these profiles will be associated
with a single response group. Assign a meaningful name to each group.

These groups will be response groups and their associated profiles that you will create in
Chapter 4, “"Completing Basic Setup Tasks.” Choose the following values for each group:

= Name. Choose a meaningful name for each response group.

= Administrator email address. Choose the email address to which you want to direct
unprocessed email (email that cannot be processed due to database error, routing error, and
so on) that is sent to profiles in each response group.
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= Description. Describe the types of email behaviors each response group controls. This
information prepares you to set up input arguments for each response group.

What email behaviors (input arguments) are needed for each profile type?

Input arguments provide information to a business service so it can process incoming email.
Because input arguments control the way email is handled, all profiles in a response group must
have the same input arguments.

Using the response group description from Step 5, assign the input arguments for each group of
email profiles. For a list of available input arguments, see “Siebel Email Response and Business
Services.”

Do you need to modify the workflows included with Siebel Email Response?

Even if you decide not to modify the predefined workflows, you must activate them in the
Administration - Business Process screen before starting Siebel Server and receiving incoming
email. For additional information about predefined workflows, see “Using Siebel Email Response
Workflow Processes” in Chapter 5, “Setting Up Siebel Email Response Workflows.”

CAUTION: If you modify a workflow, it will not be upgraded when you upgrade your Siebel
application. You will need to recreate all modifications in the prebuilt workflows in the new
version of your application.

For information about creating and modifying workflows, see Siebel Business Process Designer
Administration Guide.

Which routing and queuing method will you use to route incoming email to agents?
By default, email messages are recorded in your database as activities or service requests.

Identify the routing and queuing methods you will use: manual assignment, Siebel Assignment
Manager, Siebel Universal Queuing, or custom routing and queuing. See “Routing and Queuing
Methods Comparison Table” for a description of the advantages and disadvantages of each.

See Siebel Assignment Manager Administration Guide and Siebel Universal Queuing
Administration Guide for information about creating routing and queuing rules for each system.

Do you need to set up Siebel Smart Answer?

If you have purchased the Siebel Smart Answer module (optional), use Siebel Smart Answer
Administration Guide to implement it.

Do you want to process emails using real time mode or nonreal-time mode?

Depending on your business requirements, you can set up Siebel Email Response for real-time
or nonreal-time processing. For more information, see “Processing Email in Real-Time"” on page 24
and “Processing Email in Nonreal-Time” on page 25.

Is your email server enabled for Secure Sockets Layer (SSL)?

Siebel Email Response allows the POP3 and SMTP drivers to work with email servers that are
enabled for SSL. For more information, see “Creating Secure Sockets Layer (SSL) Connections for
SMTP and POP3 Drivers” on page 12.
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This chapter covers completing basic setup tasks for Siebel Email Response. It includes the following
topics:

m  “Setting Up Siebel Email Response”

®  “Performing Prerequisite Tasks for Siebel Email Response” on page 34

m  “Performing Setup Tasks for Siebel Email Response” on page 35

m  “Revising, Testing, and Activating Workflow Processes” on page 36

®  “Implementing Routing and Queuing Processes” on page 38

m  “Setting Up Communications Server for Siebel Email Response” on page 40
m  “Creating Templates, Catalogs, and Categories” on page 51

m “Starting Siebel Email Response Server Tasks” on page 63

®  “Enabling a Secure Sockets Layer (SSL) Connection for SMTP and POP3 Drivers” on page 68

Setting Up Siebel Email Response

Setting up Siebel Email Response for your business will be easier if you plan your setup using
Chapter 3, “Planning a Siebel Email Response Deployment,” before you use the setup procedures in
this chapter.

NOTE: Before implementing Siebel Email Response, you must provide your users with adequate
training.

Prerequisite tasks. Your organization needs to complete some configuration and installation tasks
before setting up Siebel Email Response. This section describes these tasks and tells you where you
can find more information about them.

Basic setup instructions. This section provides step-by-step instructions for setting up Siebel
Email Response using information you gathered in Chapter 3, “Planning a Siebel Email Response
Deployment.”

If you purchased the Siebel Smart Answer add-on module, use Siebel Smart Answer Administration
Guide to implement Smart Answer after completing this chapter.
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Performing Prerequisite Tasks for Siebel
Email Response

This section describes the tasks that need to be completed before you set up Siebel Email Response.
See Siebel System Requirements and Supported Platforms on Siebel SupportWeb for specific system
requirements, such as names of supported email servers.

Before you attempt to set up Siebel Email Response, confirm that the following tasks have been
completed. Your network administrator can help identify who in your organization performs each
task.

m Siebel Server is installed. For more information, see the Siebel Server Installation Guide for
your operating system.

You must have a working Siebel Systems environment installed and configured by the system
administrator before setting up Siebel Email Response.

= During the Siebel Server installation, the following items are installed and configured:
0 Database server
0 Gateway server
0 Siebel Server
[0 Siebel eBusiness Application Integration (if you will use a universal queuing application)
[0 Siebel Web Server Extension (EAppWeb)
= During the Siebel Server installation, the following components are enabled:

0 Communications Management includes (Communications Inbound Receiver,
Communications Inbound Processor, and Communications Outbound Manager)

[0 Siebel Call Center (includes Siebel Email Response, Siebel Smart Answer, and Siebel
Service)

Component groups can also be enabled after the Siebel server installation.

= During the Siebel Server installation, the spell check feature is installed.

The spell check feature is automatically installed and enabled as part of the Siebel Server
and Mobile Web Client installation processes. Spell Check dictionaries are installed in several
languages. For a list of supported languages, see Siebel System Requirements and Supported
Platforms on Siebel SupportWeb.

m Siebel Universal Queuing is installed (optional). If you have chosen to use Siebel Universal
Queuing or a third-party universal queuing application, install and configure it using the
application documentation. For information about Siebel Universal Queuing, see Siebel Universal
Queuing Administration Guide.

® The email server is installed, configured, and tested. For installation and configuration
information, see the installation instructions you received with your email server. See Siebel
System Requirements and Supported Platforms on Siebel SupportWeb for a list of supported
email servers.
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Basic tests are performed. Before you set up Siebel Email Response, perform the following
tests:

m  Verify network connectivity by establishing the presence of the email server from the Siebel
Server.

= Test the email server, and make sure your email server is properly set up. To do this, verify
that you can communicate to and from each email account you create. For each email
account, you can use any email client to:

0 Set up test accounts
0 Send email from each test account to itself

0 Send email from each test account to an account outside your company

Performing Setup Tasks for Siebel Email
Response

You must complete the following tasks before you can use Siebel Email Response.

Revise and test workflow processes. Workflow processes from the Siebel Business Process
Designer control the way incoming email is processed. All revisions and tests of workflow
processes are done through Siebel Tools. For information on revising workflow processes, see
“Revising Workflow Processes” on page 37. For information on testing workflow processes, see
“Testing Workflow Processes” on page 37.

Activate workflow processes. Once you have completed your revisions, you need to activate
the workflow processes in your Siebel Email Response application. For information on activating
workflow processes, see “Activating Workflow Processes” on page 38.

Implement your routing and queuing application. Tasks depend on the routing and queuing
application you choose to implement. You can choose one of the following applications:

= Use Siebel Assignment Manager to create new assignment rules that route email to an agent
who has the appropriate skills.

= Use Siebel Universal Queuing to create an email channel, routes, and escalation rules, and
associate escalation rules with routes.

NOTE: If you have chosen to use a third-party routing and queuing product, consult that
product’s documentation for implementation instructions.

Set up Communications Server for Siebel Email Response. You use the Administration -
Communications screen to assign values to communications driver fields (such as, email server
name) and create Siebel Email Response driver profiles and response groups. The server
components you will use are Communications Inbound Receiver (for receiving email),
Communications Inbound Processor (for processing emails in nonreal-time mode) and
Communications Outbound Manager (for replying to emails).

Create templates, a catalog, and categories. Use the Administration - Communications
screen to create templates. Use the Administration - Catalog screen to create a catalog and
categories. This includes associating templates and solutions with categories.
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m Start the server components. Depending on your server architecture, start one or more of the
following server components:

s Communications Inbound Receiver

= Communications Inbound Receiver and Communications Inbound Processor (if you are using
nonreal-time email processing)

m Communications Outbound Manager (for either real-time or nonreal-time email processing)

If you make any changes (other than profile or response group changes) to your Siebel Email
Response setup after implementation, you must stop and restart the Communications Inbound
Receiver, Communications Inbound Processor, and Communications Outbound Manager server
components so that your changes take effect. If you make profile or response group changes,
you can submit them without stopping the server components. For information on submitting
profile, see “Submitting Profile Changes” on page 45. For information on submitting response
group changes, see “Submitting Response Group Changes” on page 50.

m If you purchase Siebel Smart Answer (optional module), set it up using Siebel Smart Answer
Administration Guide after you complete your Siebel Email Response setup.

Revising, Testing, and Activating
Workflow Processes

Siebel Email Response comes with a number of predefined workflow processes, which allow
organizations to deploy Siebel Email Response without having to create an entire workflow. Some
organizations may want to use one or more of these workflows with a few modifications. An
organization with complex needs might want to revise one of the existing workflows or create its own
custom workflow. See Siebel Business Process Designer Administration Guide for information about
creating or revising a workflow process. You activate workflows in the Repository Definitions view
under the Administration - Business Process screen.

Determining Workflow Status
Workflows are shipped with a status of Completed. You may want to make changes to the workflows,
but it is not required. A workflow can have the following status:

m  Completed. Preconfigured Siebel Email Response workflows have a status of Completed.
Completed workflows must be activated before they can be used.

m In Progress. You must change the status of a workflow process to In Progress before you can
make changes to it.

m  Active. An activated workflow will be used to process Siebel Email Response work items. Only
one workflow for each process can be active.

Setting the Workflow Step Execution Log Level
The Workflow Step Execution Log Level allows you to follow the steps in a workflow as it processes
an email. The following procedure describes how to set the Workflow Step Execution Log Level.
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To set the Workflow Step Execution Log Level

1 From the application-level menu, choose Navigate > Site Map > Administration - Server
Configuration > Servers.

2 In the Siebel Servers list, select the server containing the workflow whose status you want to
check.

Click the Components view tab.

Perform a query for Communications Inbound Receiver.

In the Components list, select the Communications Inbound Receiver.
Click the Events subview tab.

In the Event Type list, perform a query for Workflow Step Execution.
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Select Workflow Step Execution and set the log level to 5.

Revising Workflow Processes

Some organizations may want to use one or more of these workflows with a few modifications. An
organization with complex needs might want to revise one of the existing workflows or create its own
custom workflow. See Siebel Business Process Designer Administration Guide for information about
creating or revising a workflow process. The following procedure describes how to revise a workflow
process.

To revise a workflow process
1 In the Siebel Tools Object Explorer, select the Workflow Processes object.

2 In the Workflow Processes list, perform a query for Process Name = eMail*.

3 In the Workflow Process list, select the workflow process you want to change and click Revise.
The status of the workflow process changes to In Progress.

4 Right-click the workflow process you want to change and choose Edit Workflow Process.
The Business Process Designer appears.

5 In the Business Process Designer, make your changes to the workflow process and return to
Siebel Tools.

6 Right-click the workflow process you have made changes to and choose Validate...

7 1In the Workflow Processes list, select the workflow process you have made changes to and click
Deploy.

Testing Workflow Processes
Before activating a workflow process, you can test it to make sure the workflow is functioning
correctly.
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To test a workflow process
1 In the Siebel Tools Object Explorer, select the Workflow Processes object.

2 In the Workflow Processes list, perform a query for Process Name = eMail*.

3 Right-click the workflow process you want to test and choose Simulate Workflow Process.

Activating Workflow Processes

You must activate all Siebel Email Response workflows before starting Siebel Email Response. From
the application you can only view and activate workflow processes. If you want to make changes to
the workflow processes you must use Siebel Tools. A server parameter (Workflow Version Checking
Interval) controls how often the server component checks for recently activated versions of each
process definition. Workflows are refreshed approximately every hour. After each refresh, recently
activated workflows are available. For a list of predefined Siebel Email Response workflows, see
Chapter 5, “Setting Up Siebel Email Response Workflows.”

You activate workflow processes by completing the following procedure.

To activate workflow processes

1 From the application-level menu, choose Navigate > Site Map > Administration - Business
Process > Workflow Deployment.

2 In the Repository Workflow Processes list, perform a query for Siebel Email Response workflow
processes with a status of Completed.

3 Select the workflow process you want to activate and click Activate.

In the Repository Workflow Processes list, the Status of the workflow processes changes to
Active.

4 Repeat Step 1 through Step 3 for each Siebel Email Response predefined workflow you want to
use. For a list of predefined Siebel Email Response workflows, see “To see a list of preconfigured
Siebel Email Response workflows” on page 71.

Implementing Routing and Queuing
Processes

Siebel Email Response workflows record incoming emails in your database, except for messages
identified as junk email. The eMail Response - Process Message workflow creates an activity record
and the eMail Response - Process Service Request workflow creates a service request record.

The Process Message and the Process Service Request workflows can use the routing and queuing
features in Siebel Assignment Manager and Siebel Universal Queuing to further automate your email
interactions. Routing and queuing application choices include Siebel Assignment Manager, Siebel
Universal Queuing, and third-party universal queuing applications. See Step 9, where you
determined the routing and queuing method you will implement.
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Siebel Assignment Manager can assign ownership of email activities and service requests. Siebel
Universal Queuing can queue an email to a specific individual based on real-time analysis of agent
availability, agent skills, language, and variety of other routing and escalation attributes.

Your organization can use the preconfigured routing and queuing rules provided by Siebel Email
Response, revise the preconfigured rules, or create new rules. Before you start Siebel Email
Response and process your incoming email messages, you must activate the Siebel Email Response
workflows, make changes to the routing and queuing method you choose to implement, and start
the server tasks associated with that routing and queuing method.

You can route email in one of the following ways:

®  Manual assignment. A person dedicated to the routing process manually assigns each incoming
email to an agent as it arrives, or agents select a message from a message queue.

m Siebel Assignment Manager. You can use Assignment Manager to assign emails by setting the
Enable Assignment Manager process property in the Email Response - Process Message workflow
in the following ways:

= Assignment Manager will assign emails for all response groups if you set the process property
to TRUE.

= Assignment Manager will assign emails for a specific response group if you set the process
property to TRUE for that response group.

After enabling Assignment Manager, you use information in Siebel Assignment Manager
Administration Guide to:

= Verify that each employee in your database has been assigned the appropriate skills to
respond to incoming email. For example, you might assign each employee an email recipient
address and define competencies, expertise level, and exception hours.

m  Set up the service regions and associate each employee with a service region.

= Create new assignment rules, assign criteria, define employees, and release the rules.
m  Activate Territory Assignment Manager.

m  Test your Territory Assignment Manager setup.

m Siebel Universal Queuing or a third-party universal queuing product. You can use UQ to
assign emails by setting the Enable Universal Queuing process property in the eMail Response -
Process Message workflow in the following ways:

= UQ will route and escalate emails for all response groups if you set the process property to
TRUE.

= UQ will route and escalate emails for a specific response group if you set the process property
to TRUE for that response group.

After enabling UQ, use information in Siebel Universal Queuing Administration Guide to perform
the following tasks in the UQ Administration screen:

= In the Channels view, create one email channel and add properties. Two properties can be
used for Siebel Email Response channels: Receiver Address and Sender Address.

= In the Routes view, create routes, escalations, and escalation rules and associate escalation
rules with routes.
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0 Routes define high-level criteria such as route priority and service-level times.

0 An escalation step defines the time an email can wait in queue before it is passed to the
next step. Steps are assigned an order number to control the escalation sequence.

00 Escalation rules establish the criteria that determine the agent skills (such as language
and level of product knowledge) that are necessary to handle each escalation step.

= In the Employees view, for each employee, assign skills, employee competencies for each
skill, expertise for each competency, and the number of simultaneous sessions the employee
can have open.

0 Assign skill categories such as language, employee competencies, and expertise for each
competency, such as French (Expert) and English (Novice).

0 Select the email channel and assign the maximum number of email items (Simultaneous
Sessions) for a specific channel that an agent can be assigned at any given time. This
number must be at least 1 for the agent to receive email for the email channel. When set
to 1, an agent can receive a maximum of one work item at a time for that channel.

= Activate UQ and test your UQ setup.

Setting Up Communications Server for
Siebel Email Response

Siebel Communications Server supports many communication channels used to communicate with
customers through server components including Communications Inbound Receiver,
Communications Inbound Processor, and Communications Outbound Manager.

NOTE: If you ever need to change the number of tasks or threads for Communications Inbound
Receiver, be aware that Maximum Tasks should always be greater than Maximum Threads.

Setting Up Communications Server for Real-Time Email Processing
When you use real-time email processing, you are only using one server component, the
Communications Inbound Receiver, to receive and process email. The Communications Inbound
Receiver monitors email accounts (email addresses) by using communications driver profiles to
check for inbound messages. When an inbound email is detected, the Communications Inbound
Receiver receives the email message and sends it through the Workflow Process Manager for
processing . After the email has been processed and an activity created, the message is either stored
in the database (if it is less than 16K) or the Siebel File System (if the email is larger than 16K). The
role of the SRB Listener is to receive inbound requests from some other component. For example,
when you submit profile or response group changes, the SRB executes these commands.
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Setting Up Communications Server for Nonreal-Time Email Processing
When you use nonreal-time email processing, the Communications Inbound Receiver monitors email
accounts (email addresses) by using communications driver profiles to check for inbound messages.
When an inbound email is detected, Communications Inbound Receiver pulls the email from the email
server, converts it into event data, and creates an SRM request to inform Communications Inbound
Processor that a new event has been created. Communications Inbound Processor uses workflows to
process and routes the event. Communications Outbound Manager uses communications driver
profiles to handle outbound communications to customers.

You set up communications drivers and profiles to connect the communications server to your email
server.

Communications drivers. Drivers specify the protocol used to access the email server, and driver
parameters control the behavior of each driver. For example, the Internet SMTP/POP3 Server driver
logs in to the POP3 server and checks for new mail at an interval set in the PollingInterval driver
parameter.

You can use the same communications driver for different purposes. For example, you can associate
the same communications driver to perform the following tasks:

B Monitor multiple email accounts (addresses).

B Monitor email addresses for other departments in your organization, such as an eMarketing
outbound campaign.

NOTE: Although you can use the same communications driver for multiple purposes, make sure that
you set up a unique email address and response group for each group and purpose.

CAUTION: Changes made to a communications driver’s parameters affect everyone who uses that
driver. Therefore, the person in your organization who maintains communications drivers should
make or approve all changes. See Siebel Communications Server Administration Guide for more
information.

Communications driver profile. A driver profile specifies a specific mailbox for monitoring and
rules (profile parameter overrides) for the way the driver should behave while monitoring that
mailbox.

Communications drivers and profiles used for Siebel Email Response allow Communications Inbound
Receiver to monitor mailboxes for inbound messages. Other communications channels, such as voice
use different communications drivers and profile types.

Each communications driver profile used by Siebel Email Response processes both incoming and
outgoing email. Therefore, each driver profile should be configured for both.

To set up Communications Server for Siebel Email Response:

® Set up your communications driver parameters to establish defaults for all profiles using this
driver.

m Create a communications driver profile for each email account that Siebel Email Response will
monitor (includes creating profile parameter overrides).

B Create at least one response group (includes creating input arguments and associating a profile
with a response group).

To accomplish these tasks, use this chapter and Siebel Communications Server Administration Guide.
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Setting Up Communications Driver Parameters

Siebel Email Response uses the Internet SMTP/POP3 Server driver for sending and receiving email
messages. The Internet SMTP/POP3 Server driver has a number of driver parameters that define the
default behavior of this driver. Organizations may have multiple mailboxes they wish to monitor such
as support@siebel.com, sales@siebel.com, and marketing@siebel.com. These mailboxes can share
common parameters. For example, support@siebel.com, sales@siebel.com, and
marketing@siebel.com might have the same SMTP Server and POP3 Server parameter
(mail.siebel.com). For more information, see “How the Internet SMTP/POP3 Driver Processes Email
Messages.”

The administrator can set default driver parameters for the SMTP/POP3 driver, instead of setting
these values for each profile they create. If, however, the administrator has another mailbox (such
as support-japan@siebel.com) that is on a different POP3 server and SMTP server (such as
japan.siebel.com), the administrator has to create profile parameter overrides for POP3 and SMTP
Server only for the support-japan@siebel.com profile.

The most common driver parameters that an administrator might change are parameters that are

relatively consistent across most of an organization’s mailboxes, such as those for the SMTP Server
and POP3 Server, or parameters that need to be changed occasionally for all profiles. For example,
if an administrator is troubleshooting the communications setup and wants to turn on debug logging,
the administrator changes the LogDebug parameter to TRUE.

The administrator can set up a SMTP backup server, the host name or IP address of the machine on
which the backup Internet SMTP server is running, as appropriate for your network configuration.
This parameter is used when you have implemented a failover strategy for your SMTP server handling
outbound email or fax communications. For more information, see Siebel Communications Server
Administration Guide.

To set up your communications driver parameters, see Siebel Communications Server Administration
Guide.

NOTE: To make sure you use a supported communications driver, see Siebel System Requirements
and Supported Platforms on Siebel SupportWeb for specific system requirements.

Understanding Communications Driver Profiles

Siebel Communications Server profiles map to individual accounts or mailboxes on a server. For
example, support@siebel.com or info@siebel.com are valid accounts to which a profile can be
mapped.

Because you can use the same driver for many different profiles, you must create a unique profile
to differentiate each of your email server accounts. For example, support@siebel.com and
info@siebel.com must have separate profiles. Although you can use any name you choose, it is
recommended that you use the email address as the profile name. This makes each profile easier to
identify.
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You can determine what email profiles are available in the From drop-down list on an email reply by
associating profiles with responsibilities. For example, you might want your support representatives
to send replies only from support@siebel.com and your marketing representatives to send replies
only from info@siebel.com. To accomplish this, create a responsibility for each group and associate
each profile and agent with the appropriate responsibility.

Each profile has parameter overrides that assign unique behaviors to it. For example, a common
parameter override is Mail Password. The instructions in this section provide basic information for
creating a communications driver profile. For more detail, see Siebel Communications Server
Administration Guide.

NOTE: Repeat the following procedures for each Siebel Email Response mailbox. For more
information, see Siebel Communications Server Administration Guide.

To create a communications profile, complete the following tasks in the order presented:
1 Creating a Communications Driver Profile

2 Assigning Parameter Overrides for a Communications Profile

3 Submitting Profile Changes

CAUTION: To delete a profile, you should delete it only from the response group. Do not delete it
from the Profiles list because Communications Outbound Manager might be using it to send a
message and emails could be lost.

Creating a Communications Driver Profile

When creating a communications profile, you must first create a communications driver profile. You
can create a communications driver profile by completing the following procedure.

To create a communications driver profile

1 From the application-level menu, choose Navigate > Site Map > Administration -
Communications > Communications Drivers and Profiles.

The Communications Drivers list appears.
In the Communications Drivers list, select the Internet SMTP/POP3 Server driver.
Click the Profiles tab.

In the Profiles list, click New.
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Using information gathered during the planning process, complete the necessary fields to add a
profile. Use the values you chose in “"Gathering System Setup Information For Siebel Email
Response.”

See the table at the end of this procedure for profile field descriptions.
a In the Name field, type the name of the profile you want to add.
b Select an organization to associate with the profile.

0 If your company has only one organization, do not change the default value.
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0 If your company has multiple organizations, click the select button and select the
appropriate organization in the Pick Organization dialog box.

Cc To assign the appropriate responsibilities, click the select button and select the responsibilities
needed for this profile in the Responsibilities dialog box.

Field Name Default Value Description

Name Required. The name of the profile (the mailbox you
want to monitor). It is recommended that you use the
email address as the profile name.

Organization Default Required. When an email sender has contact records
Organization that exist in multiple organizations, Siebel Email

Response can use the organization ID on the receiving
profile to look up the sender. To make this possible,
you must add an input argument called Lookup
Sender By Organization to the response group and set
the value to TRUE. This value also dictates which
profile is being shown in the picklist.

Responsibilities Optional. Determines what email profiles show in the
From drop-down list on an email reply. Only the email
profiles associated with these responsibilities show for
users whose personal profiles contain the same
responsibilities.

Assigning Parameter Overrides for a Communications Profile

The next task is to assign parameter overrides for the profile. Some driver parameters have no
default value. If a parameter is required, you must assign the value as a profile parameter override
when you create the profile. This is what determines whether a profile would be shown as owner,
same organization, or one of responsibility.

To assign parameter overrides for a profile
1 In the Profiles list, make sure you have selected the appropriate profile.

2 In the Profile Parameter Overrides list, click New.

3 Using information gathered during the planning process, add the necessary parameter override
fields. Use the values you chose in “Gathering System Setup Information For Siebel Email
Response.”

a In the Name drop-down list, select the name of the driver parameter for which you want to
change the value.

If you cannot see the entire name in the drop-down list, pass your cursor over it to make the
full name appear.

b Complete the Value field.

Repeat for each profile parameter override.
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Submitting Profile Changes

The final step in creating a communications profile is to submit any profile changes. When you submit
profile changes, you unload the profile and profile configuration settings from all response groups
that are loaded with the profile. You also /oad the profile in all of the response groups that are
configured with the profile.

You should submit profile changes in the following situations:

m If you have only changed the communication profile parameters (or the underlying driver
parameters) on a communications profile that is currently loaded by at least one response group.

NOTE: If you submit profile changes for a communication profile that is not loaded by a response
group, nothing will happen.

m If you have removed a profile from a response group and you only want the profile to be unloaded
without unloading and reloading all of the other profiles. To accomplish this, remove the profile
from the response group and then submit profile changes. This causes the response group to
unload the profile.

m If you want to move a communication profile from one response group to another you have to
remove the profile from one response group do a submit and then add the same profile to another
response group and do a submit. By submitting profile changes you cause the communication
profile to stop executing in one response group (the one you moved the communication profile
from) and start executing in the other response group (the one you moved the communication
profile to).

You can submit profile changes by completing the following procedure.

To submit profile changes

1 From the application-level menu, choose Navigate > Site Map > Administration -
Communications > Communications Drivers and Profiles.

2 In the Communications Drivers list, select Internet SMTP/POP3 Server.
3 Click the Profiles tab.

4 In the Profiles Menu drop-down list, select Submit Profile Changes.

Setting Up a Response Group

A response group defines behaviors (input arguments) for one or more profiles. Communications
Inbound Receiver processes each item based on the input arguments in the response group. When
Communications Inbound Receiver starts, it searches for all active response groups and starts them.
Because Siebel Email Response processes are managed by Siebel Business Process Designer,
response groups use the Workflow Process Manager business service and the RunProcess method for
Siebel Email Response work items as defaults.
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You begin the setup process by first creating a response group. Then, you assign input arguments
that tell Communications Inbound Receiver how to monitor incoming mail for all profiles in the
response group. Input arguments allow you to define auto-acknowledgment messages, error
messages, and business component fields. Each response group method has different input
argument settings.

NOTE: You cannot change the method name of a response group after you generate input
arguments.

If you want to make changes to a response group or profile, see "Making Changes to Response Groups
and Profiles” on page 49. After making any changes to a response group or profile, you must submit
the response group changes for them to take effect.

The final task in setting up response groups is associating the response group with profiles (email
addresses). All mail sent to these profiles will be handled as specified by the input arguments
assigned to the response group.

CAUTION: A profile should not be associated with more than one active response group or messages
may be lost.

To set up response groups, perform the following tasks in the order in which they are presented:
m Creating a Response Group

B  Adding Input Arguments to a Response Group

m  Associating Profiles with a Response Group

® Making Changes to Response Groups and Profiles

®  Submitting Response Group Changes

m Starting a Response Group

CAUTION: When deleting a response group, you should only delete it from the response group. Do
not delete it from the Profiles list because Communications Outbound Manager might be using it to
send a message and emails could be lost.

Creating a Response Group
The first task is to create a response group.

To create a response group

1 From the application-level menu, choose Navigate > Site Map > Administration -
Communications > All Response Groups.

2 In the Response Groups form, click New.
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3 Using information gathered during the planning process, complete the necessary response group
fields from the table below.

Use Table 3 to complete the response group fields.

Table 3. Response Group Fields

Name Default Value Description
Name Required. The name of the response group.
Service Name Workflow Process | Required. Do not change.
Manager
Method Name RunProcess Required. Do not change.

Administrator Optional. You should change this value. The email
Email Address address to which a notification is sent when server
errors occur.

Description Optional. A field to enter notes about this response
group. It is recommended that you the behaviors that

apply to all profiles in this response group.

Adding Input Arguments to a Response Group
The next task in setting up a response group is to add input arguments to the response group.

To add input arguments to a response group
1 Click the Input Arguments view tab.
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2 1In the Input Arguments list, click Generate Defaults.
Default input arguments appear on the Input Arguments list.

Default input arguments are based on the business service method. For a list of Siebel Email
Response process properties used as input arguments, see “Modifying Frequently Used Siebel
Email Response Process Properties.” For more information about frequently used input arguments,
see Chapter 5, “Setting Up Siebel Email Response Workflows.”

Table 4 lists the input arguments for response groups.

Table 4. Input Arguments For Response Groups

Name Type Description
Process Name Email Response - Required field. The name of the
Process Message workflow process that processes
Siebel Email Response inbound
messages.

Change to Email Response - Process
Service Request for keyword-based
response groups.

Required field. Default input
argument. Not used.

Catalog Name String Required field. Kilobyte name to
be used in Smart Answer.

Disable Send Acknowledgment | TRUE or FALSE Default value is FALSE. If you
change this input argument to True,
no acknowledgement will be sent.

Enable Assignment Manager TRUE or FALSE Default value is FALSE.

Enable Universal Queuing TRUE or FALSE Default value is FALSE.

Enable Lookup Sender By TRUE or FALSE Default value is FALSE.
Organization

Enable Test Mode TRUE or FALSE Default value is FALSE.

Real Time TRUE or FALSE

MsgDefaultLanguageCode Input argument for the default

language of the email message.

3 Select the eMail Response - Process Message workflow, and add the Catalog Name input
argument:

a In the Input Argument list, click New.

b In the Name field, type Catalog Name.
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c In the Value field, type the catalog name.

You will create this catalog and its categories in the procedure named “To create a catalog for
the Email Response - Process Message workflow.”

4 Add other new input arguments using information gathered during the planning process. Use the
values you chose in “Gathering System Setup Information For Siebel Email Response” on page 30.

a Click New.

b Type the name and value of the input argument exactly as they appear in the tables in “Siebel
Email Response and Business Services.”

5 To delete an input argument record, click Delete.

Associating Profiles with a Response Group
The next task you must perform is to associate profiles with the response group.

To associate profiles with a response group
1 Click the Profiles view tab.

2 In the Profiles list, click New.
The Add Communication Profiles dialog box appears, listing existing profiles.

3 In the Add Communication Profiles dialog box, select profiles you identified in “Gathering System
Setup Information For Siebel Email Response.”

Only profiles you have added will display on the list. To add more profiles, see “To create a
communications driver profile.”

4 Click the drop-down arrow to view and select additional profiles.
5 Click OK to associate the selected profiles with the response group.

The profiles appear in the Profiles list.

Making Changes to Response Groups and Profiles

Most of the changes that you can make to a response group do not automatically take effect. To have
a change take effect, you must click Submit Response Group Changes (for response group changes)
or Submit Profile Changes (for profile changes) from the File menu. The one change that does
automatically take effect is deleting a response group.

The types of changes you can make are:
® Adding or deleting a profile

® Changing an input argument

® Changing a workflow

NOTE: The Submit Response Group menu item does not work on the Siebel Mobile Web Client.
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Submitting Response Group Changes

If you make changes to the response group input parameters, add a profile to the response group,
or remove a profile from the response group, you must submit the response group changes for them
to take effect.

To submit response group changes

1 From the application-level menu, choose Navigate > Site Map > Administration -
Communications > All Response Groups.

2 In the Response Group list, select the response group to which you want to make changes.
3 Click the Response Group view tab.

4 In the Response Group form, verify the following fields:

Field Value

Server <Sijebel Server name>

Startup Active

5 In the Response Groups menu drop-down list, select Submit Response Group Changes.

Starting a Response Group
You can choose to manually or automatically start a response group.

Manually Starting a Response Group
Complete the following procedure to manually start a response group.

To manually start a response group

1 From the application-level menu, choose Navigate > Site Map > Administration -
Communications > All Response Groups.

2 In the Response Group list, select the response group you want to start.

3 In the Response Groups menu drop-down list, select Submit Response Group Changes.

Automatically Starting a Response Group

When Communications Inbound Receiver starts, it looks at the Active and Server field to determine
whether a response group should be started or not. When the response group status changes from
Blank/Manual to Active, the change will be picked up by Communications Inbound Receiver and the
response group will be started.

NOTE: There is one component task for each response group. If you have two or more response
groups, two or more component tasks will be started automatically.
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Communications Inbound Receiver can start multiple component tasks, one for each response group.
Each task has multiple subtasks, representing a workflow thread that can process inbound messages.

Creating Templates, Catalogs, and
Categories

Templates allow agents to respond to inbound email messages by using templates, messages that
have already been created and approved for specific situations. Your initial templates can be created
at any time during the planning process and can be modified or new ones added any time after
implementation.

NOTE: Usually your database contains the same repository data as the SRF file. However, if you
create templates on a local database, such as on a mobile Web client, they will be available in the
picklist only when you access the local database.

The templates that appear to an agent depend on the agent’s Outbound Communications user
preference settings and how the templates are filtered. For more information about setting user
preferences, see Applications Administration Guide. Templates are filtered in the following ways:

A catalog is the name you give to a group of categories. You can define one or more catalogs for use
by Siebel Email Response as follows:

B You need only one catalog if everyone in your organization can share the same categories.
B You need multiple catalogs if some categories cannot be used by everyone in your organization.
A company could have two groups that share one catalog and a third group that has its own catalog.

A catalog must be defined as a response group input argument. It contains categories that you can
associate with templates and solutions. During the planning process, you gathered and categorized
templates and solutions.

Templates and solutions that contain answers to similar questions are associated with a single
category. When agents use categories, they do not have to look through all templates and solutions
to find the information that they want to send to a customer. They can use Search Center to look
through the templates and solutions that are grouped in the appropriate categories. To use Search
Center for this purpose, the categories have to be indexed. For information, see Siebel Search
Administration Guide.

Using Substitution Fields in Siebel Email Response
Templates

Templates can include template substitution fields that obtain data directly from your database, such
as a customer name or a service request status. You insert a substitution field by selecting it in the
Available Substitutions list, copying the substitution, and pasting it into the Template Text field at
the place where you want the value to appear. In a template, you can use substitution fields from
only one recipient group.
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Setting Up Workflow to Use Substitution Fields

Templates in Siebel Email Response can include substitution fields from any business component that
has a correctly configured relationship to the Communications Outbound Email Business Component.
Business components with this relationship include Account, Campaign, Contact, Opportunity, and
Service Request.

Before you attempt to set up templates that include substitution fields other than the default active
business component, you must modify the Email Response - Response Workflow.

To set up Siebel Email Response templates substitution fields
1 In the Siebel Tools Object Explorer, select the Workflow Processes object.

2 In the Workflow Processes list, perform a query for eMail Response - Response Workflow.
3 In the Workflow Processes list, select eMail Response - Response Workflow, and click Revise.
4

In the Workflow Processes list, right-click eMail Response - Response Workflow and choose Edit
Workflow Process.

The Business Process Designer appears.

5 Right-click the Get Response Text business service step and choose Show Input Arguments.

6 In the Input Arguments list, add the following input arguments:
Property
Input Argument Type Value Name
ActivityBusComp Literal Action
ActivityBusObj Literal Action
Sourceld Process Property Object Id

7 Right-click the Expand Template Text business service step and choose Show Input Arguments.

8 In the Input Arguments list, add the following input argument:

Property
Input Argument Type Value Name

Expand Template Literal Y

9 In the History Toolbar, click Back to return to Siebel Tools.

10 In the Workflow Processes list, right-click eMail Response - Response Workflow and choose
Validate...

11 In the Workflow Processes list, select eMail Response - Response Workflow and click Deploy.

NOTE: Additional business components can be enabled for template substitutions using Siebel Tools.
For information, see Using Siebel Tools.
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Enabling Additional Business Components to Use as Substitutions
Recipient groups are based on business objects. When you create a template, you associate it with
a recipient group. Siebel Email Response checks the recipient group assigned to the template to
determine the associated business object. For example, the Service Request Contact recipient group
is based on the Service Request business object and the Opportunity Sales Team recipient group is
based on the Opportunity business object. Fields from any business component can be used as
substitution fields in any template.

Siebel Email Response looks at the Communications Outbound Email business component’s user
properties for a record that describes the relationship between the Communications Outbound Email
business component and the Target business component. The following record shows that the
Communications Outbound Email business component is related to the Account BO, using the
Account Id field.

Source Id Field: Account = Account Id

Other business components can be enabled for substitutions by associating the Target business
component with the Communications Outbound Email business component and then creating a new
User Property on the business component. See the following example:

Customers may wish to configure the Quotes business component. To add the Quotes business
component, they create the necessary links in tools and add the following User Property entry:

Source Id Field: Quotes = Quote Id

Quotes is the name of the business component and Quote Id is the name of the foreign key
between Communications Outbound Email and Quotes.

To use solutions and create templates, catalogs, and categories, perform the following tasks:
m Create solutions and email templates.

m Create a catalog and categories.

B Associate templates and solutions with categories.

To accomplish these tasks, use this chapter and Siebel Communications Server Administration Guide.

Using Solutions and Creating Email Templates

Solutions and Templates objects can be used as templates in Siebel Email Response. They can
provide answers to frequently asked questions. To help you determine when to use solutions, when
to use templates, and how each compares to a free-form reply, see “Solutions and Templates Decision
Table.”

Using Solutions

Solutions appear to customers over the Web through Siebel eService, and to employees through
products such as Siebel Call Center. They should be used for answers to questions that can be shared
across customer communications channels. For information about creating and storing solutions, see
Applications Administration Guide.
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You may discover that some questions received in email and service requests have been asked and
answered many times. Storing responses to frequently asked questions allows you to reuse the
answers without having to perform duplicate research. See Applications Administration Guide for
information about creating and storing solutions.

Siebel Email Response uses solutions as a type of template that does not have substitution fields.
Solutions should contain information and instructions for customers that are shared across
departments or channels. When you maintain information in one place, maintenance is kept to a
minimum and customers receive the most current information.

Solutions can be imported into the body of a Siebel Email Response reply when you associate them
with a category. An agent can use solutions when responding to telephone, email, and service
requests.

NOTE: If your solutions are going to be shared between Siebel Email Response and eService, and if
they contain URLs or other HTML tags, be sure to enable HTML formatting for Siebel Email Response.
HTML formatting is enabled in the User Preferences screen, Outbound Communications view. For
more information about enabling HTML formatting for Siebel Email Response, see Applications
Administration Guide.

Creating Email Templates

There are Simple templates and Advanced templates. Siebel Email Response only uses Simple
templates. Therefore, this guide provides information about creating a Simple template.Templates
can include template substitution fields that bring in data directly from your database. For
information about using substitution fields, see “Using Substitution Fields in Siebel Email Response
Templates.” For information about templates, see Siebel Communications Server Administration
Guide.

Templates are shared by many Siebel products, including the following:
m Siebel Email Response

m Siebel eMarketing

B Siebel Business Process Designer

®  Send Email

®  Send Fax

m  Send Page

m  Send Wireless Message

This section focuses on creating templates for use in Siebel Email Response.

Creating a Simple Template
Complete the following procedure to create a Simple template.
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To create a Simple template
1

2

From the application-level menu, choose Navigate > Site Map > Administration -
Communications > All Templates.

In the Templates list, click New.
NOTE: See Table 5 on page 55 for default values and descriptions of template fields.
In the Templates list, complete the Name, Channel Type, and Description fields.

Click the Advanced view tab and in the Templates form use the template information gathered
from “Performing a Business Analysis for Your Siebel Email Response Deployment” on page 27 to
complete the necessary fields.

Table 5 lists the default values and descriptions of template fields.

NOTE: Be sure to notify agents whenever a template has been added or modified and provide
instructions on how to use the new or revised template.

Table 5. Template Field Default Values and Descriptions

Field Name Default Value Description

Name Required. Name of the template. Choose a name that
clearly identifies the template’s purpose.

Channel Type Email Required. Communications channel that will use this
template. Always use Email for Siebel Email Response.
Other channel types are Fax, Wireless, and Page.

Subject Do not use for System-filled. In Siebel Email Response, if you put a
Siebel Email value in this field when creating the template, this value
Response. will be overwritten with the subject of the incoming email

in the reply. This field is used for Send Email and Send
Fax templates only.

Template Type Required. Possible values are Greeting, Body, and
Closing. Agents use these templates to tailor each area
of a reply to a customer.

Greeting or Closing. Used only for Siebel Email
Response. You may want formal and casual greeting and
closing templates. Other situations might call for a more
detailed greeting or closing. Greeting and closing
templates should be generic across the application and
should not be associated with a category.

Body. Used for Send Email, Fax, Wireless Message, and
Page templates. It is not needed for Siebel Email
Response templates unless you want to make the
templates available for Send Email, Fax, Wireless
Message, and Page.

Only templates intended to be used as body templates
should be associated to a category.
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Table 5. Template Field Default Values and Descriptions

Field Name Default Value Description
Recipient Required. Selecting a group determines the values that
Group appear in the Available Substitutions list.

The Recipient Group drop-down list contains all business
objects that have a primary business component. In
many cases, this will map to specific customer screens.
After choosing a recipient group, the available
substitutions for the selected group appear in the
Available Substitutions selection box.

In any greeting or closing templates that are set up as
defaults in the Outbound Communications view in the
User Preferences screen, only field substitutions from
the Action recipient group will appear correctly. For more
information about setting user preferences, see
Applications Administration Guide.

Public Optional. Not used by Siebel Email Response.
checkbox

Available Optional. Substitutions are variable fields that take the
Substitutions place of actual information that will vary from one email

to another. Values come from the business components
and are added using Siebel Tools. For example, the
available substitutions for the Action business
component appear when you choose the Activity Contact
recipient group.

Template Text Required. Template Text can be free-form text with or
without substitution fields. Type the text for the template
type you choose, copying and pasting available
substitution fields where you want the value to appear.

For example, when the casual greeting template is:
Dear [First Name],

The email reply shows:

Dear Bob,

Creating a Catalog and Categories

If you are implementing Siebel Smart Answer, use the catalog and category setup instructions in the
section about importing the knowledge base file in Siebel Smart Answer Administration Guide.

CAUTION: If you use the following procedure to create a catalog and categories before you
implement Smart Answer, make sure these catalog and category names match the catalog and
category names in the Smart Answer KB file.
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Setting Up a Catalog for Siebel Email Response
You must set up a catalog for Siebel Email Response so that agents can use templates and solutions
in replies to customers.

To create a catalog for the Email Response - Process Message workflow
1 From the application-level menu, choose Navigate > Site Map > Administration - Catalog.

2 In the Catalogs list, click New.
3 In the Name field, type the catalog name you want to use.
NOTE: Catalog names must be unique.

The new catalog appears in the Catalogs list.

After creating the catalog, you must next set up categories for Siebel Email Response.

Setting Up Categories for Siebel Email Response
To set up categories for Siebel Email Response, perform the following tasks in the order in which they
are presented:

m Create Categories in a Catalog
B Associating Templates with a Category

m  Associating a Solution with a Category

Create Categories in a Catalog
When setting up categories, the first task to perform is creating categories in a catalog.

To create a category in a catalog
1 From the application-level menu, choose Navigate > Site Map > Administration - Catalog.

2 In the Catalogs list, click the catalog name.
3 In the Categories list, click New.
See the table at the end of this procedure for descriptions of category fields.

4 In the Name field, type the name of a category you assigned to your templates and solutions
during the planning process.
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5

In the Display Name field, type the category name as you want it to appear to the agents.

Default

Field Name Value Description

Name Required. Name of the category. Choose a name
that clearly describes what templates will be
associated with the category.

Display Name Required.

Description Optional.

Effective Start Date/ The value of this field determines whether the

Effective End Date category will be used.

Associating Templates with a Category
The next task you must perform is associating a template with a category.

NOTE: A template can be associated with more than one category.

To associate a template with a category

1

A 01 A W N

From the application-level menu, choose Navigate > Site Map > Administration - Catalog >
Catalog Administration.

In the Catalogs list, drill down on the Name field.

Select the category with which you want to associate a template.

In the Categories form, click the drop-down arrow to find the Response Template view.
In the Response Templates list, click New.

In the Add Templates dialog box, use the scroll bar to find and select one or more templates you
want to associate with the category.

NOTE: Use the templates you matched with categories in “Performing a Business Analysis for Your
Siebel Email Response Deployment” on page 27.

Click OK.

The Response Templates list shows the templates you selected to associate with the selected
category.

NOTE: If you use Smart Answer, you can associate multiple templates with an auto-response
email. The Order field in the Response Templates view tab allows you to specify the sequence in
which templates appear in an auto-response email. After you select all the templates you wish
to associate with a category, type a number that represents the sequence in which the template
should appear.

Associating a Solution with a Category
The final task when setting up categories is associating a solution with a category.
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To associate a solution with a category

1 From the application-level menu, choose Navigate > Site Map > Administration - Catalog.

2 In the Catalogs list, select the catalog name and drill down on the Name field.

3 Select the category with which you want to associate a solution.

4 In the Categories form, click the drop-down arrow to find the Solutions view tab.

5 Click New.

6 In the Add Solutions dialog box, use the scroll bar to find and select one or more solutions you
want to associate with the category. For more information, see “Performing a Business Analysis
for Your Siebel Email Response Deployment” on page 27.

7 Click OK.

The Solutions list shows the solutions you selected to associate with the selected category.

NOTE: If you use Smart Answer, you can associate multiple solutions with an auto-response
email. The Sequence # field in the Solutions view tab allows you to specify the sequence in which
solutions appear in an auto-response email. After you select all the solutions you wish to
associate with a category, type a number that represents the sequence in which the solution
should appear.

Repeat the three procedures in this section for each category you created during the planning
process.

NOTE: To delete a record from the list of associated templates or solutions, select the record, and
click Delete.

Creating an HTML Wrapper Template

You can create a special template containing HTML features that serves as a wrapper around
outbound email messages, even when HTML is not directly supported by Siebel communications
features. A wrapper template can contain links to your Web site, marketing messages, and so on.
Agents do not have to change the way in which they reply to incoming messages through Siebel Email
Response. However, when an agent clicks Send, the email is embedded in your wrapper template
and sent to the message recipient.

To create a wrapper template for use with Siebel Email Response replies, perform the following tasks
in the order in which they are presented:

® Using an HTML Editor to Create a Wrapper Template
m Creating a Communications Template

B Modifying the eMail Response - Client Send Email Workflow in the Business Process Designer

Using an HTML Editor to Create a Wrapper Template

The first task you must perform is to use any HTML editor to create a wrapper template.
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To create an HTML wrapper template
®  Using any HTML editor, create an HTML template.

® Make sure that the template contains the substitution value [Email Body] where you want your
email body to appear.

Creating a Communications Template
The next task to perform is creating a communications template.

NOTE: For additional information on creating your communications template, see “Creating
Templates, Catalogs, and Categories” on page 51 and Siebel Communications Server Administration
Guide.

To create a communications template

1 From the applications-level choose Navigate > Site Map > Administration - Communication > All
Templates.

2 In the Templates list, select a template.
3 Click the Advanced view tab.

4 In the Templates form, click New and complete the following fields.

Template Type Recipient Group

Body Email Activity Receiver

5 Click the Template Items view tab.
6 In the Template Item form, check Substitute Values and Message Body.

7 Add the wrapper template and associated graphics files to template items in Administration -
Communications > All Template > Template items. For information about adding template items,
see Siebel Communications Server Administration Guide.

Modifying the eMail Response - Client Send Email Workflow in the
Business Process Designer

After creating the HTML wrapper template and your communications template, you must modify the
Email Response - Client Send Email workflow.

To modify the Client Send Email workflow
1 In the Siebel Tools Object Explorer, select the Workflow Processes object.

2 In the Workflow Processes list, perform a query for eMail Response - Client Send Email.

3 In the Workflow Processes list, select eMail Response - Client Send Email and click Revise.
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4 In the Workflow Processes list, right-click eMail Response - Client Send Email, and choose Edit
Workflow Process.

The Business Process Designer appears.
5 Right-click the Send Response business service and choose Show Input Arguments.

6 In the Input Arguments list, add the input arguments that appear in Table 6.

Table 6. Client Send Email Workflow Input Arguments

Input Argument Type Other Columns
Comm Template Literal Value: [Siebel template name that contains your HTML
Name List template (without the HTML file extension)]
Recipient Business Literal Value: Comm Outbound Email
Component
Source Business Literal Value: Comm Outbound Email
Object
Comm Profile Business Business Component Name: Comm Outbound Email
Override Compone . . .

nt Business Component Field: Email Sender Name
Source Id List Process Property Name: Object Id

Property .

Property Data Type: String

7 In the History Toolbar, click Back to return to Siebel Tools.
8 In the Workflow Processes list, select eMail Response - Client Send Email and choose Validate.

9 In the Workflow Processes list, select eMail Response - Client Send Email and click Deploy.

Managing Template Visibility
You can control visibility to templates in many ways, including the following:

® Associate a template with a business component. The template will be visible only when you are
in a view associated with that business component.

m Select the appropriate template type (Greeting, Body, and Closing). For example, when you
choose Greeting as the template type, only the template names for that type appear for
selection.

NOTE: Greeting and closing templates are used only in Siebel Email Response replies, not in
Send Email (F9) or Send Fax (CTRL + F9) communications. For more information about template
types, see “To create a Simple template.”

® By assigning default values in the Outbound Communications view of user preferences. For more
information, see “Filtering Templates by Assigning User Preferences Default Values.”
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® By using access groups to filter objects. For more information, see “Using Access Groups to Filter
Objects.”

m In Siebel Smart Answer, body templates must be associated with a category in the current KB
file or the template will not be visible to you.

Filtering Templates by Assigning User Preferences Default Values
You can filter templates by assigning user preferences in the following ways:

® Template format (plain text or HTML). Set your Default Message Format in the Outbound
Communications view of User Preferences. If you set your default message format to Plain Text,
HTML templates will not be visible to you. Therefore, each template should created once as an
HTML template and once as a plain text so that it will be available to all users.

® Language and locale. You can set your language and locale in the Outbound Communications
view of User Preferences. If you do not set this user preference, the language and locale used
during the installation of Siebel software will be the default. In a global deployment, some
templates need to be created in specific languages and locales. Because you can see only
templates that were created for your language and locale setting, each template you wish to use
for another language and locale, should be created in that language and locale.

Using Access Groups to Filter Objects

Access groups allow you to restrict visibility to various objects. By adding an access group to catalogs
and categories, you can filter these objects based on the user’s access group, division, or
organization. Using access groups, you can also filter catalogs and categories and their
corresponding response templates and solutions.

To assign an access group to a catalog
1 From the application-level menu, choose Navigate > Site Map > Administration - Catalog.

2 1In the Catalogs list, select and drill down on the Name field.
3 Click the Access Groups view tab and click New.
4

In the Add Access dialog box, select the groups that should have visibility to this catalog and
click OK.

NOTE: You can create new access groups in the Access Group screen.

5 Click the Private Flag field.

To assign an access group to a category
From the application-level menu, choose Navigate > Site Map > Administration - Catalog.

In the Catalogs list, drill down on the Name field.

Select an existing category or create a record and complete the fields.

A W N =

Click the Access Groups view tab, and then click New.
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5 1In the Access Group dialog box, select the groups that should have visibility to this category and
click OK.

NOTE: You can create new access groups in the Access Group screen.

Starting Siebel Email Response Server
Tasks

Depending on your business requirements for processing email, you need to start the following
server components:

m If you are processing email in real-time mode, you only need to start Communications Inbound
Receiver. For more information on real-time email processing, see “Processing Email in Real-Time”
on page 24. For information on how to enable real-time email processing, see “Enabling Real-Time
Email Processing.”

m If you are processing email in nonreal-time mode, you need to start both Communications
Inbound Receiver and Communications Inbound Processor. For more information on nonreal-time
email processing, see “Processing Email in Nonreal-Time” on page 25. For information on how to
enable nonreal-time email processing, see “Enabling Nonreal-Time Email Processing” on page 63.

Enabling Real-Time Email Processing

Complete the following procedure to enable real-time email processing.

To enable real-time email processing

1 From the application-level menu, choose Navigate > Site Map > Administration -
Communications > All Response Groups.

2 In the Response Groups list, select the response group for which you want to enable real-time
processing.

3 Click the Input Arguments tab.
4 Add the following input argument:
RealTime True

NOTE: This is the default value for this input argument.

Enabling Nonreal-Time Email Processing

The following procedure describes how to enable nonreal-time email processing.
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To enable nonreal-time email processing

1 From the application-level menu, choose Navigate > Site Map > Administration -
Communications > All Response Groups.

2 In the Response Groups list, select the response group for which you want to enable nonreal-
time processing.

3 Click the Input Arguments tab.
4 Add the following input argument:

RealTime False

One instance of the Communications Inbound Receiver and Communications Inbound Processor
server components has multiple subtasks that run at the same time as the server component. The
Communications Inbound Receiver and Communications Inbound Processor server component tasks
and subtasks must be running before Siebel Email Response can process incoming email. Therefore,
you must start all Communications Inbound Receiver and Communications Inbound Processor server
component tasks and subtasks. For general information about server components, see the Siebel
Server Installation Guide for your operating system. Before starting any component tasks, please
note the following:

m  If you try to start the same Communications Inbound Receiver or Communications Inbound
Processor component task twice, it will be rejected the second time. However, the first instance
will be running as usual. You can always increase the number of subtasks for each component
task if you have a high volume of incoming emails.

B One component task can have multiple subtasks associated with it and the subtasks route the
email. The component task acts like a controller to coordinate its subtasks.

NOTE: The preconfigured number of maximum threads is five. Also, be aware that Maximum Tasks
should always be greater than Max Threads.

Changing Siebel Email Response Setup After Implementation

If you make changes to the Siebel Email Response setup after you implement Siebel Email Response,
you must stop and restart the Communications Inbound Receiver and Communications Inbound
Processor server component for your changes to take effect. For some changes, you must stop and
restart the server components only if you want your changes to take effect immediately. For
example:

m  To have changes to a workflow process take effect, you can submit them without stopping the
server components. For information on submitting profile changes, see “Submitting Profile
Changes” on page 45. For information on submitting requests, see “Resubmitting a Request” on
page 125.
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Automatically Restarting Server Components

If Communications Inbound Receiver and Communications Inbound Processor crashes, a new
process will be started automatically for these server components if the AutoRestart component
parameter = TRUE. The new process looks through all the response groups defined in the database
and picks those records in which Startup = Active and Siebel Server = [current Siebel Server name]
(the Siebel Server field cannot be blank) and starts a Communications Inbound Receiver and
Communications Inbound Processor component task for each one of them. Complete the following
procedure to verify the Communications Inbound Receiver and Communications Inbound Processor
restart automatically.

To verify Communications Inbound Receiver and Communications Inbound
Processor auto-restart

1 From the application-level menu, choose Navigate > Site Map > Administration - Server
Management > Servers.

2 Click the Tasks view tab.

3 In the Tasks list, query for the components named Communications Inbound Receiver/
Communications Inbound Processor.

4 If the status field value is not Active, refresh the view by clicking another view tab and then
clicking the Server view tab.

When the value in the Status field changes to Active, auto-restart is complete.

For more information about starting server components, see the Siebel Server Installation Guide for
your operating system.

Automatically Restarting a Response Group
You can set up Siebel Email Response to have Communications Inbound Receiver automatically start
a response group. For more information, see “Automatically Starting a Response Group” on page 50.

Managing Subtask Failures at the Email Process Level
When a task fails, the following events occur:

B An email message is sent to the email address defined in the Administrator Email Address field
of the response group.

® The administrator should check the log files that are attached to the email and identify possible
causes of the server component task failure.

m Ifitis a workflow step error, it can be fixed in the workflow.
m Ifitis a profile error, the administrator verifies that the profile for the response group is valid.

B The administrator manually restarts the server component task.
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Starting the Communications Inbound Receiver

Every time you start an instance of Communications Inbound Receiver the application starts one
main task and five subtasks. The main task is assigned the first (lowest) task number (for example,
1318). The five subtasks are assigned the next numbers in sequence (for example, 1319, 1320,
1321, 1322, and 1323). The main task manages the subtasks and the message queue. The subtasks
process inbound messages by pulling the inbound messages from the queue and passing them to the
appropriate workflow.

Starting the Communications Inbound Processor
The Communications Inbound Processor has only one main task.

Scenario for Communications Inbound Receiver Events

This topic gives one example of how the Communications Inbound Receiver Events may be used. You
may use Communications Inbound Receiver Events differently, depending on your business model.

Events are stored in a subfolder under bin/queued. The subfolder name is based on the response
group name. The root directory, bin/queued, can be overridden using the Communications Inbound
Receiver server parameter EventQueueDirectory.

Processing Typical Communications Inbound Receiver Events
The following process describes a typical Communications Inbound Receiver event.

1 The driver generates an event for Communications Inbound Receiver.
2 The Communications Inbound Receiver creates an .evt file that stores the driver event.

3 The Communications Inbound Receiver renames the .evt file to .xevt immediately before
workflow execution.

4 The workflow executes without any errors and the .xevt file is deleted.

Managing Errors During Communications Inbound Receiver Email
Processing

The following process describes a processing error during Communications Inbound Receiver email
processing.

1 The driver generates an event for Communications Inbound Receiver.
2 The Communications Inbound Receiver creates an .evt file that stores the driver event.

3 The Communications Inbound Receiver renames the .evt file to .xevt immediately before
workflow execution.

4 Workflow returns an error which causes the event to be renamed from .xevt to .error.

5 An email is sent to the administrator and an error is logged (Error invoking method %1 on event
%?2. Event will be reprocessed within %3 sections.)
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6 Within five minutes, the event will be renamed from .error to .evt and requeued.

Managing Database Failures During Communications Inbound
Receiver Processing

The following process describes what happens when a database goes down during Communications
Inbound Receiver processing.

1 The driver generates an event for Communications Inbound Receiver.
2 The Communications Inbound Receiver creates an .evt file that stores the driver event.

3 The Communications Inbound Receiver renames the .evt file to .xevt immediately before
workflow execution.

4 Workflow returns an error and Communications Inbound Receiver determines the database is
down.

5 The Communications Inbound Receiver renames the .xevt file to .paused.

6 Within five minutes, the event will be renamed from .paused to .evt and requeued.

Managing Crash Errors During Communications Inbound Receiver
Processing

The following process describes what happens when a crash error occurs during Communications
Inbound Receiver processing.

1 The driver generates an event for Communications Inbound Receiver.
2 The Communications Inbound Receiver creates an .evt file that stores the driver event.

3 The Communications Inbound Receiver renames the .evt file to .xevt immediately before
workflow execution.

4 A crash occurs during email processing.

5 When Communications Inbound Receiver restarts, the .xevt file is found and renamed to
.retry.evt.

6 A warning message is logged (Event %s may have caused crash, requeing event for one retry.)

7 The event is requeued for processing.

Typical Processing of an event that previously caused a crash
The following process describes the typical processing of an event that previously caused a crash.

1 The Communications Inbound Receiver renames retry.evt to retry.xevt immediately before
workflow execution.

2 The workflow executes without error and retry.xevt is deleted.

Second Crash Error
The following process describes what happens the second time an event causes a crash.
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1 The Communications Inbound Receiver renames retry.evt to retry.xevt immediately before
workflow execution.

2 A crash occurs during workflow execution.

3 When Communications Inbound Receiver restarts, the retry.xevt file is found and renamed to
“.crash”.

4 An error message is logged and an email is sent to the administrator (Event %s may have caused
crash, change .crash extension to .evt to requeue on restart.)

NOTE: The event is not reprocessed because it is assumed to have caused the crash. To reprocess
the event, you need to change the .crash extension to .evt.

Stopping Communications Inbound Receiver and Communications
Inbound Processing

If necessary, you can shut down the Communications Inbound Receiver and Communication Inbound
Processor server components. For information on shutting down Siebel Server components, see
Siebel System Administration Guide.

Enabling a Secure Sockets Layer (SSL)
Connection for SMTP and POP3 Drivers

Complete the following procedure to enable an SSL connection for SMTP and POP3 drivers.

To enable an SSL connection for SMTP and POP3 drivers

1 From the application-level menu, choose Navigate > Site Map > Administration -
Communications > Communications Drivers and Profiles.

2 In the Communications Drivers list, select Internet SMTP/POP3 Server.

3 Click the Driver Parameters tab and complete the following fields:

Field Comments

Enable SSL for POP3 Enter a value of TRUE to enable SSL.
Enable SSL for SMTP Enter a value of TRUE to enable SSL.
POP3 Server Port Change POP3 port to 995.

NOTE: Port 110 is used for non-SSL connections.

SMTP Account Name Enter value for SMTP Account Name.

SMTP Account Password Enter value for SMTP Account Password.

SMTP Backup Account Name Specifies account name for backup SMTP interface requiring
user authentication.
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Field Comments

SMTP Backup Account Specifies account password for backup SMTP interface
Password requiring user authentication.
SMTP Server Port Port 25 is used for both SSL and non-SSL connections.

Authenticating a SMTP Server

This security method uses two new driver parameters:
m  SMTP Account Name
m  SMTP Account Password

If these two new parameters are specified, an attempt will be made to execute the AUTH LOGIN
command at the start of the SMTP session. If the AUTH LOGIN command fails, the session will be
terminated, a log file error message will be generated, and the message send will fail. The driver will
not consider this to be a permanent fatal error, so the OutboundCommMgr existing retry logic will
apply and another attempt will be made to send the message at a later date.
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This chapter covers how to set up Siebel Email Response workflows. It includes the following topics:
m  “Processing Email With Workflow Manager”

B "“Using Siebel Email Response Workflow Processes” on page 72

m “Determining Siebel Email Response Process Properties” on page 72

m  “Modifying Frequently Used Siebel Email Response Process Properties” on page 73

m  “Using Preconfigured Siebel Email Response Workflow Processes” on page 75

B  "“Using the eMail Response - Process Message Workflow” on page 76

B "“Using the eMail Response - Process Service Request Workflow” on page 94

m  “Invoking the eMail Response - Response Workflow” on page 103

m  “Invoking the eMail Response - Client Send Mail Workflow” on page 104

Processing Email With Workflow
Manager

This section contains information on how Siebel Email Response works with Workflow Manager to
process incoming email. It also describes two inbound email workflow processes included with Siebel
Email Response, eMail Response - Process Message and eMail Response - Process Service Request.
For information about how to use Siebel Business Process Designer, see Siebel Business Process
Designer Administration Guide.

Siebel Email Response processes each inbound email message using Siebel Business Process
Designer. Siebel Business Process Designer is also used for user interface operations. Understanding
Siebel Business Process Designer and the way Siebel Email Response uses it is critical to a successful
deployment. It is strongly recommended that you learn the basics of Siebel Business Process
Designer before implementing Siebel Email Response.

Siebel Email Response includes a few preconfigured workflows that route email messages to the right
agent at the right time. Preconfigured workflows must be activated before they can be used. For
instructions, see “Activating Workflow Processes” on page 38.

The following procedure describes how to see a list of the preconfigured Siebel Email Response
workflows.

To see a list of preconfigured Siebel Email Response workflows

1 From the application-level menu, choose Navigate > Site Map > Administration - Business
Process > Workflow Processes.
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2 In the Workflow Processes list, perform a query for eMail Response with a status of Completed.

You can use Siebel Business Process Designer with Siebel Assignment Manager, Siebel Universal
Queuing, or a third-party universal queuing application to further automate your email interactions.
No matter which routing method you use, it sets the Owned By field in the Activity record, so that
the agent can view the email on the agent’'s My Communications screen. You can find detailed
instructions for these applications in the following guides:

m  Siebel Business Process Designer Administration Guide
B Siebel Assignment Manager Administration Guide

m  Siebel Universal Queuing Administration Guide

Using Siebel Email Response Workflow
Processes

To use a workflow process, you specify the Workflow Process Manager business service and
RunProcess method in your response group and the workflow process name in the ProcessName
input argument of your response group.

The following terms appear frequently in the workflow processes used for Siebel Email Response:

® New message. A new email work item entering the Siebel Email Response workflow for the first
time. The message will not have a thread ID.

®  Follow-up message. An email work item that has a thread ID.

m Decision point. The place in a workflow process at which a work item branches to other steps
depending on a set of conditions. It includes possible branches for that point in the business
process. Each branch consists of one or more conditions that must be met for a work item to
follow that branch. There can be one or more decision points in a workflow process definition.

® Business service. An activity within a workflow process. Business services are logically linked
together to create a workflow process definition.

m Subprocess. A workflow process embedded in another workflow process as part of the workflow
process definition.

Determining Siebel Email Response
Process Properties

A process property is a place to store values that the workflow process retrieves from your database
or obtains during or after a processing step. Process properties can be added (as input arguments)
to a business service step in a workflow. When a business service process ends, the final value of a
process property is available as an output argument. There are two types of process properties:
configurable and nonconfigurable.
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m  Configurable process properties allow the administrator to control the behavior of email message
processing. They are changed frequently during setup. An example is Enable Test Mode?

Process Default

Property Name Value Description

Enable Test Mode? FALSE If the Enable Test Mode? process property is set to TRUE,
the eMail Response - Process Message workflow loads a
sample email message from a file, rather than a live email
server, allowing the administrator to test the workflow
using the Process Simulator. See Siebel Business Process
Designer Administration Guide for more information about
running the eMail Response - Process Message workflow in
the Process Simulator.

CAUTION: Use test mode only when you run the workflow process in Process Simulator mode.
It should never be used when you run the process during normal operations.

®  Nonconfigurable process properties are used primarily to store variables and are rarely modified
by application administrators. An example is the MsgBody process property.

Process Default

Property Name Value Description

MsgBody none The body of the inbound email message is stored in this
variable. There is no default value.

Modifying Frequently Used Siebel Email
Response Process Properties

You can modify process properties using the following ways:

Siebel Business Process Designer process properties. If you modify process properties in the
Process Properties tab, the changes apply to all instances of this workflow.

Communications Server response group input arguments. You can override process properties
using response group input arguments. This change applies only to messages processed using that
response group. For more information, see Chapter 4, "Completing Basic Setup Tasks.”
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In the eMail Response - Process Message workflow, process properties shown in Table 7 can be
changed during a typical Siebel Email Response deployment.

Table 7. Process Message - Frequently Used Process Properties

Name

AckTemplateName

Default Value

Email Response - Auto
Acknowledge

Description

The name of the template used for an Auto-
Acknowledgement message.

Catalog Name KB The name of the catalog that stores the
solutions and templates you use to respond
to inbound messages.

CommOutboundMgrName The name of the Siebel Server that
transmits the outbound message.

Commit Time Entitlement The workflow calculates the appropriate

ID commit time, based on an entitlement.

Enable Assignment FALSE If TRUE, Assignment Manager is enabled for

Manager email routing.

Enable Test Mode FALSE If TRUE, Test Mode is enabled and the
workflow can be used in the Process
Simulator. The XMLTestFileName parameter
must also be specified.

Enable Universal Queuing If TRUE, UQ is enabled for email routing.

Enable Lookup Sender By | FALSE If TRUE, contact lookup can be restricted to

Organization a specific organization.

Enable Smart Answer FALSE If TRUE, Smart Answer is enabled for Auto-
Response and Auto-Suggest capabilities.

XmlTestFileName The file path and file name of the XML file
used for Test Mode.

Disable Auto FALSE This is actually a response group input

Acknowledgement

argument. Change the value to TRUE to
disable the sending of auto
acknowledgement email.
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In the eMail Response - Process Service Request workflow, process properties shown in Table 8 can
be changed during a typical Siebel Email Response deployment.

Table 8. Process Service Request - Frequently Used Process Properties

Name

SRHelpAckName

Default Value
Email Response - SR Help

Description

The template used to respond when
the Help keyword is processed.

SRQueryAckName

Email Response - SR Query

The template used to respond when
the Query keyword is processed.

SRStatusAckName

Email Response - SR Status

The template used to respond when
the Status keyword is processed.

SRStatusErrorAckName

Email Response - SR Status
Error

The template used to respond when
the Status keyword is processed and
an error is detected.

SRSubmitAckName

Email Response - SR Submit

The template used to respond when
the Submit keyword is processed.

SRUpdateAckName

Email Response - SR Update

The template used to respond when
the Update keyword is processed.

SRUpdateErrorAckName

Email Response - SR Update
Error

The template used to respond when
the Update keyword is processed and
an error is detected.

Using Preconfigured Siebel Email
Response Workflow Processes

Siebel Systems provides the following two types of workflow processes with Siebel Email Response:

m Message processing workflows. Executed by the Communications Inbound Processor server
component as each inbound message is received. The following are the primary message

processing workflows:

= “Using the eMail Response - Process Message Workflow.” Use this workflow primarily for
unstructured email messages. Each inbound message is processed and ultimately an activity

record is created.

= “Using the eMail Response - Process Service Request Workflow.” Use this workflow for
structured or Web-form email messages. The subject of each inbound message is searched
for specific keywords such as update or status. The workflow uses this keyword to call the
appropriate subprocess.

m Userinterface workflows. Executed each time an agent clicks specified buttons in Siebel Email
Response. The following are the primary user interface workflows:

= “Invoking the eMail Response - Response Workflow.” Invoked by clicking the Reply, Reply to
All, and Forward buttons on the My, My Team’s, and All Communications screens.
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= “Invoking the eMail Response - Client Send Mail Workflow.” Invoked from the Send button in
Siebel Email Response.

Message processing and user interface workflows can call subprocesses to accomplish subtasks. You
can use Siebel Business Process Designer to customize preconfigured workflows or design new ones.

CAUTION: If you use scripts to customize Siebel Email Response workflows, do not attach any
scripts to the BusComp_WriteRecord event. This might result in the script being executed more than
once because a single process may write to a record multiple times. For more information on
scripting, see Siebel Tools Online Help.

This chapter provides an overview of each workflow process, describing the most frequently modified
processes or steps in these processes. For information about Siebel Email Response business
services, methods, and input arguments, see “Siebel Email Response and Business Services” on
page 131.

Using the eMail Response - Process
Message Workflow

Unstructured email messages should be processed using the eMail Response - Process Message
workflow.

The following are the primary features in this workflow process:
m "Setting Up a Workflow Process to be Test Mode Enabled (Workflow Decision Point)”
®  "“Finding Junk Email (Workflow Subprocess)”
m  “Parsing Message Workflow Steps”
® “Creating an Activity (Workflow Subprocess)”
= Contact Lookup
= Commit time calculation (entitlement verification)
®  “Enabling Smart Answer (Workflow Decision Point)”
m Identify Language
0 Analyze Message (message categorization)
0 Suggest a reply
0 Automatically respond with a reply
® "Sending an Acknowledgement (Workflow Subprocess)”

®  "Routing Email or a Message (Workflow Subprocess)”
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Figure 5. eMail Response - Process Message

To set up the eMail Response - Process Message workflow, use this chapter, Chapter 4, “Completing

Basic Setup Tasks,” and Siebel Business Process Designer Administration Guide.
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Setting Up a Workflow Process to be Test Mode Enabled
(Workflow Decision Point)

After modifying a workflow, test the changes to make sure they are working properly. To use the
Process Simulator, the administrator must set up the workflow process to run in Test Mode. To modify
and test changes to the workflow process, use the Process Simulator. See Figure 6 for an illustration
of this process.

Load From
Meszage

Load From
ML File

Figure 6. Enable Test Mode

In the production environment, Communications Inbound Processor executes the eMail Response -
Process Message workflow. In test mode, process properties for the workflow are loaded from an XML
file, not dynamically loaded by the Communications Inbound Processor server component. This
allows the administrator to modify each parameter individually.

To run the Process Simulator, the administrator must perform the following tasks:
®  Modify test XML files.

m  Set up the workflow process.

To modify test XML files (Example)

1 Copy the test XML files from the sample database subdirectory
(sample\applications\email_response).

NOTE: Test XML files are installed when you install the Sample Database.
2 Create a new directory on your Siebel Server. For example, c:\testmode.

NOTE: You do not need to use this exact location on your Siebel Server as long as you modify
the XML file to reference the new directory. If the directory in which you copied the test mode
files is not c:\testmode, you must modify the OrigMsgFile parameter in the XML file to match the
directory you created for the files.

3 Copy the test files from the sample database subdirectory to your newly created directory.
4 Open the testmode.xml file in the text editor you use for these files.

NOTE: Files with the XML extension might be mapped to open in your web browser. If so, you
should open the text editor and then open the file from the text editor.
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5 Use Table 9 on page 79 to m

6 Save and close the XML file.

odify the required parameters.

Table 9. Output Arguments and Descriptions

Output Argument

Example of a Value

orkflows = Using the eMail Response - Process

Message Workflow

Description

Cclist “replaceme@replaceme.com;test Optional. A semicolon-
@test.com;casey_cheng@siebel.c | delimited list of email
om” addresses in the CC field of
the message, enclosed in
double quotation marks.
HasAttach N Do not modify.
Loopback_spcCandidate | N Optional. Changes to Y if the
message is identified as a
loop-back candidate.
MsgClass IPM.Note Do not modify.
OrigMsgFile c:\testmode\OriginalMessageText | Optional. A file path pointing
_3B88245D00000001.txt to the original message file.
Prefix Do not modify.
Received 08/25/01 15:20:40 Optional. The time the email

server receives the message.

ReceiverAddress

replaceme@replaceme.com

Required. Email address of a
working Communications
Server Profile on your server.

ReceiverName

replaceme@replaceme.com

Required. Name of a working
Communications Server
Profile on your server.

SenderAddress casey_cheng@siebel.com Required. Email address of the
sender of the message.

SenderAddrType Optional. Type of sender
address.

SenderName Casey Cheng Required. The text name of

the message sender.

SenderReplyNames

The customer’s name

The text name to whom the
reply will be sent.

Sent

08/25/01 15:20:26

Optional. The time that the
message was sent.

SiebelChannelProfile

replaceme@replaceme.com

Required. Same as the
ReceiverAddress.

SiebelChannelType
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Table 9. Output Arguments and Descriptions

Output Argument

Example of a Value

Description

SiebelChannelTypeString | POP3SMTP Do not modify.
SiebelDriverEventName | MsgRead Do not modify.
SiebelDriverNotifyWhen | 0 Do not modify.

Done

SiebelWorkItemID

10-3SYAC##998778040:1

Do not modify.

Subject This is a test subject. Optional. Text in the subject
line of an email message.
TextNote Fundamentally, computers just Optional. The plain text
deal with numbers. version of the email message
body.
TextNoteCharset us-ascii Do not modify.
Tolist test2@test.com Required. Email address to

which the message was sent.

To set up the Enable Test Mode process

1
2
Message.
3
The Status field changes to In Progress.
4
Workflow Process.
The Business Designer appears.
5 In the WF Process Props list, select XmITestFileName.
6
file.
NOTE: You must include the complete directory path to this file.
7 In the History Toolbar, click Back to return to Siebel Tools.
8
Workflow Process.
Business Process Designer Administration Guide.
80 m

In Siebel Tools Object Explorer , select the Workflow Processes object.

In the Workflow Processes list, perform a query for Process Name = eMail Response Process

In the Workflow Processes list, select eMail Response Process Message and then click Revise.

In the Workflow Processes list, right-click eMail Response Process Message and choose Edit

In the Default String field, enter the complete directory path and the file name of the test XML

In the Workflow Processes list, right-click eMail Response Process Message and choose Simulate

The Process Simulator starts. For more information about the Process Simulator, see Siebel
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Finding Junk Email (Workflow Subprocess)

Workflows can be configured to screen out many junk email messages. A junk email message is any
message that you do not want to be routed to an agent for processing. Administrators can define
keywords in workflow decision steps that detect junk email messages. When identified as junk email
messages, the message is not stored in your database and workflow processing stops. Figure 7
illustrates this process.

_ Delete
FITEd rl%JaLiJInk Jurk? ’s Temporary
Files

End Jurk

Figure 7. Find Junk Email

Looking for Junk Email

When looking for junk email, Siebel Email Response examines three areas in an email message: the
sender field, subject field, and message body. If Siebel Email Response finds the keywords specified
by the Siebel Email Response administrator, it flags the message as junk mail. Figure 8 illustrates
this process.

Defaul Bad Sender? t Bad Subject? t Bad Body? t End

SetJunk
Tupe Email

Figure 8. Find Junk Email Subprocess

Examples of keywords and keyword phrases that might be used to detect junk email messages
include:

m Sender: postmaster@[your company’s name].com

m  Subject: out of office
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B Body: [specified objectionable language]

NOTE: Only an experienced administrator should add keywords to the junk message processing
workflow. Important messages might be lost unless each keyword is considered carefully.

Adding Keywords to Decision Points

Keywords can be added to decision points in the junk message processing workflow. The decision
point you modify depends on the field you want to examine. You also can create decision points to
examine other fields for keywords.

Decision points are the diamond-shaped steps in the Process Designer tab of the Administration -
Business Process screen. Each decision point contains a Next Steps list, a Conditions list, and a
Values list. For information about working with decision points, see Siebel Business Process Designer
Administration Guide.

The Next Steps list includes Branch Name and Next Step fields.
®m  The Branch Name can be N (conditions are not met) or Y (conditions are met).

m  The Next Step field specifies the workflow step where the message will be passed after branch
conditions are examined.

In the Next Steps list, a branch can have one or more conditions in the Conditions list and each
condition has a value in the Values list. For information about operators, expressions, and conditions,
see Using Siebel Tools.

m If conditions for Branch Name Y are met, the work item will be passed to the workflow step in
the Next Step field.

m If conditions for Branch Name N are not met, the work item will be passed to the Next Step field
on the Branch Name N record.

Use the following procedure to set up the junk message processing workflow to detect messages sent
from a particular email account.

To set up junk message processing
1 In Siebel Tools Object Explorer , select the Workflow Processes object.

2 In the Workflow Processes list, perform a query for Process Name = eMail Response - Parse Junk
Email.

3 In the Workflow Processes list, select the eMail Response - Parse Junk Email and then click
Revise.

The status of eMail Response - Parse Junk Email changes to In Progress.

NOTE: You do not have to change the workflow before you activate it. However, you must change
the status to In Progress.

4 In the Workflow Processes list, right-click eMail Response - Parse Junk Email and choose Edit
Workflow Process.

The Business Process Designer appears.
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Right-click each decision step you want to modify (such as Bad Sender?) and add the new value
to compare with Process Property.

For example, you can create a condition the following values:

Compare To Operation Property Name

Process Property = One Must Match (Ignore Case) MsgSenderAddress

In this example, the MsgSenderAddress Property Name is compared to Process Property. To
complete this condition, you need to type the address to which a message should be sent when
it is identified as a junk email in the MsgSenderAddress field.

For example, postmaster@[your company’s name].com.
In the History Toolbar, click Back to return to Siebel Tools.

In the Workflow Processes list, right-click eMail Response - Parse Junk eMail and choose
Validate...

NOTE: For more information on testing a workflow process, see “Setting Up a Workflow Process
to be Test Mode Enabled (Workflow Decision Point)” on page 78.

In the Workflow Processes list, click Deploy.

Parsing Message Workflow Steps

The following are two features used when Siebel Email Response processes email:

Threading. Maintaining an association with related messages that are sent between a customer
and an organization.

Parsing. Analyzing an email message to look for predefined, structured fields that are typically
used to process Web-form email messages.

The Parse Message step in the eMail Response - Process Message workflow provides both of these
capabilities.

By default, this step parses an email message for the text [THREAD ID:. When that text is found, the
workflow copies all the characters until it reaches the ] character. These characters are stored in the
Thread ID process property. The eMail Response - Process Message workflow uses the thread ID to
perform the following tasks:

On an agent’s Communications views, the thread ID allows all messages with the same thread
ID to appear in the History tab.

Messages that have a thread ID are handled as follow-up messages. Automatic responses are
never sent in response to follow-up messages.

NOTE: Misspelled words that appear after the [THREAD ID: tag do not get caught in the spell check.

The following are examples of message threading:

Customer sends a new incoming email message.
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From: customer@customer.com
To: support@siebel.com

Subject: Help

Please help.
- Customer
NOTE: There is no thread ID at the bottom of the response.

®  Company sends response to customer.

From: support@siebel.com
To: customer@customer.com

Subject: RE: Help

Attached is the answer to your question.

- Support

[THREAD ID:1234]

NOTE: A thread ID appears at the bottom of the response.
m  Customer replies to the response with a follow-up question.

From: customer@customer.com

To: support@siebel.com

Subject: RE: Help

I already tried that. Any other ideas?

- Customer

From: support@siebel.com

To: customer@customer.com

Subject: RE: Help

Attached is the answer to your question.

- Support
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[THREAD ID:1234]

NOTE: A thread ID appears at the bottom of the response.

In this example, each message is associated with the same thread ID (1234). The Parse Message
step identifies messages as part of the same thread by looking for the text [THREAD ID:1234]. Each
of these messages appear on the History tab on the Communications screen views.

Parsing for New Fields

In addition to the preconfigured capabilities of the Parse Message step, the step can be modified so
that additional fields can be identified in an email message. Once these fields are extracted from a
message, other steps in the workflow can be modified to use these values. One example would be
to parse an email message for a campaign code. In email marketing campaigns, a code is often
included in the bottom of the email message, so that marketing analysis can be performed. For a
description of the Parse Text method and its input arguments, see “ParseText” on page 135.

See the following example of an outgoing marketing message:
From: marketing@siebel.com
To: customer@customer.com

Subject: Important marketing message

Please visit our website www.siebel.com for more information on Siebel
EmaiTlResponse.

- Siebel Marketing
[CID:1234]
NOTE: A campaign ID appears at the bottom of the email.
See the following example of a response to the marketing message that might be sent by a customer:
From: customer@customer.com
To: marketing@siebel.com

Subject: RE: Important marketing message
Please have a sales representative contact me. Thanks.

- Customer

From: marketing@siebel.com

To: customer@customer.com
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Subject: Important marketing message

Please visit our Web site www.siebel.com for more information on Siebel Email
Response.

- Siebel Marketing
[CID:1234]

NOTE: The campaign ID still appears at the bottom of the customer’s inquiry.

Parsing Message Text for the Campaign ID

Using information in Siebel Business Process Designer Administration Guide and the following list of
tasks, you can modify the eMail Response - Process Message workflow to look for a CampaignID field
in the message body or subject.

To parse text for the campaign ID
1 In Siebel Tools Object Explorer, select the Workflow Processes object.

2 In the Workflow Processes list, perform a query for eMail Response - Process Message.
3 In the Workflow Processes list, select eMail Response - Process Message and then click Revise.

NOTE: Confirm that you have clicked Revise for the workflow record that you want to modify.
You can modify a record only if it has a status of In Progress.

4 In the Workflow Processes list, right-click eMail Response - Process Message and choose Edit
Workflow Process.

The Business Process Designer appears.
Right-click the Parse Message step and choose Show Process Properties.
In the Workflow Process Props list, add a new record with Name = CampaignID.

Right-click the Parse Message step and choose Show Input Arguments.

0 N & U

In the Input Arguments list, add the CampaignID input argument with the following values:

Input Argument Type Value

CampaignID Literal [CID:%s]

9 Right-click the Parse Message step and choose Show Output Arguments.
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10 In the Output Arguments list, add a CampaignID output argument with the following values:

Property Name Type Output Argument
CampaignID Output Argument CampaignID

NOTE: This output argument must match the input argument name you created in Step 8.
11 IN the History Toolbar, click Back to return to Siebel Tools.

12 In the Workflow Processes list, right-click eMail Response - Process Message and choose
Validate...

NOTE: You can also make sure the workflow works correctly by starting up the Communications
Inbound Processor and sending test messages. For more information on validating workflow
processes, see “Setting Up a Workflow Process to be Test Mode Enabled (Workflow Decision Point).

”

13 In the Workflow Processes list, click Deploy.

You have modified the eMail Response - Process Message workflow to parse for an additional field in
an email message. When the workflow receives a message with the specified field, the text will be
copied into the new process property (CampaignID).

Using this same approach, you could modify the eMail Response - Create Activity Process workflow
and associate the Activity record with the appropriate campaign.

Other potential uses of the Parse Message step include the following:

B Parsing an email message generated from a Web form. This step can look for first name, last
name, and telephone number and use this data to create a contact record.

®  The workflow can look for the text in the subject line instead of the message body. For example,
if the CampaignID field is in the subject of the email message, you can modify the eMail Response
- Process Message workflow to look for it.

Parsing Message Subjects for the Campaign ID

Using information in Siebel Business Process Designer Administration Guide and the following list of
tasks, you can modify the eMail Response - Process Message workflow to look for a Campaign ID
field in the subject line of email messages.

To parse message subject for the campaign ID
1 1In Siebel Tools Object Explorer , select the Workflow Processes object.

2 In the Workflow Processes list, perform a query for eMail Response - Process Message.
3 In the Workflow Processes list, select eMail Response - Process Message and click Revise.
The status of eMail Response - Process Message changes to In Progress.

NOTE: This example uses the version of the workflow that has a status of Completed.
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4 In the Workflow Processes list, right-click on eMail Response - Process Message and choose Edit
Workflow Process.

The Business Designer appears.
5 In the Workflow Process Props list, add a new record with Name = CampaignID.
6 Navigate to the Process Designer view and add a new business service step.

For information on adding business service steps, see Siebel Business Process Designer
Administration Guide.

7 Right-click the new business service step and complete the following fields:

Name Business Service Method

Parse Subject for Campaign Inbound Email Manager Parse Text

8 Right-click the Parse Subject for Campaign business service step and choose Show Input
Arguments.

9 In the Input Arguments list, add a Text input argument with the following values:

Input Argument Type Property Name Property Data Type
Text Process Property MsgSubject String

10 In the Input Arguments list, add a CampaignID input argument with the following values:

Property
Input Argument Type Value Name Property Data Type
CampaignID Literal [CID:%s] MsgSubject  String

11 Right-click the Parse Subject for Campaign business step and choose Show Output Arguments.

12 In the Output Argument list, add a new output argument with the following values:

Property Name Type Output Argument
CampaignID Output Argument CampaignID

NOTE: The value you create for the Output Argument must match the input argument you
created in Step 10.

13 Use the Connector tool to connect the new step (Parse Subject for Campaign) you created in
Step 7 to the eMail Response - Process Message workflow.

14 In the History Toolbar, click Back to return to Siebel Tools.

15 In the Workflow Processes list, right-click eMail Response - Process Message and choose
Validate...
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16 In the Workflow Processes list, select eMail Response - Process Message and click Deploy.

Creating an Activity (Workflow Subprocess)

The primary purpose of the eMail Response - Process Message workflow is to convert inbound email
messages into activity records. These activity records are reviewed by agents using the
Communications screen. The Create Activity step invokes a subprocess workflow, eMail Response -
Create Activity, and passes in a number of variables, which create the activity record and perform a
number of other steps. See Figure 9 for an illustration of this process.
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In addition to creating an activity record, the Create Activity subprocess performs the following

processes:

m  Follow-up messages. If the original message was associated with an SR, this process returns
the Service Request ID and Service Request Owner ID values so that follow-up messages will be

associated with the SR.

m Contact lookup. The workflow searches contacts in your database to find one with a matching
email address. If you set up multiple organizations, the contact lookup can be restricted to a
specific organization.

® Language identification. Performing a language detection routine on the message, identifying
the language of the inbound email message, which is later used to route the message to an agent
with the appropriate language skills.
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m  Commit time calculation (entitlement verification). The workflow calculates the
appropriate commit time, based on an entitlement.

m  Activity attachments. The workflow stores the original message and attachments as activity
attachments in your database.

For more information, see Chapter 4, “Completing Basic Setup Tasks.”

Enabling Smart Answer (Workflow Decision Point)

One of the key capabilities of Smart Answer is to automatically respond to inbound customer
inquiries without human intervention and to automatically suggest answers to an agent who is
manually responding to an email message. The eMail Response - Process Message workflow calls
several subprocesses that analyze the message and ultimately send an auto-response message back
to the customer. Figure 10 illustrates this process. For more details about these capabilities, see
Siebel Smart Answer Administration Guide.

Smart Answe
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Figure 10. Smart Answer Enabled?

The eMail Response - Process Message workflow first determines if Smart Answer is enabled and if
the administrator has enabled Smart Answer, then calls a subprocess, eMail Response - Analyze
Message. The Analyze Message subprocess performs the following tasks:

m Message categorization. Analyzes the body of the email message using a series of natural
language processing techniques to determine what the customer wants to know. The results of
these routines are used to associate the message with one or more categories of potential
solutions to the message. These categories are used in the eMail Response - Process Message
workflow to automatically respond to the message or automatically suggest answers to an agent
for approval.
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= Auto Respond? decision point (automatically respond to the email). An auto-response
message is sent when each of the following events occur:

0 The Analyze Message subprocess returns matching
categories that exceed the accuracy levels established by
the administrator.

0 The message is not a follow-up message.

0 The message is not a loopback candidate. Siebel Email
Response identifies a loopback candidate by determining
how many messages have been received from a particular
email address in a given period of time. For more
information, see information about driver parameters for
the Internet SMTP/POP3 Server communications driver in
Siebel Communications Server Administration Guide.

After an automatic response message is sent, an activity record is created for the auto-
response message and the inbound activity record status is set to Auto Responded.

= Automatically suggest a reply. If auto-response criteria are not met, an auto-
acknowledgement message is sent to the customer and the message and suggested answers
are routed to an agent for approval.

Sending an Acknowledgement (Workflow Subprocess)

When messages are received, organizations want to acknowledge the customer’s message and tell
the customer that they are working on the problem. Business Process Designer calls the Send
Acknowledgement Process when an auto-response message cannot be sent. Some reasons are:
Smart Answer is not enabled, an organization does not want to use auto-response, or the message
is a follow-up.

The Send Acknowledgement Process calls the Email Response - Send Acknowledgement step. This
step sends a customer an email notification stating that the customer’s message has been received.
After the acknowledgement message has been sent, the inbound message is routed to an agent for
further review. Figure 11 illustrates this process.
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Figure 11. Send Acknowledgement Subprocess Steps

Siebel Email Response Administration Guide Version 7.7 = 91



Setting Up Siebel Email Response Workflows
Message Workflow

Routing Email or a Message (Workflow Subprocess)

Email messages usually are routed to agents by setting the Owned By field in the Activity record,
allowing an agent to see the message in their Inbound Item List view. New email messages and
follow-up email messages are routed differently. Follow-up messages from a customer contain a
thread ID, new messages do not. The routing and queuing methods you use to identify the correct
agent are other Xfactors that determine how messages are routed. Figure 12 illustrates this process.
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Figure 12. Route Email (Route Message) subprocess
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New Message Routing. New messages do not have Thread IDs. Therefore, new messages are
identified by the absence of a thread ID in the message. When a new message is found, the

workflow checks to see which routing process is employed (Siebel Universal Queuing, Assignment
Manager, custom routing and queuing, or manual routing) on the following process properties:

Default
Process Property Value Description
Enable UQ FALSE When TRUE, UQ should be configured to route
email messages.
Enable Assignment Manager FALSE When TRUE, Assignment Manager should be

configured to route email messages.

NOTE: Only one routing process property should be assigned a value of TRUE or the workflow
might not work properly.

If both Enable UQ and Enable Assignment Manager process properties are set to FALSE, agents
have to manually route each message.

= Universal Queuing. If the Enable UQ Process Property is TRUE, Siebel Universal Queuing
routes the message to the appropriate agent or queue, based on the channel, routing, and
escalation criteria you define.

UQ routes new messages based on a prioritized list of the incoming email channels. For each
email channel defined, there might be one or many corresponding routing and escalation
rules that route the message based on a fully configurable range of criteria, including
message category, message language, and employee skill.

Assignment Manager. If the Enable Assignment Manager Process Property is TRUE, Siebel
Assignment Manager assigns messages to the appropriate agent. Using assignment rules and
criteria, Assignment Manager assigns specific activities to employees based on their skills,
competencies, and other email assignment attributes. Assignment Manager can assign
emails to employees dynamically, interactively, or by assigning a batch of emails to an agent.

= Manual routing. Each new message must be manually routed to an agent.

Follow-up message routing. A follow-up message is an incoming email message containing a
thread ID. By default, a follow-up message is routed to the agent who handled the original email
message. For example, if Casey Cheng was routed the initial email message, the follow-up
message will be routed to Casey Cheng if the thread ID is detected in the response from the
customer. However, if the agent escalated the email message to a Service Request (SR) and
assigned the SR to a different person, the message will be routed to the SR owner, not to the
original email owner.

= Universal Queuing. If the administrator has set the Enable UQ process property to TRUE,
follow-up messages can be routed using UQ, although in a different way from new messages.
For follow-up messages, we know to whom the message should be routed (the person who
handled the initial message or the SR owner) and UQ notifies the agent using the
communications toolbar. For new messages, UQ uses key skills to determine the agent who
should receive the email message, and then displays the message to that agent.

If the agent is not available then UQ can still find another agent who can handle the message.
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= Assignment Manager. If the initial agent is not available then Assignment Manager can
route the email to another agent capable of handling the message based on the defined
assignment criteria.

= Manual routing. Each follow-up message must be manually routed to an agent.

Using the eMail Response - Process
Service Request Workflow

Structured or Web-form messages, which must be submitted in plain text, can be processed using
the eMail Response - Process Service Request workflow. The eMail Response - Process Service
Request workflow attempts to identify a contact record that matches the sender’s email address and
processes the messages by identifying a keyword at the beginning of the subject line of the inbound
email message. The other words in the subject line are ignored. Figure 13 illustrates this process.
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Figure 13. eMail Response - Process Service Request

This section describes how to take advantage of the following features of this workflow process:
®  “Looking up Email By Organization (Workflow Decision Point).”

m “Getting a Subject Keyword (Workflow Step).”

m Service Request Workflow Subprocesses.

When a keyword is detected, eMail Response - Process Service Request workflow invokes one of
the following workflow subprocesses:
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= “Submitting a Subprocess (SR Submit Workflow).” Creates a service request record in your
database.

= “Querying a Subprocess (SR Query Workflow).” Finds service request records in your database.

= “Updating a Subprocess (SR Update Workflow).” Adds an update to a service request record in
the form of an Activity associated with the SR.

= “Determining the Status of a Subprocess (SR Status Workflow).” Requests the current status of
the service request record.

= “Invoking a Help Subprocess (SR Help Workflow).” Sends instructions for the supported
keywords.

To set up the eMail Response - Process Service Request workflow, use this chapter, Chapter 4,
“Completing Basic Setup Tasks,” and Siebel Business Process Designer Administration Guide.

Looking up Email By Organization (Workflow Decision
Point)

When an email message is received, the eMail Response - Process Service Request workflow
attempts to identify a contact record that matches the sender’s email address. This lookup capability

operates in two different ways, depending on the value in the Lookup Sender By Organization process
property.

By default, the workflow looks for a contact that matches the email address of the sender. If you
change the Lookup Sender By Organization process property to Y, the following events occur:

m  The workflow identifies the organization that is associated with the email profile (mailbox) in
which the message is received. For more information, see Chapter 4, "Completing Basic Setup
Tasks.”

m  The workflow looks for a contact that is a member of that organization.

Figure 14 illustrates this process.
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Figure 14. Lookup By Org?
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Getting a Subject Keyword (Workflow Step)

The Get Subject Keyword step takes the text of the subject line and returns the first word in the
subject line. The Subject Keyword = ? decision step uses this keyword to call the appropriate Process
Service Request subprocess. See Figure 15 for an illustration of this process.
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Figure 15. Get Subject Keyword

Submitting a Subprocess (SR Submit Workflow)

The eMail Response - Process Service Request workflow invokes the eMail Response - SR Submit
workflow when the eMail Response - Process Service Request workflow detects the Submit keyword
as the first word in the Subject line of an incoming email. See Figure 16 for an illustration of this
process. This workflow parses the body of the email message looking for a set of structured fields
which will be used to create the SR.
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Figure 16. Process Service Request Subprocesses

The preconfigured workflow is designed to work with the Abstract, Area, Description, and Severity
fields in the Mail Agent Service Request business component, but the workflow can be configured to
work with other fields in that business component.

NOTE: The Mail Agent Service Request business component and the Service Request business
component are based on the same table. Therefore, they share some fields.

For more information on extending the Mail Agent Service Request business component, see Using
Siebel Tools.
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Understanding the Submit Subprocess

After parsing the email message, the workflow looks for an entitlement record, using the Get
Entitlement ID subprocess, and calculates a commit time for the SR. For more information, see
“Creating an Activity (Workflow Subprocess).”

The workflow creates a new service record, adds attachments that were received with the incoming
email message to the SR, and notifies the sender that an SR has been created.

See the following example of an incoming Web-form Submit message:
From: customer@customer.com
To: webform-processor@siebel.com

Subject: Submit

[severity]

1 - Critical

[Area]
Usage

The eMail Response - Process Service Request workflow generates a service request, stores it in your
database, and sends a notification to the customer confirming that the message was received.

See the following example of a response that might be sent to a customer:
From: webform-processor@siebel.com
To: customer@customer.com

Subject:
Your email has been received.

Your reference number is 2-1CR. Please use the number for future reference.

Parsing for Fields in Incoming Email

The eMail Response - SR Submit workflow can be modified to process other keywords in the Service
Request business component by making a few modifications to the eMail Response - SR Submit
workflow.
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Identify the additional fields that you would like to parse from incoming email and locate them in the
Service Request business component. In the following example, you want to look for the Priority
field. Verify that the field is available in the Mail Agent Service Request business component. If the
field is not in the business component, see Using Siebel Tools for information about extending the
Mail Agent Service Request business component. For additional information, see Siebel Business
Process Designer Administration Guide.

To parse for other fields in email
1 In Siebel Tools Object Explorer , select the Workflow Processes object.

2 In the Workflow Processes list, perform a query for eMail Response - SR Submit.
3 In the Workflow Processes list, select eMail Response - SR Submit and click Revise.

NOTE: Make sure you click Revise before you attempt to modify a workflow process. You can
modify a record only if it has a status of In Progress.

4 In the Workflow Processes list, right-click on eMail Response - SR Submit and choose Edit
Workflow Process.

The Business Process Designer appears.
5 Right-click the Extract SR Fields step and choose Show Input Arguments.

6 In the Input Argument list, create a new input argument with the following values:

Input Argument Type VELTS
Priority Literal [Priority]%s[

7 Right-click the Extract SR Fields step and choose Show Output Arguments.

8 Create a new output argument with the following values:

Property Name Type Output Argument
Priority Output Argument Priority

9 Right-click the Create Service Request business service step and choose Show Input Arguments.

10 In the Input Arguments list add a new input argument with the following values:

Input Argument Type Property Name

Priority Process Property Priority

11 In the History Toolbar, click Back to return to Siebel Tools.
12 In the Workflow Processes list, right-click eMail Response - SR Submit and choose Validate...

13 In the Workflow Processes list, select eMail Response - SR Submit and click Deploy.
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Querying a Subprocess (SR Query Workflow)

The eMail Response - Process Service Request workflow invokes the eMail Response - SR Query
workflow when the eMail Response - Process Service Request workflow detects the Query keyword
as the first word in the Subject line of an incoming email. See Figure 16 for an illustration of this
process. This preconfigured workflow parses the body of the email message for a set of structured
fields that will be used to find a set of matching SRs.

See the following example of an incoming Web-form Query message:
From: customer@customer.com
To: webform-processor@siebel.com

Subject: Query

[Severity]

1 - Critical

[Area]
Usage
See the following example of a response that might be sent to a customer:
From: webform-processor@siebel.com
To: customer@customer.com

Subject: RE: Query

The following is a 1list of service requests that match your criteria. They are
displayed in comma-delimited format.

2-1CrR, 12:51 9/13/2001, oOpen, Assigned, Important issue

2-1cy, 12:51 9/15/2001, Closed, Closed, very important issue

Understanding how the SR Query Workflow Processes a Request

The workflow process sends an email message to the customer with a list of matching SRs. This
preconfigured workflow queries the Abstract, Area, Description, and Severity fields in the Mail Agent
Service Request business component. Administrators can extend the workflow to query other fields.
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The eMail Response - SR Query workflow can be modified to query using other fields in the Service
Request business component by making a few modifications to the eMail Response - SR Query and
eMail Response - Search Spec workflows.

NOTE: The Mail Agent Service Request business component and the Service Request business
component are based on the same table. Therefore, they share some fields.

Adding Query Fields to the Search Spec Workflow

If you want to query using the Priority field, you should modify the eMail Response - Search Spec
workflow. The following example describes the steps for modifying the eMail Response - Search Spec
workflow. For additional information, see Siebel Business Process Designer Administration Guide.

To add query fields to the Search Spec workflow
1 1In Siebel Tools Object Explorer, select the Workflow Processes object.

2 In the Workflow Processes list, perform a query for eMail Response - Search Spec.
3 In the Workflow Processes list, select eMail Response - Search Spec and click Revise.

NOTE: Make sure you click Revise before you attempt to modify a workflow process. You can
modify a record only if it has a status of In Progress.

4 In the Workflow Processes list, right-click eMail Response - Search Spec and choose Edit
Workflow Process.

The Business Process Designer appears.

5 1Inthe WF Process Props list, create a new process property called Priority in which to store the
new field.

6 Right-click the Extract SR Fields step and choose Show Input Arguments.

7 1In the Input Arguments list, create a new input argument with the following values:

Input Argument Type Value
Priority Literal [Priority]%s[

8 Right-click the Extract SR Fields step and choose Show Output Arguments.

9 In the Output Arguments list, create a new output argument with the following values:

Property Name Type Output Argument
Priority Output Argument Priority

10 Right-click the Get Search Criteria step and choose Show Input Arguments.
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11 In the Input Arguments list, create a new input argument with the following values:

Input Argument Type Property Name

Priority Process Property Priority

12 In the History Toolbar, click Back to return to Siebel Tools.
13 In the Workflow Processes list, right-click eMail Response - Search Spec and choose Validate...

14 In the Workflow Processes list, select eMail Response - Search Spec and click Deploy.

Updating a Subprocess (SR Update Workflow)

The eMail Response - Process Service Request workflow invokes the eMail Response - SR Update
workflow when the eMail Response - Process Service Request workflow detects the Update keyword
as the first word in the Subject line of an incoming email.

See the following example of an incoming Web-form Update message:
From: customer@customer.com
To: webform-processor@siebel.com

Subject: Update 2-1CR

Here is the update to my service request.

See the following example of a response that might be sent to a customer:
From: webform-processor@siebel.com
To: customer@customer.com

Subject: RE: Update

Your update has been submitted successfully.

This workflow parses the subject of the email message looking for an SR number. If workflow finds
an SR number, the workflow process creates an activity record containing the contents of the email
message and associates the record with the SR. If a customer sends an email to update the SR and
the email contains an attachment, the attachment will be associated with the SR record.

Siebel Email Response sends an email message notifying the customer that the update has been
received. If the workflow does not identify an SR, it sends an error message to the customer.
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Determining the Status of a Subprocess (SR Status
Workflow)

The eMail Response - Process Service Request workflow invokes the eMail Response - SR Status
workflow when the eMail Response - Process Service Request workflow detects the Status keyword
as the first word in the Subject line of an incoming email. See Figure 16 for an illustration of this
process.

See the following example of an incoming Web-form Status message:
From: customer@customer.com
To: webform-processor@siebel.com
Subject: Status 2-1CR

See the following example of a response that might be sent to a customer:
From: webform-processor@siebel.com
To: customer@customer.com

Subject: RE: Status
The current status for service request number 2-1CR is:

Status: Open

Sub-Status: Assigned

Area: Network

Severity: 1-Critical
Abstract: Important problem

This workflow parses the subject of the email message, looking for a service request humber. The
status of the SR identified in the subject line will then be sent to the customer in an email message.
If a service request is not identified then an error message is sent to the customer.

Invoking a Help Subprocess (SR Help Workflow)

The eMail Response - Process Service Request workflow invokes the eMail Response - SR Help
workflow when the eMail Response - Process Service Request workflow does not detect a matching
keyword as the first word in the Subject line of an incoming email. See Figure 16 for an illustration
of this process. If the system does not find a contact in your database with a matching email address,
the system sends an error notification to the sender, stating that a contact was not identified.
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Invoking the eMail Response - Response

Workflow

The eMail Response - Response Workflow is invoked by the Reply, Reply to All, and Forward buttons
on the Communications screen. This workflow process creates the outbound email message and
navigates the user to the view where agents can compose a response message. In addition to
creating the activity the workflow also is responsible for appending the original message to the

bottom of the email message.

Figure 17 illustrates this process.
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Figure 17. eMail Response - Response Workflow
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Invoking the eMail Response - Client
Send Mail Workflow

The eMail Response - Client Send Email workflow is invoked by the Send button on the Siebel Email
Response Reply view. This workflow is responsible for performing message validation steps, updating
the status of the inbound message to Done, and sending the email message. If you use the Smart
Answer or UQ product, the workflow is responsible for providing feedback to the Smart Answer
knowledge base, as well as releasing the UQ work item. Figure 18 illustrates this process.
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This chapter covers completing advanced setup tasks for Siebel Email Response. It includes the
following topic:

m  “Authenticating the Email Sender’s Email Address in Siebel Email Response”

NOTE: Many customers can deploy Siebel Email Response without advanced customizing. For
customers with more complex needs, this chapter contains information that can be used to customize
eMail Response - Process Service Request workflows. Before you use the advanced setup procedures
in this chapter, follow all instructions in Chapter 3, “Planning a Siebel Email Response Deployment” and
Chapter 4, “Completing Basic Setup Tasks.”

Authenticating the Email Sender’s Email
Address in Siebel Email Response

The eMail Response - Process Service Request workflow process authenticates inbound email sender
addresses during the Lookup Sender business service step.

Looku[u Error Looku[u Error

Get Lookup Get
Stat  ADefauw . EHtract 00KUP BY ™, gl (iganization |~ GenderBy W Subject  p—
Ewent Fields Org?
Id Org Fepword

E Lookup Error

Lookup
Sender

Send
Lookup Erar it
Email

Update Status Huery Subrit
1 1 De{pult

|Jpdate Sub Statuz Sub Query Sub Submit Sub Help Sub
Frocess Frocess Frocess Frocess Frocess

v

Delete
End Termparary it
Files

Figure 19. eMail Response - Process Service Request
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Understanding the Lookup Sender Business Service

The high-level logic of this step is to use the inbound email sender's email address to search the list
of contact records in the Siebel database for a matching email address. When the match is found,
the step returns the row ID of the contact and the row ID of the contact's primary account and
continues processing the request. These values are used in the following ways:

®  When the Submit and Update workflow subprocesses are run, the row ID values are used to set
values for the service request and activity records.

®  When the Status subprocess is run, the row ID values are used to find the service request record.

®  If no match is found, the workflow branches to an error condition and sends the inbound email
sender a notification that authentication failed.

The Lookup Sender Business Service step uses the Inbound Email Siebel Operation business service
FindRecord method to query a specific business object and business component within Siebel. The
step uses developer-defined input arguments to specify the business object, business component,
the field, the value to search the field with, and finally a field that is to provide the return value. The
output argument of the step maps a process property from the workflow process to the value field
returned by the query.

In the standard workflow process, the Lookup Sender Business Service step goes to the Mail Agent
Contact business component in the Mail Agent Activity business object. In the Mail Agent Contact
business component, it takes the value from the Email Address field and compares it to the
MsgSenderAddress process property. When a matching contact record is found, it returns the
Account ID field value and ID field value from that record. In some cases, users may need to modify
the authentication logic so that the processing is based on a different business component, a
different field, and so on. The following are two examples of how to accomplish this task.

CAUTION: Changes to one step in a workflow process may affect other steps later in the process.
Therefore, be careful when customizing any workflow and test all customized workflow processes
thoroughly before implementing them in a Production environment.

Authenticating a Sender's Email Address Using
Employee Email Address

In this scenario returning the Account Id value would not be useful. Therefore, the user might want
to change the Value Fields argument to Id. This would return the row Id of the employee who will
have access. You might decide to use the value in the workflow to set the Owner Id field of the service
request record.

Before changing any workflow, make sure you are familiar with procedures and guidelines in Siebel
Business Process Designer Administration Guide.

Performing the following tasks is one way to customize the workflow to authenticate the inbound
email sender’s address:

®  Changing the Lookup Sender Step to Capture Employee Email Address

B Changing Related Workflows and Subprocesses
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Changing the Lookup Sender Step to Capture Employee Email Address
If a business requires that employees be authenticated using email, you can modify the Lookup
Sender step input arguments by setting the Business Object field equal to Employee, the Business
Component field equal to Employee, and the Query field equal to EMail Addr (the field in the
Employee business component that stores the email address).

To change the Lookup Sender step to find the employee email address
1 In the Siebel Tools Object Explorer, select the Workflow Processes object.

2 In the Workflow Processes list, perform a query for Process Name = eMail Response - Process
Service Request.

3 In the Workflow Processes list, select eMail Response - Process Service Request and click Revise.

The status of the eMail Response - Process Service Request workflow process changes to In
Progress.

4 In the Workflow Processes list, right-click eMail Response - Process Service Request and choose
Edit Workflow Process.

The Business Process Designer appears.
5 Right-click the Lookup Sender step and choose Show Input Arguments.

6 In the Input Argument list, make the following changes:

Input Argument Type Value
Business Object Literal Employee
Business Component Literal Employee
Email Address Process Property Email Addr
Query Literal Email Addr
Value Literal Id

7 Right-click the Lookup Sender step and choose Show Output Arguments.
8 In the Output Arguments list, delete Account Id.

NOTE: To recapture the Account Id, see “Recapturing the Account Id” on page 110.
9 Right-click the Lookup Sender step and choose Show Process Properties.

10 In the WF Process Props list, create a new process property called Employee ID and change the
value in the Data Type field to String.

11 Right-click the Lookup Sender step and choose Show Output Arguments.

12 In the Output Arguments list, modify the Contact Id output argument by changing the Property
Name to Employee Id instead of Contact Id.

13 In the History Toolbar, click Back to return to Siebel Tools.
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14 In the Workflow Processes list, right-click eMail Response - Process Service Request and choose
Validate.

15 In the Workflow Processes list, right-click eMail Response - Process Service Request and click
Deploy.

Changing Related Workflows and Subprocesses

Having changed the Lookup Sender step, you must also change other steps in the eMail Response -
Process Service Request workflow and any of its subprocesses that use the Employee ID process
property value. In this scenario, you need to make sure that you set the appropriate fields in the
Service Request or Activity records so that they use the row ID of the employee record found by the
Lookup Sender step.

For the outbound acknowledgement email, the preconfigured workflow uses an email template that
assumes the contact ID is assigned to the service request record. In this example, we modified the
Lookup Sender step of the workflow to assign the employee ID. To prevent the acknowledgement
step in the eMail Response - SR Submit workflow process from failing, change the acknowledgement
to use a template that uses the Service Request Owner recipient group or assign the contact ID to
the Service Request record.

The following procedure provides an example of how to set up an employee ID in a subprocess
workflow.

To set up an employee ID in a subprocess workflow
1 Add a process property to eMail Response - SR Submit called Employee ID.

2 Add an input argument to the Submit Subprocess step of eMail Response - Process Service
Request; call it Employee ID and set it to the process property Employee ID.

3 Add an input argument to the Create Service Request step in eMail Response - SR Submit and
set the name to Field: Owned By ID and set the process property to Employee ID.

NOTE: In the preceding example, the employee who submitted the email becomes the owner of the
new service request record.

Authenticating a Sender’'s Address Using an Alternate
Email Address

Your business might want to store more than one email address per contact in the Siebel database.
One way to accomplish this is to use the Alternate Email Address field in the Contact business
component. This field has multiple values and the data is stored in the Address field of the
Communication Address business component.

The following scenario describes how to change standard workflow processes so that they will check
the Alternate Email Address field to authenticate the sender of inbound emails.
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Using Siebel Tools to Create a New Business Object

Because the Alternate Email Address field in the Contact business component is a multivalue field,
you can use Siebel Tools to determine the destination business component and the destination field
that stores the data. To find the destination business component, check the multivalue link that is

associated with the field. The destination field is defined as a field parameter. For this example, the
Alternate Email Address field in the Contact business component uses the data in the Address field
of the Communication Address business component. These values will be used to define the input

arguments in the Lookup Sender step.

Before you can use the Communication Address business component in the workflow, you must
define it as part of a business object in the repository. Because Communication Address is not defined
as part of a business object in preconfigured workflows, you need to create a new business object in
Siebel Tools. For more information about creating business objects, see Using Siebel Tools.

Open Siebel Tools and use the object explorer to select the Business Object object. Create a new
business object and call it Communication Address. Add two business object components to the
business object, Contact and Communication Address. Set the link parameter on the Communication
Address business object component to Contact/Communication Address. Navigate back to the
business object level and set the primary business component to Contact. Compile the changes into
the .srf used by the Siebel Server. Typically it is the siebel.srf file located in the [SIEBSRVR]\objects
directory on the Siebel Server machine.

Changing the Lookup Sender Step to Capture Alternate Email Address
After the SRF file has been recompiled and the Siebel Server restarted, perform the following steps
to change the Lookup Sender step.

To change the Lookup Sender step to find the alternate email address
1 In the Siebel Tools Object Explorer, select the Workflow Processes object.

2 In the Workflow Processes list, perform a query for Process Name = eMail Response - Process
Service Request.

3 In the Workflow Processes list, select eMail Response - Process Service Request and click Revise.

The status of the eMail Response - Process Service Request workflow process changes to In
Progress.

4 In the Workflow Processes list, right-click eMail Response - Process Service Request and choose
Edit Workflow Process.

The Business Designer appears.
5 Right-click the Lookup Sender step and choose Show Input Arguments.

6 In the Input Arguments list, make the following changes:

Input Argument Type Value
Business Object Literal Communication Address
Business Component Literal Communication Address
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8

Input Argument Type Value
Email Address Process Property Address
Query Literal Address
Value Literal Person Id

(the foreign key that stores the row Id of the contact)

Right-click the Lookup Sender step and choose Show Output Arguments.
In the Output Arguments list, make the following changes:
a Delete Account Id.
NOTE: To recapture the Account Id, see “Recapturing the Account Id” on page 110.
b Change the argument from Object Id to Person Id.

Recapturing the Account Id

NOTE: The following example is optional.

The scenarios in “"Authenticating the Email Sender’s Email Address in Siebel Email Response” contain a
step that deletes the Account Id output argument. When you delete the Account Id output argument,
eMail Response - Process Service Request no longer captures the account Id for the contact. You can
use the Contact Id process property to obtain the Account Id value using the following example. For
more details, see Siebel Business Process Designer Administration Guide.

1

2

Create a new business service step in the workflow process and call it Find Contact Account. Set
the business service to Inbound Email Siebel Operation and the method to FindRecord.

Connect the Lookup Sender to the Find Contact Account step instead of the Get Subject Keyword
step.

Connect the Find Contact Account step to the Get Subject Keyword step.

In the Find Contact Account step, create the following input arguments and assign the values
shown:

Input Argument Type Value
Business Object Literal Contact
Business Component Literal Contact
Query Fields Literal Id

Value Fields Literal Account Id
Object ID Process Property Contact Id

Create an output argument called Account Id and set its value to Account Id.
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This chapter covers setting up and configuring Siebel Email Response for multilingual, Unicode
database, or non-Unicode database deployments. It includes the following topics:

m “Using the Siebel Email Response Smart Character Set”

®  "Deploying Siebel Email Response Internationally” on page 112

®  “Planning a Siebel Email Response Global Deployment” on page 114

m "Setting Up Siebel Email Response for International Deployment” on page 115

NOTE: Siebel Email Response setup and configuration steps are the same for each deployment type.
For more information, see Global Deployment Guide.

Using the Siebel Email Response Smart
Character Set

Siebel Email Response uses the Smart Character Set feature to support global installations by
receiving, displaying, and replying to all emails with no character corruption. This feature works with
both double-byte and single-byte character sets (with and without HTML) and applies to the email
message body, MIME attachments, and the Subject line of an email. Smart Character Set saves the
incoming character set so that it can be used later when replying to the email sender. For example,
if a customer sends an email in Japanese (ISO-2022-JP character set), this information will be saved
and used when replying to the email.

By implementing Smart Character Set, all incoming messages from Microsoft Outlook and outgoing
messages sent to Web-based email clients (such as Yahoo! and Hotmail) will display properly. For a
list of supported email clients, see Siebel System Requirements and Supported Platforms on Siebel
SupportWeb.

While it is still possible to set the character set on a driver, if no character set is specified the Smart
Character Set feature will reply in the character set of the incoming email (for example, if no
character set is specified, emails received in UTF-8 will be replied to in UTF-8). When an email
activity is received, the character set is stored in the activity table and contact record so that it can
be used in F9 Send Email.

Automatically Enabling Smart Character Set
The following activities automatically respond using the same character set as the inbound email:

®  Auto Response

®  Auto Acknowledgement
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NOTE: A new field, MIME_CHAR_SET is defined in the S_EVT_MAIL table to store the incoming or
outgoing character set.

Manually Enabling Smart Character Set
When you manually enable the Siebel Email Response Smart Character Set, you define the character
set for all outbound email using the profile.

To enable Siebel Email Response Smart Character Set

1 From the application-level menu, choose Navigate > Site Map > Administration -
Communications > Communications Drivers and Profiles.

2 In the Communications Drivers list, select Internet SMTP/POP3 Server.
3 Click the Driver Parameters tab.
4 In the Charset parameter, enter a value.

For a list of supported character sets, see Siebel System Requirements and Supported Platforms
on Siebel SupportWeb.

Using Smart Character Set With F9 Send Email

NOTE: F9 Send Email is sent in UTF-8 unless a character set is specified when the profile is set.
For F9 Send Email, Smart Character Set checks for a character set in the following order:
1 The driver parameter is checked to determine the correct character set.

2 If no driver parameter exists, then the email is sent in UTF-8.

Using Smart Character Set With Siebel Email Response
For Siebel Email Response, Smart Character Set checks for a character set in the following order:

1 The message header of the inbound email is used to determine the correct character set.
For example, Content - Type:text/plain;charset= iso-8859-1.

2 If no customer record exists, the driver parameter is checked to determine the correct character
set.

3 If no driver parameter exists, then the email is sent in UTF-8.

Deploying Siebel Email Response
Internationally

In an international deployment of Siebel Email Response, you need to set up an email account
(profile) and response group for each language supported by your organization.
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For example, if your organization plans to support French and German, then you would set up two
profiles and response groups. You might name the French profile and response group
fra_support@siebel.com, and the German profile and response group deu_support@siebel.com.
Customers send messages to the address that processes their preferred language.

In a Unicode deployment, the database is Unicode and customers can send email messages in
different languages such as Japanese, Chinese, English, German, and so on. However, unless you
use Siebel Smart Answer and will process email messages only in the languages supported by Smart
Answer, you still need to set up a profile for each language.

Siebel Smart Answer can automatically detect several supported languages. For a list of supported
languages by Siebel Smart Answer, see the system requirements and supported platforms
documentation for your Siebel application. For more information about deploying Siebel Smart
Answer internationally, see Siebel Smart Answer Administration Guide.

In an international environment, Siebel Email Response performs the following tasks:
B Monitors response groups set up for each language that your organization supports.

m  Creates an activity record in the Siebel database that stores the content of the email along with
the language of the email message. The original email message is also stored as an attachment
to the record.

® Sends an acknowledgement message using the original language of the message. For example,
if a user sends a message in French, an acknowledgement message will be sent to the user in
French.

B Routes an inbound email message to the agent that can best handle the message. The routing
is based on assignment rules defined using Assignment Manager and Universal Queuing. For
example, a French message will be routed to an agent that has French as a language skill. See
Siebel Assignment Manager Administration Guide and Siebel Universal Queuing Administration
Guide.

B Suggests responses or automatically responds to the messages in the sender's native language
using Siebel Smart Answer.

See Siebel Smart Answer Administration Guide on Siebel Bookshelf and Banter Workbench User’s
Guide on Siebel eBusiness Third-Party Bookshelf.
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Allows an agent to compose and send messages using templates in a preferred language.

Agents review messages using a Siebel client and compose and send response messages using
response templates. The list of available templates consists of all templates in all languages.
Templates are filtered by the language and locale values that are set by the agent in the User
Preferences screen. If these user preference fields are not specified, filtering is based on the
language and locale of the object manager to which the agent is connected. For example, if the
agent's browser is connected to the French object manager, then the templates are filtered based
on French.

When Smart Answer is used, a list of suggested categories is displayed. Solutions and templates
are associated with the suggested categories. The agent selects a category in the category list
and then selects a solution or template associated with that category from the Body drop-down
list. The association of solutions and templates with a category is an administrative function that
you perform during Siebel Email Response setup.

NOTE: Templates and solutions should be translated into the supported languages that were
selected by your organization during the deployment planning stage of your Siebel Email
Response implementation.

Checks spelling for the most common international languages. For more information, see “Using
the Spell Check Feature.”

Planning a Siebel Email Response Global
Deployment

Before deploying Siebel Email Response in an international environment, analyze your organization’s
requirements.

Do any groups in your organization receive messages in languages other than English? If so, do
they have an email address set up to receive international messages? How are international
email messages handled currently?

What code page does your Siebel Server support? How many languages does your organization
plan to support?

If your organization plans to support three languages (French, German, and Italian), you need
to create one profile for each language. You also create one response group for each language,
adding the appropriate profile to the response group. Each response group will support one
language-specific profile. For example, to support French, the response group named
fra_support@siebel.com supports the profile named fra_support@siebel.com.

If you use Siebel Smart Answer, see the following requirements:

m  If you process email messages only in the languages supported by Smart Answer, you do not
need to set up a separate profile and response group for each language.

= However, if you want to process email messages that are not supported by Smart Answer,
you must set up a separate profile and response group to process email in each of those
languages.
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®  Which routing method will you use to route incoming email to agents? You can route activities
using Assignment Manager or Universal Queuing based on the language of the message.

NOTE: The language field is not displayed in the Activities list. To see the language of the
activity, you have to select the More Info tab, click the Show More button, and check the
Language field.

®  What communications templates have you decided to use in Siebel Email Response replies? If
your organization is planning to support multiple languages and decides to add new templates,
the template text will have to be translated to the languages that the customer plans to support.

See “Creating Templates For International Deployments.”

Setting Up Siebel Email Response for
International Deployment

Customers can deploy Siebel Email Response in a single environment using different languages if the
languages are in the same code page. Agents that use templates for daily replies to inbound
messages can filter templates based on the language and locale setting in user preferences.

Completing Prerequisite Setup Tasks for International Deployments
If your organization plans to support multiple languages, make sure to install the language packs for
each of the languages supported. The language pack will install the templates used in Siebel Email
Response in a specific language. For more information on language pack installation, see the Siebe/
Installation Guide for the operating system you are using.

If you plan to use Siebel Assignment Manager to assign activities based on language, you need to
enable the Assignment Management Group. For additional information, see Siebel Assignment
Manager Administration Guide.

For additional information about using Siebel Universal Queuing to assign activities based on
language, see Siebel Universal Queuing Administration Guide.

Installing Language Packs and Communications Templates

When you install Database Language packs, the communications templates (containing the correct
values for language and locale) associated with Siebel Email Response are installed. You can create
additional templates to meet your business requirements, following best practices guidelines. See
“Creating Templates For International Deployments.”

Setting Up Email Accounts for Supported Languages

You will need to set up an email account for each language that you plan to support.
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In your email server, create one response group per language. Each of these response groups will
be used to handle messages in different languages. If your installation supports French and German
messages, then set up two response groups (for example, fra_support@yourcompany.com and
deu_support@yourcompany.com). For French messages, users have to send their messages to
fra_support@yourcompany.com. For German messages, users will have to send their messages to
deu_support@yourcompany.com.

Configuring Response Groups For International Deployments

To be able to reply to email messages in more than one language, you need to create a response
group for each language and associate a profile with it. For example, if you plan to receive French
messages, create a Response Group named “FRA Response Group” and associate the profile
fra_support@yourcompany.com with the response group.

Each response group will monitor a particular language response group. You will need to create one
response group per language. For example, the Communication Inbound Receiver for French will
monitor the profiles associated with FRA Response Group.

For each response group, you need to pass the MsgDefaultLanguageCode input argument (contains
the default language of the email message) to the following workflows:

® eMail Response - Process Message
® eMail Response - Process Service Request

MsgDefaultLanguageCode is an argument in the workflow process. It specifies the language that the
workflow process uses to set the language of an activity record created. For example, when a user
sends an email to fra_support@yourcompany.com, an activity record is created and the language of
the activity is FRA. Based on the activity language, Assignment Manager and Universal Queuing can
assign the activity to the agent that handles French emails. For a list of input parameters to configure
response groups, see “Adding Input Arguments to a Response Group” on page 47.

For more information on how to create profiles and response groups, see “Setting Up Communications
Server for Siebel Email Response” and Siebel Communications Server Administration Guide.

Creating Templates For International Deployments

When creating templates in international deployments, follow the convention of naming the
templates in English and include the language and locale. This will help maintain consistency. It is
the naming convention used by Siebel Systems for translating the standard templates used by Siebel
Email Response into the languages Siebel Systems supports. It is recommended that you follow the
same naming convention.

Additionally, if you create templates, additional logic must be added to the workflow so that they can
be invoked from the workflow process and so that Workflow will be able to detect the language of
the template.

For instruction on how to create templates, see “Creating Templates, Catalogs, and Categories” and
Siebel Communications Server Administration Guide.
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Providing Language Support For International Deployments
The following should be considered in a Siebel Email Response international deployment:

Email addresses containing non-ASCII characters are displayed and processed correctly by Siebel
Email Response. However, when an outbound email contains non-ASCII characters in the email
address, the non-ASCII characters are changed to Xs before the email is sent to the recipient.

NOTE: Generic Internet email addresses should not contain non-ASCII characters.

One response group can handle only one language. If you support multiple languages, you need
to set up a response group for each language.

Siebel Email Response does not perform language detection. To detect languages, you must
license Siebel Smart Answer. If you do not license Siebel Smart Answer, if an email message is
sent to the wrong response group, the language of the activity record will be the default language
that is specified in the input argument of the response group. For additional information about
supported languages, see Siebel System Requirements and Supported Platforms on Siebel
SupportWeb.

Messages that are in languages that do not fall in the Windows code page 1252 or code page
8859-1 appear as undisplayable characters.

When you work with a monolingual or multilingual deployment or a non-Unicode database
deployment, you might receive messages in languages that are not supported by the
environment.

Because the Subject and Body cannot be converted, they appear as undisplayable characters.
These emails are not processed by Siebel Email Response, no activities are created, and the
email is sent as an attachment in email format to the administrator for review (if you set up the
administrator email profile).

Communications Inbound Receiver and Communications Inbound Processor allow the use of most
widely-used character sets including 1252 / Latin-1, Shift-JIS, ISO-2022-JP (mail JIS), EUC-JP,
and UTF-8.

When Siebel Email Response replies to email messages, the prefix strings are in English and are
not translated to the various languages supported.

For more information about supported languages, see Siebel System Requirements and
Supported Platforms on Siebel SupportWeb.
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This chapter covers how to diagnose and resolve many Siebel Email Response problems. It includes
the following topics:

®  “Troubleshooting Siebel Email Response”

m  “Using the Communications Inbound Events View"” on page 124
B “Synchronizing Batch Components” on page 125
m  “Using the Component Statistics and State Value Views” on page 125

Troubleshooting Siebel Email Response

To resolve the problem, look for it in the list of Symptoms/Error messages in Table 10

Table 10. Resolving Siebel Email Response Problems

Symptom/Error

Message Diagnostic Steps/Cause Solution

When I activate Siebel | Verify the status of the If the status of the workflow is not Active,
Email Response workflow process that you see “Activating Workflow Processes” on
workflows in the are trying to activate. page 38.

Administration -
Business Process
screen, the following
error appears:

Make sure the workflow
process has the correct
status. You cannot activate a
workflow process unless it
Cannot activate has a status of In Progress.
workflow process
'<ProcessName>"'
version
[<versionNumber>]
. Make sure it has
'In Progress'

status.
The Communications Use the Communications Inbound Events
Inbound Receiver and view to begin diaghosing nonreal-time
Communications processing errors. For more information,
Inbound Processor see “Resolving Nonreal-Time Processing
server tasks stop and Problems” on page 124.

nonreal-time email
processing stops.
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Table 10. Resolving Siebel Email Response Problems

Symptom/Error
Message

Reprocessing emails in
siebsrvr/bin/queued is
not working
automatically.

Diagnostic Steps/Cause

An email failed after not
being processed correctly.

Solution

Resubmit the failed email. For
information on how to perform this task,
see “Resubmitting a Request” on

page 125.

Unable to find definition
for CommOutboundMgr
component.

The Communications
Outbound Manager server
component is not
synchronized correctly.

To resolve this error, synchronize the
batch components on the Siebel Server.
For more information, see “Synchronizing
Batch Components” on page 125.

Communications
Inbound Receiver error.

Use the Component Statistics and State
Value view tabs to trace the last
encountered error in Communications
Inbound Receiver. For more information,
see “Using the Component Statistics and
State Value Views” on page 125.

I set up and started my
response group.
However, I do not see a
reply to my inbound
email.

Possible causes for this
problem could be:

m  The POP3 parameters
could be wrong.

B  The Communication
Outbound Manager may
not be operating.

B  The Communication
Outbound Manager is
running and operating
but I still do not see any
reply email.

®  The Communications
Inbound Processor may
not be running.

For a list of possible solutions to this
problem, see “Resolving Response Group
Issues” on page 127.

I believe I set up
everything correctly for
Fax but I am not able to
see the incoming fax
when I use F9 Fax.

120 =

The fax server or fax
machine could be incorrectly
set up.

Two possible solutions to this problem
are:

®  Try dialing the fax humber to see
whether it actually reaches the fax
machine.

®  Send an email using a working email
client with the exact syntax from
Siebel Send Fax. Then, check to see
if you receive the fax.
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Symptom/Error
Message

I created an outbound
email or fax request but
I did not receive the
email or fax.

Siebel Email Response Administration Guide Version 7.7

Diagnostic Steps/Cause

Communications
Outbound Manager may
not be running.

Communications
Outbound Manager is
running but there is
error in sending emails.

Communications
Outbound Manager is
running but the email is
sent to the wrong
recipient.

bleshooting Siebel Email Response

Solution

The following list contains possible
solutions to this problem.

® Check the outbound request to see if
it has a Status = Success.

m If the Statusis not Success, check for
errors in either the Request view or
the log file.

m If the log file indicates an error but
did not provide enough information
about the error, increase the event
log level for Communications
Outbound Manager.

121



Troubleshooting Siebel Email Response

Table 10. Resolving Siebel Email Response Problems

Symptom/Error
Message

I perform an F9 Send
Mail from Microsoft
Outlook on a contact.
After I send the email,
the activity still has a
Status = Queued.

Diagnostic Steps/Cause

An activity has been created
(otherwise you would not

see the email). The question
is whether the right contact

is associated with the email.

Solution

A possible way to diagnose and solve this
problem is:

When you press F9 Send Mail and go into
Microsoft Outlook before sending the
email, you create an activity. You could
go back to the contact where you pressed
F9 Send Mail and drill down on the
contact name and then click the Activity
view tab. You should see a new activity.
The status of the activity should be
Queued. Once you send the email , the
status of the activity should change to
Done. If the activity status remains
Queued and you do not see an error after
clicking the Send button, you should
close all Internet browsers and clean all
downloaded objects.

NOTE: To delete all objects from Internet
Explorer, go to Tools > Internet Options >
Setting > View Objects.

Sometimes, you may need to go to
C:\WINNT\Downloaded Program Files
and physically remove all objects from
there. After doing this, restart the
application.
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Symptom/Error
Message

I perform an F9 Send
Mail on a contact from
Microsoft Outlook. After
I send the email, I do
not see an activity
being associated with
the email.

Diagnostic Steps/Cause

The correct statement
should be that previously
created activity records were
removed.

m Troubleshooting Siebel Email Response

Solution

Two possible solutions to this problem

are:

An activity record will be created
once you press F9 Send Mail and go
into Microsoft Outlook. After finishing
your email and possibly add or
removing a contact, you click the
Send button to send the email. Once
you send the email, there is a script
in the form that notifies the Siebel
Server to update all email
information including the contact list,
the email subject and the email
content. In a preconfigured
application, the script will first
remove all existing contacts from the
activity and then add any new
contacts based on the new contact
list from Microsoft Outlook. The
contact information from Microsoft
Outlook could be in the following
format:

= Firstname LastName

= Firsthname
LastName<email@email.com>

= someemail@someemail.com

On the server side, the server code
will use (1) Firstname, Lastname,
emailaddress as search criteria
against the contact table. If there is a
match (either single or multiple), the
server code will also associate the
first found contact it finds with the
activity. Therefore, if you think there
is no association to the contact of
your choice, check your database to
see if you have multiple entries of the
same first name, last nhame or email
address.
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Using the Communications Inbound
Events View

You can use the Communications Inbound Events view to perform the following troubleshooting
activities:

m  Resolving Nonreal-Time Processing Problems

m Resubmitting a Request

Resolving Nonreal-Time Processing Problems

The following procedure describes how to resolve some of the common nonreal-time email
processing problems.

To resolve nonreal-time processing problems

1 From the application-level menu, choose Navigate > Site Map > Administration -
Communications Inbound Events.

2 In the Communications Inbound Events list, examine the fields to help determine the source of
the problem as described in Table 11.

Table 11. Communications Inbound Events Fields

Field Value Possible Cause
SRM Request | Id m  If null, could be a problem in the
Id Communications Inbound Receiver.

m  If not null, could be a problem in the
Communications Inbound Processor.

Status B  Queued A value of Queued or CIP Processing means there
is no problem with the email processing. A value

= CIP Processing of Error or CIP Fatal means the email was not

m  Error processed.
m CIP Fatal
Processing/ Siebel Server Name If the Siebel Server Name is in the Receiving
Receiving Siebel Server field, then the Communications
Siebel Server Inbound Processor has received the event.
Activity ID Id If the Activity Id is not null, the error may be in
one of the steps in the workflow after creating the
activity.
Comments Description Use the DriverTrackID to find the location of the

error in the log files.
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Resubmitting a Request

You can resubmit a failed email by completing the following procedure.

To resubmit a failed email

1 From the application-level menu, choose Navigate > Site Map > Administration -
Communications > Communications Inbound Events.

2 From the Communications Inbound Events menu drop-down list, choose Submit Request.

Synchronizing Batch Components

The following procedure describes how to synchronize Siebel Server batch components.

To synchronize the Siebel Server batch components

1 From the application-level menu, choose Navigate > Site Map > Administration - Server
Configuration > Enterprises.

2 In the Enterprise Servers list, select the Siebel Server for which you want to synchronize batch
components.

3 Click the Synchronize view tab.
4 Select the batch components you want to synchronize and then click Synchronize.

NOTE: You do not need to stop and restart the Siebel Server process.

Using the Component Statistics and
State Value Views

You can use the Component Statistics and State Value views to perform the following activities:

®  Diagnosing Communications Inbound Receiver Errors

B Tracing the Last Encountered Error in Communications Inbound Receiver

Diagnosing Communications Inbound Receiver Errors
The following procedure describes how to diagnose Communication Inbound Receiver Errors using
the Component Statistics and State Value views.

To use the Component Statistics and State Value Views to diagnose Communications
Inbound Receiver errors

1 From the application-level menu, choose Navigate > Site Map > Administration - Server
Management > Components.

Siebel Email Response Administration Guide Version 7.7 m 125



Troubleshooting Siebel Email Response = Investigating a
Behavior During Processing

2 In the Components list, perform a query for Communications Inbound Receiver.
3 Click the State Values tab.

All currently loaded Response Groups appear.
4 Click the Statistics view tab.

The number of response groups, profiles loaded, real time events processed, and processing
times appear.

Tracing the Last Encountered Error in Communications Inbound
Receiver

The following procedure describes how to trace the last error encountered in the Communications
Inbound Receiver.

1 From the application-level menu, choose Navigate > Site Map > Administration - Server
Management > Tasks.

2 In the Tasks list, perform a query for Communications Inbound Receiver.
Click the State Values view tab.

4 In the State Value list, select Last Real Time Error and check the Description field for information
on the last encountered error in the Communications Inbound Receiver.

Investigating and Reporting Abnormal
Behavior During Processing

Communications Inbound Receiver and Communications Inbound Processor will not stop if an
incoming work item (such as an email or a phone call) causes abnormal behavior during processing.
Instead, a log file entry will be created for the abnormal behavior. An example of abnormal behavior
could be a missing From address in an email or a stopped UQ engine. The log files for
Communications Inbound Receiver and Communications Inbound Processor are:

m  Communications Inbound Receiver: Comminboundrcvr log file

m  Communications Inbound Processor: Comminboundprocessor_xxxxx.log

Investigating Abnormal Behavior During Processing

To investigate any abnormal behavior during processing, go to the Components view in the
Administration - Communication > Communication Inbound Events screen and make sure there are
entries for each email that is being processed. After an email has been successfully processed the
entry will be deleted. If the email was not successfully processed, make sure that the status and
comments are correct. You should also check the URL to make sure you have the right name. If you
want to resubmit a failed email for processing, see "Resubmitting a Request” on page 125.
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Reporting Abnormal Behavior During Processing

Before reporting any abnormal behavior during processing, make sure comminboundrcvr and
comminboundprocessor are set to the proper debugging level and MIME message. You need to attach
both of these files to the abnormal behavior when reporting the problem.

Resolving Response Group Issues

The following list describes possible solutions to the problem of not seeing a reply to an inbound
email after setting up and starting a response group.

m Check the <server>/bin directory to see whether there is any POP3SMTP*.log.

B Check the log file with the closest timestamp to the time the error occurred and see whether
there is an obvious error on the POP3 side.

= Set up an POP3 email account in Microsoft Outlook using the same profile information and
perform a test to see if you are using good information.

m  Check if the server can actually see your email server. Test which users on the mailing list
are current by sending an email to the mailing list asking for a response.

= Use an IP address instead of a hostname.

m  Perform an F9 Send Mail from a contact and see if you could see the outbound email. If you see
a complaint about the Communication Outbound Manager not being defined, perform a Batch
Component Synchronization. For information on performing this procedure, see “Synchronizing
Batch Components” on page 125.

®  From the application-level menu, choose Navigate > Site Map > Server Job > My Job to see if a
Communications Outbound Manager request has been created. Examine the record to determine
the status of the request. If Status = Queued, then the request has been created and is waiting
for Communications Outbound Manager to pick it up. If Status = Active, then the
Communications Outbound Manager is executing it. If the Status = Error, then you need to
determine what type of error occurred.

m If you are using nonreal-time email processing, the processing of emails is done by the
Communications Inbound Processor. Navigate to the Administration - Communication >
Communication Inbound view and check the status of the email. Each inbound email processed
in nonreal-time mode will have an entry if the processing has either not started or has resulted
in an error.

m Choose Navigate > Site Map > Server Job > My Job and check if there is a Communications
Outbound Manager server job that resulted in an error.

m If everything seems to correct, you need to determine if the email is actually reaching the email
server. To do this, login to the POP3 email server and check the following:

= telnet <emailserver> pop3

= +O0K Microsoft Exchange 2000 POP3 server version 6.0.4417.0
(smtdI380exchl.esexchl.siebel.com) ready.

= user gatest99

NOTE: You will not see what you type.
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+0K

pass resource

+0K User successfully logged on.
stat

+0K 00

NOTE: This indicates no pending emails. The first 0 is the number of messages. The second
0 is total size of all messages.

quit

B If there are emails in your POP3 email server but your Siebel application email POP3 driver is not
picking them up, set the POP3 driver to LogDebug=True and resubmit the profile changes. After
this parameter, a log file named pop3smptXXXXX.log will be generated. Check the log file to see
if there are any errors.
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This appendix includes tables referenced by multiple chapters, details about how email is processed
through drivers, and an overview of the information you need when you upgrade from Release 6.x
to Release 7.7 of Siebel Email Response. It includes the following topics:

m  “Solutions and Templates Decision Table”

®  “Routing and Queuing Methods Comparison Table” on page 130

m  “Siebel Email Response and Business Services” on page 131

m  “How the Internet SMTP/POP3 Driver Processes Email Messages” on page 140

B “Processing Internally Generated Attachments in Siebel Email Response” on page 147

m  “Upgrading to Siebel Email Response Release 7.7” on page 149

Solutions and Templates Decision Table

Table 12 will help you determine when to use solution documents (called FAQs in Siebel eService),
when to use reply templates, and how each compares to a free-form reply.

Table 12. Solutions and Templates Decision Table

Free-Form Reply Template Solution

Personalized. Less personal than free-form. Less personal than free-form.

Time-consuming. Faster than free-form. Faster than free-form.

More error-prone. Content can be verified and Content can be verified and
preapproved by legal and other preapproved by legal and other
departments before using. departments before using.

Does not use Can select identified fields from an Does not use substitution fields.

substitution fields. incoming email and insert them in

predefined places in your template.

Can include multilevel substitution
fields using the Advanced Template
form, such as links to service requests,
orders, and opportunities.
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Table 12. Solutions and Templates Decision Table

Free-Form Reply Template Solution

A one-time effort that | Can be sent to any customer by The same solutions files can be
cannot be shared with | selecting the template within Siebel shared across channels.

other customers Email Response. Updates only need to be done
unless you recreate once and then all users have
the email. access to the most current

information. An agent can insert
the contents of a solutions file
into the body of an email
message (Siebel Email
Response), use it to reply to a
customer’s request received
during a telephone call (Siebel
Call Center), and publish it on a
service Web site (Siebel

eService).
Can attach files. Can attach a file to an email that Can attach afile to an email that
contains a template. However, Siebel contains a solution. However,
Email Response does not support Siebel Email Response does not
adding attachments to templates. support automatically adding

attachments from solutions.

Routing and Queuing Methods
Comparison Table

Table 13 lists the advantages and disadvantages of each routing and queuing method.

Table 13. Routing and Queuing Methods Comparison

Routing Method or
Product Advantages Disadvantages

Manual routing Very simple. Very slow: Each email must be
manually assigned to an agent.

Requires a person dedicated to the
routing process.

Custom Routing and Meets precise business Takes time to design and program.
Queuing requirements.

Can accommodate more complex
business processes and
hierarchies.
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Table 13. Routing and Queuing Methods Comparison

Routing Method or

Product Advantages Disadvantages
Siebel Assignment More powerful. No real-time notification using the
Manager Skills-based ti communications toolbar. No blending
i1is-based routing. of inbound communications across
Workload-based routing. channels.
Rules maintenance in graphical
user interface. No programming
required.
Siebel Universal Most powerful. Must be purchased separately.

ueuin
Q g Skills-based routing.
Keeps track of agent availability
and workload sessions in real time.

Maintenance performed in
graphical user interface.

Real-time notification using the
communications toolbar.Access to
communications channels (email,
voice, Web collaboration, and so
on) by using the communications
toolbar.

Siebel Email Response and Business
Services

Siebel Email Response uses business services to interact with your database. A business service
provides a new top-level object (such as a business object or applet) that can be used to implement
reusable business logic and implement business rules capabilities. For more information about
business services, see Using Siebel Tools.

Siebel Email Response uses many business services and their associated input arguments in its
workflow processes. The two business services used by Siebel Email Response are:

®  Inbound Email Manager Business Service

®  Inbound Email Database Operations Business Service
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Inbound Email Manager Business Service

Table 14 shows a list of methods and input arguments with descriptions for this Siebel Email

Response business service.

Table 14. Inbound Email Manager Methods and Input Arguments

Method Input Argument Description
AddAttachments Creates attachment records for the attachments
in EventFields.
Business Component Business component in which attachment records
are created.
Business Object Business object in which attachment records are
created.
EventFields Hierarchy that contains file properties, such as
FileNameO, FilePathO, FileNamel, FilePathl,
and so on.
AddCategories Associates categories with an activity record.
ActivityID ID of activity record with which categories are
associated.
BusComp Business component in which category
associations are created.
BusObj Business object in which category associations
are created.
Catalog Catalog in which the system looks up categories.
Categories List of categories and corresponding scores.
DeleteTempFiles Deletes temporary files specified in EventFields.
EventFields Hierarchy that contains file properties, such as
FilepPathO, FilePathl, and so on.
GetCategories Gets the list of categories and scores associated
with an activity.
ActivityID ID of activity record from which categories are
obtained.
BusComp Business component of the associated categories.
BusObj Business object of the associated categories.
Categories List of categories and corresponding scores.
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Table 14. Inbound Email Manager Methods and Input Arguments

Method

GetEventCategorie
s

Input Argument

Description

Enumerates the categories in EventFields and
returns them in a hierarchy.

Categories

List of categories extracted from EventFields.

EventFields

EventFields that contain category properties
prefixed by CATEGORY.

GetPreference

Gets the value of a user preference.

Category

Category of preference.

Preference

Name of preference.

Value

Value of preference.

GetResponseText

Gets the auto-suggest/response text for a set of
categories based on their scores and thresholds.

Catalog ID

The ID of the catalog in which your categories are
stored. If the Catalog ID input argument contains
a value, the Catalog ID is used to locate the
catalog.

Categories

List of categories and corresponding scores.

CheckThreshold

If Y, checks category scores against the threshold
to determine whether response text for a
category is used. If N, gets the response text
based on scores alone.

Catalog Name

The name of the catalog in which your categories
are stored. If the Catalog ID input argument
contains a value, the Catalog Name input
argument is ignored.

MaximumSections

Maximum number of categories for which
response text will be returned.

ResponseText

Response text for the set of categories.

GetSearchSpec

[Name of a business
component field, such as
Area or Extract]

Siebel Email Response Administration Guide Version 7.7

Creates a search specification based on the fields
included as input arguments. For example, if
Abstract and Area were input arguments, the
search specification named [Area] =
“Installation” AND [Abstract] =
“Production” would be called the SRSearchSpec
output argument.
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Table 14. Inbound Email Manager Methods and Input Arguments
Method Input Argument Description

GetTokens Gets a specified number of tokens from a string.
The tokens are returned in output properties such
as Token 1, Token 2, and so on.

Delimiter One or more characters that set off a token from
surrounding characters. Default is the space
character.

NumTokens The number of tokens to obtain. Default is 1.

Text The text from which the tokens are obtained.

GetUQCategories Creates a WorkItemDataProperty hierarchy

required by UQ. Every input property will be
added to the output hierarchy.

Categories List of categories and corresponding scores. The
category with the highest score is extracted and
added to the WorkItemDataProperty hierarchy.

WorkItemDataProperty Hierarchy with the highest scored category and
all input properties.
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Table 14. Inbound Email Manager Methods and Input Arguments
Method Input Argument Description

ParseText Extracts response properties from the email. The
input arguments of this method include a fixed
argument called Text, which contains the text to
parse and one additional argument for each
response property to extract. The types of these
additional arguments are Literal and the values
indicate the patterns to match and are in the
following format:

expression = exp | "Last(" exp ")"
exp = {prefix}"%s"[{suffix}]

The text “Last(” at the beginning and the text
“)” at the end are optional. They indicate that the
last occurrence of the pattern should be used if
there are multiple occurrences. If they are not
specified, the first occurrence will be used.

{prefix} represents any literal that marks the
beginning of the pattern and is required.

“%s” marks the value to be extracted and is
required.

{suffix} represents any literal that marks the
end of the pattern. If not specified, all the text
between the prefix and the end of line will be
extracted.

The extracted response properties are used in the
workflow process.

Text The string to parse.

ReturnPropSet Returns a hierarchy that contains the input
properties and properties from the input
hierarchy.

PropSetType The type of the output hierarchy.
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Table 14. Inbound Email Manager Methods and Input Arguments

Method Input Argument Description
SetResponseFields Constructs To, CC, and BCC lines for outbound
email based on corresponding lines from inbound
email.
InputEmailBccLine BCC line in inbound email.
InputEmailCcLine CC line in inbound email.
InputEmailToLine To line in inbound email.

InputMsgReceiveAddres | Receiver address in inbound email.
s

InputMsgSenderAddress | Sender address in inbound email.

InputResponseType Reply, Reply to All, or Forward.
OutputEmailBccLine BCC line for outbound email.
OutputEmailCcLine CC line for outbound email.
OutputEmailToLine To line for outbound email.

Inbound Email Database Operations Business Service

This business service performs database-level actions.

Table 15 shows methods and input arguments, with descriptions, for this Siebel Email Response
business service.

Table 15. Inbound Email Database Operations Methods and Input Arguments

Method Input Argument Description
AttachFile Creates an attachment record.
BusComp Name of attachment business component.
BusObj Name of business object.
ErrorMessage The error message if an error occurs during
method execution.
FatalErrCode The error code if a fatal error occurs during
method execution.
FileName Name of the file to attach.
FilePath Path of the file to attach.
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Table 15. Inbound Email Database Operations Methods and Input Arguments

Method Input Argument Description
DeleteRecord Deletes a record.
BusComp Name of business component from which to
delete a record.
BusObj Name of business object.
ErrorMessage The error message if an error occurs during
method execution.
FatalErrCode The error code if a fatal error occurs during
method execution.
1D ID of the record being deleted.
ExpandBCTemplate Substitute values in a template.
BusComp Name of business component used to get values
for template substitutions.
ReplyMessage Reply message with substituted values.
ReplyTemplate Reply template.
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Table 15. Inbound Email Database Operations Methods and Input Arguments

Method
FindRecord

Input Argument

Description

Finds a record. This method respects the
Caselnsensitive parameter in the CFG file. The
CFG file is configured to perform case-sensitive
searches by default. If you want to change this
parameter to case-insensitive to search for an
email address, you clear the checkbox for the
Use Default Sensitivity property in the Email
Address field of the Mail Agent Contact business

component.

BusComp Name of business component from which to find
a record.

BusObj Name of business object.

ErrorMessage The error message if an error occurs during

method execution.

FatalErrCode

The error code if a fatal error occurs during
method execution.

ID ID of a record if it is found.

QueryFields List of comma-separated fields to query on.
Query values are passed in additional
arguments, with one argument per field.

ValueFields List of comma-separated fields from which to get

values. Each field is passed back in one output
argument, with the name set to the field name
and the value set to the field value.

FindRecordEx

138 =

Contact Alternate Email
Address

QueryField: Email
Address

Used only by Siebel Email Response for matching
contacts when processing inbound emails. It
finds all contacts in the Siebel database whose
primary or alternate email address matches the
From email address of the inbound email and
then associates each contact found with the
email activity record.
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Table 15. Inbound Email Database Operations Methods and Input Arguments

Method
GetFieldValues

Input Argument

Description

Gets the field values from a record.

BusComp Name of business component from which to get
record values.

BusObj Name of business object.

ErrorMessage The error message if an error occurs during

method execution.

FatalErrCode

The error code if a fatal error occurs during
method execution.

1D ID of record from which to get values.

IDField The field on which to query for the ID.

ValueFields List of comma-separated fields from which to get
values. Each field is passed back in one output
argument, with the name set to the field name
and the value set to the field value.

GetRecordList Get a list of records.

BusComp Name of business component from which to get
record values.

BusObj Name of business object.

ErrorMessage The error message if an error occurs during

method execution.

FatalErrCode

The error code if a fatal error occurs during
method execution.

NumberofRows Number of records returned. Default is 10.

QueryFields List of comma-separated fields on which to
query. Query values are passed in the additional
argument fields (one argument per field.)

ValueFields List of comma-separated fields from which to get

values. Each field is passed back in one output
argument, with the name set to the field name
and the value set to the field value.
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Table 15. Inbound Email Database Operations Methods and Input Arguments

Method Input Argument Description
InsertRecord Insert a record.
BusComp Name of business component to insert record

into. Each field value to be set is passed as an
additional input argument with the name set to
Field: followed by the field name.

BusObj Name of business object.

ErrorMessage The error message if an error occurs during
method execution.

FatalErrCode The error code if a fatal error occurs during
method execution.

ID ID of the new record if the insert is successful.

Uselocale The Siebel Email Response (which workflow; Run

Process?) workflow receives the date (Planned)
from the driver in 24 hour format. Workflow
executes the request on the server side. Siebel
Server might be running on a computer using a
twelve hour or twenty-four hour clock. A value of
FALSE (default) indicates the server runs on a
twenty-four hour clock. A value of TRUE indicates
the server runs on a twelve hour clock.

How the Internet SMTP/POP3 Driver
Processes Email Messages

This section contains some information about email directories, driver parameters, and an overview
of how the Internet SMTP/POP3 Server driver processes email messages. For details about the
directories and driver parameters included in this section, see Siebel Communications Server
Administration Guide.

Email Directories and Driver Parameters

When the Internet SMTP/POP3 Server driver starts, it creates the following directories and by default
puts them in the bin subdirectory, if they do not exist. By default, the following directories are
created:

m Failed

®  Incoming
® Loopback
m  Processed

m  Sent
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If you do not wish to store messages in the bin subdirectory, you can specify a different location by
changing the values for the communications driver parameters. To change the locations where
messages are stored, navigate to the Administration - Communications screen and select the
Communications Drivers and Profiles view. In the Driver Parameters list, choose one of the following
parameters for the directory location that you want to change, and type a directory path in the
Default Value column.

® Failed Email Directory

® Incoming Email Directory

® Loopback Email Directory

B Processed Email Directory

®  Sent Email Directory

The following parameters control how incoming and outgoing messages are processed:
m Delete Processed Messages

B Save Sent Messages

®  Return Attachments

®  Process If Loopback Detected

You can change how these email messages are processed by changing the Default Value of a driver
parameter. For example, if you do not want to return attachments, change the default value to
FALSE.

Output Parameter Values for POP3 and SMTP Email Drivers

During email processing, the POP3 and SMTP email drivers pass output parameter values to the
Communications Inbound Receiver and Communications Inbound Processor server components.
From the Communications Inbound Receiver and Communications Inbound Processor server
components, these values are passed to the Siebel Email Response workflows in the form properties
of the EventFields property set. Table 16 provides a list of the output parameter values and a general
description of how you can modify email handling behavior by accessing these values in the
EventFields property set.

Table 16. Output Parameters for POP3 and SMTP Email Drivers

Default
Parameter Name Value Description
Attachments 0 Number of nonsupplemental attachments found.
Cclist Value of CC: header field. This parameter is semicolon

delimited as required by the Siebel application.

DsnAction This parameter uses the RFC1894 protocol. For more
information, see http://www.faqgs.org/rfcs/
rfc1894.html.
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Table 16. Output Parameters for POP3 and SMTP Email Drivers

Default

Parameter Name Value Description

DsnContent This parameter uses the RFC1894 protocol. For more
information, see http://www.faqgs.org/rfcs/
rfc1894.html.

DsnFinalRecipient This parameter uses the RFC1894 protocol. For more
information, see http://www.faqgs.org/rfcs/
rfc1894.html.

DsnOriginalEnvelopeld This parameter uses the RFC1894 protocol. For more
information, see http://www.faqgs.org/rfcs/
rfc1894.html.

DsnStatus This parameter uses the RFC1894 protocol. For more
information, see http://www.faqgs.org/rfcs/
rfc1894.html.

FileCharset%d The character set of file %d (where %d is 0 based).

FileIsInline%d If an incoming attachment does not have a name
associated with it, it is considered inline. The Siebel user
interface should display the attachment in the rich edit
control and not in the attachment pane. (%d is 0
based).

FileIsSupplemental%d If the incoming attachment is a supplemental file
created by the driver, such as the original message.txt
file, this parameter is set to TRUE. Otherwise this
parameter is FALSE.

FileName%d The name of the attachment file. This parameter can be
specified in the MIME type or synthesized based on the
type/subtype of the attachment.

FilePath%d The physical location of the file on the local hard disk. If
the response group that loaded the driver is not
processing email in Real-Time, this will be the location
of the file on the Siebel File System.

FileSubtype%d This is the MIME subtype of the attachment.

FileType%d This is the MIME type of the attachment.

HasAttach TRUE if Attachments >= 1.

HTMLBody This will be set if the incoming email text was HTML only
or was multipart/alternative with HTML.

In-Reply-To Value of In-Reply-To: header field. This parameter uses
the RFC2822 protocol. For more information, see http:/
/www.fags.org/rfcs/rfc2822.html.
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Table 16. Output Parameters for POP3 and SMTP Email Drivers

Default

Parameter Name

IsDeliveryStatusNotific
ation

Value

Description

If the incoming email is a delivery status notification as
specified by the RFC1894 protocol this parameter value
will be TRUE. Otherwise, the value will be FALSE. For
information on the RFC1894 protocol, see http://
www.faqgs.org/rfcs/rfc1894.html.

Keywords

Value of the Keywords: header field. This parameter
uses the RFC2822 protocol. For more information, see
http://www.faqgs.org/rfcs/rfc2822.html.

LocalFileToGlobal%d

For a description of this parameter, see “"Moving
Generated Local Files to the Siebel File System” on
page 145.

Loopback Candidate

For a description of this parameter, see “Moving
Generated Local Files to the Siebel File System” on
page 145.

Message-ID

Value of "Message-ID:" header field. We also use this as
the SCAPI DriverTrackingID. For more information, see
http://www.faqgs.org/rfcs/rfc2822.html.

MsgClass

This parameter is obsolete.

OrigMsgFile

The incoming MIME type is saved in this local file. If the
response group that loaded the driver is not processing
email in RealTime, this will be the location on file on the
Siebel File System.

Prefix

If this is a forwarded message this will be Fwd or Fw. If
this is a message that is in reply to another message this
will be Re. Otherwise this parameter will be empty.

Priority

This is a number from 1 to 5 with 1 being the highest
priority and 5 being the lowest priority. This is extracted
from the X-Priority or the X-MSMail-Priority if available.

Received

This is the date the email was retrieved from the POP3
server.

ReceiverAddress

The is the email address extracted from the From
Address communications profile input parameter. For
example, the RecieverAddress for John Smith
<John@Smith.net> would be john@smith.net.
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Table 16. Output Parameters for POP3 and SMTP Email Drivers

Default
Parameter Name Value Description

ReceiverName

This is the proper name extracted from the From
Address communications profile input parameter. If
there was no proper name, this will be set to the
ReceiverAddress. For example, the RecieverName for
John Smith <John@Smith.net> would be
john@smith.net.

References

Value of References: header field. This parameter uses
the RFC2822 protocol. For more information, see http:/
/www.faqgs.org/rfcs/rfc2822.html.

SenderAddress

The is the email address extracted from the From:
header field. For example, the SenderAddress for John
Smith <John@Smith.net> would be john@smith.net.

SenderAddrType

Always empty, this parameter is not needed by the
workflows.

SenderName

This is the proper name extracted from the From:
header field. If there was no 'proper name', this will be
set to the SenderAddress. For example, the
SenderName for John Smith <John@Smith.net> would
be john@smith.net.

SenderReplyNames

If the Reply-To: header field is set, this is the value but
delimited by semicolons rather than commas. If Reply-
To: was not specified, this is the same value as the
SenderAddress.

Sent

This is the date from the Date: header field.

SiebelChannelProfile

This is generated by Media Manager.

SiebelChannelType

This is generated by Media Manager.

SiebelChannelTypeStrin
g

This is generated by Media Manager.

SiebelDriverNotifyWhe
nDone

This is generated by Media Manager.

SiebelWorkItemID

This is generated by Media Manager.

Subject

Value of the Subject: header field.

Temp%d

If an attachment should be deleted by the processing
workflow, this should be TRUE.

text/html charset

This is the IANA character set of the HTMLBody. This is
the value of the charset parameter of the Content-Type
header field.
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Table 16. Output Parameters for POP3 and SMTP Email Drivers

Default

Parameter Name Value Description

text/plain charset This is the IANA character set of the TextNote. This is
the value of the charset parameter of the Content-Type:
header field.

TextNote This is the plain/text message body text of the incoming
message.

TolList This is the value of the To: header field. This will be
semicolon delimited as required by the Siebel
application.

Moving Generated Local Files to the Siebel File System
The following section describes how to cause the Communications Inbound Receiver to move driver-
generated local files to the Siebel File System.

The processing of driver events may occur on a remote Communications Inbound Processor server.
However, this will only occur if the response group input parameter RealTime is set to FALSE. In
previous versions of Siebel Email Response, the Communications Inbound Manager server
component would always execute driver events in the same process in which the driver was loaded.
This meant that the business service executed by Communications Inbound Manager server
component, usually a workflow, would have easy access to any local files generated by the driver.

To allow workflows executing on a remote Communications Inbound Processor server to access
driver-generated local files, the Communications Inbound Receiver will watch for EventFields with
the following tag:

LocalFileToGlobalXXX = tag|toReplace
NOTE: XXX must start at 0 and increase contiguously.
The file toReplace will be moved to the Siebel File System.

tag is the key to a tag/value pair that will have the text toReplace replaced with the actual Siebel
File System file name generated when toReplace was moved to the Siebel File System.

For example, the following EventFields were generated by a driver:
LocalFileToGlobalO=0riginalMsgFile|c:\OriginalMsgFile.txt
originalMsgFile=c:\OriginalMsgFile.txt

This example results in the local file c:\OriginalMsgFile. txt being moved to the Siebel File System.
Assuming this file received the name ABCDEFG on the Siebel File System, the EventFields would be
modified as follows before being submitted to workflow for processing:

OriginalMsgFile=ABCDEFG
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An Overview of the Processing Flow of Inbound Email
Messages

When the Internet SMTP/POP3 Server driver starts, it creates required directories such as Incoming
Email. The Internet SMTP/POP3 Server driver also creates a thread that polls the POP3 server. The
PollingInterval driver parameter controls the frequency at which the Internet SMTP/POP3 Server
driver checks the POP3 server for messages.

If there are messages, the Internet SMTP/POP3 Server driver retrieves and processes them one at
a time, up to a maximum per session equal to the value set in the POP3 Batch Size driver parameter.
If the current session with the POP3 server terminates abnormally, all messages previously retrieved,
processed, and deleted during the current session will be restored, retrieved, and processed again
the next time the Internet SMTP/POP3 Server driver connects to the POP3 server. The smaller the

value POP3 Batch Size driver parameter, the fewer duplicate messages will be created and processed
if a restart occurs.

Messages in a session are processed as shown in the following steps:
1 A message is saved in the Incoming Email directory.
2 The POP3 DELE command deletes the message from the POP3 server.

If the DELE command fails, the message stored in the Incoming Email directory is erased because
it will be retrieved again in the next POP3 session.

NOTE: You should not have other email clients accessing the mailboxes that Siebel Email
Response is monitoring because the email driver deletes the messages from the POP3 server
when they are processed by Siebel Email Response. As such, these messages will not be visible
from another client.

3 The disk based message is parsed. The parsing produces the following files in the Incoming Email
directory:

a OriginalMessageText_[the original header of the message along with all text parts concatenated
together].txt.

b Any attachments parsed from message are given unique names in the following format:

ATT_[the original header of the message along with all text parts concatenated
together].DAT.

€ Any remaining text or HTML fragments are turned into attachments and are given unique names
in the following format:

ATT_[the original header of the message along with all text parts concatenated
together].DAT.

4 If an error occurs when the message is parsed, the following events occur:

a A temporary file in the following format is moved to the Failed Email directory and any
attachments created are deleted:

pop3_[the original header of the message along with all text parts concatenated
together].tmp

b The POP3 session is immediately terminated with a QUIT command so that the offending
message is permanently deleted from the server.
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5 If the Loopback Detection Interval parameter value is greater than zero and the message sender
is currently being blocked, the following events occur:

m If the Process If Loopback Detected parameter value is FALSE, the message is moved to the
Loopback Email directory.

m If the Process If Loopback Detected parameter value is TRUE, the driver’s Loopback
Candidate flag is set to TRUE and the message continues processing.

6 If the message is not moved to the Loopback Email directory or flagged as a loopback candidate,
the pop3_[the original header of the message along with all text parts concatenated
together].tmp file is processed as follows:

m If the Delete Processed Messages parameter value is TRUE, the temporary file is deleted.

m If the Delete Processed Messages parameter value is FALSE, the temporary file is moved to
the Processed Email directory.

7 The primary message text, header information (subject, to, cc, date, and so on), Loopback
Candidate flag, and references to the attachments are passed to the driver's creator (usually
Communications Inbound Receiver and Communications Inbound Processor).

8 The OriginalMessageText file and all the attachments are not deleted by the SMTP/POP3 driver.
It is the responsibility of the workflow invoked by CIM to delete all the attachments.

CAUTION: Any errors that occur in the workflows may strand the ATT_OriginalMessageText files
in the Incoming Email folder. If this occurs while CIM is not running, the workflow invoked by CIM
failed to process a message event. The safe way to determine if an ATT_OriginalMessageText file
can be deleted is to stop CIM and then look at the contents of all the queued CIM Events in all
response groups to make sure that the ATT_OriginalMessageText files are no longer being
referenced.

Processing Internally Generated
Attachments in Siebel Email Response

The following sections describe how Siebel Email Response generates attachments when inbound
mail comes in and when outbound mail goes out.
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Attachments Created When Inbound Email Is Received

Siebel Email Response generates internal attachments upon receipt of plain text or HTML emails.
These internally generated attachments appear in addition to any external attachments associated
with the email by the email sender. Table 17 describes the attachments created. When a plain text
email is received into Siebel Email Response, one internally generated attachment is created called
Original Message.txt. This contains the MIME format of the message as received by the SMTP/POP3
driver. When an HTML email is received in Siebel Email Response, two internal attachments are
generated: the Original Message.txt and texthtml.htm, which contains the email in HTML formatting.
This attachment is essentially the same as the incoming email message seen in the Incoming
Message form or the Outgoing Message form (when user preferences are set as follows: Default
Message Format = HTML, Original Message is Included in Reply = TRUE). No internally generated
attachment is sent with a Reply, Reply to All, or Forward message.

Table 17. Incoming Email Attachments

Incoming Email Format Attachments Created

HTML Original Message.txt

Plain Text Original Message.txt

Attachments Created When Outbound Email Is Sent

When sending outbound emails, internally generated attachments are created for those outbound
emails whose message size is greater than 16KB (~15000 characters). These internally generated
attachments are called SiebelLongEmailBody and are stored with the email activity record in the
Siebel application but are not sent with the outbound message. Table 18 describes what kind of
attachments are created. Whether or not the email is greater than or less than 16KB, the outgoing
message will contain the entire email in the body of the message without any internally generated
attachments. This attachment is created so that any message of greater than 16KB can be stored in
the Siebel file system because there is a database limitation of 15000 characters for any email.
Additionally, this attachment allows the entire text of the email to be visible in the Outgoing Message
form and sent to the email recipient in the body of a single email message.

Table 18. Outgoing Email Attachments

Default Message Attachments Created for Email
Format greater than 16KB

HTML SiebelLongEmailBody.htm

Plain Text SiebelLongEmailbody.txt

NOTE: Default Message Format is set in the Outbound Communications view of the User Preferences
screen. For more information about setting user preferences, see Applications Administration Guide.

148 m Siebel Email Response Administration Guide Version 7.7



rence = Upgrading to Siebel Email Response Release 7.7

Upgrading to Siebel Email Response
Release 7.7

This section describes some upgrade features and provides information about upgrade
preparations. It is recommended that you export and save the configuration values discussed in this
section. You will need these configuration parameters when you configure new elements after the
upgrade.

For general upgrade information used primarily by System and Database administrators, see the
Upgrade Guide for your operating system.

Siebel Email Response Business Services and Workflow

Release 7.7 of Siebel Email Response uses the Workflow Process Manager business service to call all
workflow processes. Other business service methods can be called from within the workflows. The
following business services used by Siebel Email Response will migrate from Release 6.x to Release
7.7, with exceptions noted:

®=  Inbound Email Manager. Customization of this business service will migrate but customization
of its methods will not migrate.

In Release 7.7, the CreateRecord and ProcessServiceRequest methods have been incorporated
into workflow processes. These method names will not be in the Inbound Email Manager business
service.

Any modifications you made to the CreateRecord and ProcessServiceRequest methods will need
to be reentered by you in the eMail Response - Process Message and eMail Response - Process
Service Request workflows, respectively.

® Inbound Email Database Operations. Customization of this business service will not be
migrated.

®  Outbound Communications Manager. Customization of this business service will not be
migrated.

Response Groups and Input Arguments

Existing input arguments and default input arguments for response groups will be imported. Before
upgrading, export your input arguments for all 6.x business services and methods to a file and save
it.

Customized Mail Agent Business Components from Release 6.x will migrate, but the business
components will be used in workflow steps instead of being specified as input arguments to the
response group. After Upgrading, customers should perform the following tasks on all Siebel Email
Response workflows:

B Change the business service to Workflow Process Manager and the method to Run Process.

m Delete all input arguments, and add a single argument called ProcessName. In the input
argument value field for ProcessName,
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= Type eMail Response - Process Message to replace CreateRecord (Inbound Email Manager
business service)

= Type eMail Response - Process Service Request to replace ProcessServiceRequest
(Inbound Email Manager business service).

If response groups called workflow processes in Release 6.x, you may be able to use them with
modifications. Depending on the number of changes to the workflows, it may be easier to use a
standard workflow that accomplishes the same task.

Response Properties

Response properties have been replaced by the ParseText method on the Inbound Email Manager
business service. This method uses one fixed input argument (Text) that specifies the text for which
you are looking and one input argument for each response property that you want to parse. For
example, for the Text input argument Service Request#:, the response property is 24-57689.

®  The name of this additional input argument is customer-specified, and it corresponds to an
output argument of the same name that will contain the parsed property value. For more
information, see “Siebel Email Response and Business Services” on page 131.

Siebel Email Response Templates

Templates from Release 6.x will be migrated during your upgrade. In Release 7.7, recipient groups
control the substitution fields that are available for templates. Therefore, your templates will have
to be recreated if the substitution fields no longer exist. To make sure the imported templates are
accurate, you may need to recreate your templates in Release 7.7 You can copy and paste text from
an old template into a new one. The following list contains information about specific types of
templates:

B Release 99.5 templates (such as Submit - OK, Submit - Error, Logon Failure, and so on) have
been replaced by standard templates and are no longer specified as input arguments. For
example, the Submit - OK template is now the eMail Response - SR Submit template.

m  Four default templates have been added to the seed data and will not be migrated: Srapage.txt,
srmail.txt, Srnpage.txt, and srresolve.txt.

m Additional customer-created message templates, such as those for Send Email, should be
upgraded manually by adding them to the template table and changing the macro to the following
format:

m  Use a start bracket ([) and an end bracket (]) instead of percent signs (%) to enclose the
macro.

= Add the business component name in front of the field name. For example, enter Service
Request.SR Number instead of SR Number.
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Siebel Email Response Communications Drivers
(Adapters) and Profiles

Make sure you export all the values for adapters and profiles in your current communication
configuration. You will need these configuration parameters when you configure drivers in Release
7.7.

B Some drivers (called adapters in previous releases) that were available in Release 6.x are not
supported in Release 7.7, including Extended MAPI, Microsoft Exchange Server, and Microsoft
SMTP Service. Profiles that used these adapters will need to be recreated using the Internet
SMTP/POP3 server driver. Use the exported values file to create new drivers.

m  Profiles using the Internet SMTP/POP3 Server Adapter in 6.x will upgrade to the Internet SMTP/
POP3 server driver. There are new parameters, but they are not required. For information about
new parameters, see Siebel Communications Server Administration Guide.

m  Profile parameter overrides will not migrate. Use the exported values file to recreate these
profiles.

My Incoming Email and All Incoming Email Views

If you customized your My Incoming Email and All Incoming Email views in Release 6.x, your changes
will not migrate to Release 7.7. The same functionality exists in Release 7.7, but you will need to
customize your My Communications, My Team’s Communications, and All Communications views
after you install Release 7.7.
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Utility

This appendix covers using the Siebel File System Utility with Siebel Email Response. It includes the
following topic:

m  “Using the Siebel File System Utility with Siebel Email Response”

Using the Siebel File System Utility with
Siebel Email Response

The Communications Inbound Receiver and Communications Inbound Processor use the Siebel File
System for temporary storage and to hold copies of any attached files. To clean up any orphan files
(files with no corresponding record in the database) in the file attachment directory, you can use a
command-line utility, sfscleanup.exe. However, to avoid accidentally removing any files created by
Communications Inbound Receiver, make sure that you do not use the /g option when using the
sfscleanup.exe utility.

For more information on using the sfscleanup.exe utility to clean up the Siebel File System and a
list of sfscleanup.exe parameters, see Siebel System Administration Guide.
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